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1 Introduction 

1.1 About Aligned Elements 

Aligned Elements is a Medical Device Application Lifecycle Management system to help you create and 
maintain your medical device development documentation.  

▪ Aligned Elements is created to support the documentation standards for highly regulated 
markets. This solution includes a number of different function areas used for all parts of the DHF 
Management, all merged into one: 

▪ Design Input and Output management, structure your project documentation to make the right 
decisions and the right next steps. 

▪ Risk Management, manage your risks assessments and ensure that risks are sufficiently 
mitigated. 

▪ Verification and Validation Management, implement and manage your Verification and 
Validation efforts to ensure that the product corresponds to the planned design. 

▪ Document management, help you keep your document versioned and under control and 
features a tight integration with Microsoft Word automating some documentation tasks. 

▪ Version manager, automatically keep an audit trail of all your changes in your project. Identify 
the status at different milestones. 

▪ Issue management, report all your know errors or to-dos and link to your existing 
documentation.  

It also supports an instant gap analysis where you continuously can verify what inconsistencies you have in 
your project (before someone else does). 
 

1.2 Reading Guide 

The user manual is structured into the following parts:  
 
The first part is the description of all different screens and their functions. This part is used to get an 
overview of the available features and functions. 
 
The second part is structured around daily tasks and is supposed to answer the question How to… do the 
specific task.  
 
The third part describes the Microsoft Word Integration in detail. 
 
The fourth part describes common trouble-shooting tasks. 
 
The last part describes assorted administrator tasks and is only intended for advanced users with the needs 
to configure a project, its users and to take care of maintenance issues. 

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  10 / 269 

1.3 References 

 
No 1. SQL Server 2005 Books online (November 2008): 
http://www.microsoft.com/downloads/details.aspx?FamilyID=be6a2c5d-00df-4220-b133-
29c1e0b6585f&DisplayLang=en 
 
No 2. SQL Server 2008 Books online (October 2009): 
http://www.microsoft.com/downloads/details.aspx?familyid=765433F7-0983-4D7A-B628-
0A98145BCB97&displaylang=en 
 
No 3. SQL Server 2012 Books online: 
http://msdn.microsoft.com/en-us/library/ms130214.aspx  
 
No 4. SQL Server 2014 Books online 
http://technet.microsoft.com/en-us/library/ms130214.aspx 
 
No 5. SQL Server 2016 Technical Documentation 
http://technet.microsoft.com/en-us/library/ms130214.aspx 
 

1.4 Conventions used in this manual 

To make reading easier, the names of dialogs, menus, menu items, labels etc. are written in italic bold e.g. 
Project View. 
 
A menu choice can at times be indicated with an arrow Project View -> Exit. 
 
User interface buttons are indicated by the use of tags e.g. <OK> in italic bold. 
 
File and directory paths are written in italic e.g. serverName/server 
 

1.5 Disclaimer 

This user manual is solely intended for user guidance and does not imply any legally binding description of 
functionality. 
 
Since Aligned Elements does not prescribe any specific process, the scope of the manual excludes any 
development process related issues. This is expected to be provided from the customer’s own 
organization. 
  

http://www.aligned.ch/
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2 General Overview 

2.1 Basic Concepts 

Aligned Elements is a Medical Device ALM that captures and manages the documentation parts in your 
project that are intended to be under design control. 
 
The fundamental building blocks of Aligned Elements are the so called Document Objects. A Document 
Object is a requirement, a specification, a use case, a test, a risk etc.  
 
The document object types are defined in xml templates and therefore customizable. These xml files are 
called Document Object Templates and contain among other things the attributes that make up a certain 
Document Object Type (such as requirements, specifications etc.). A Document Object contains a set of 
attributes e.g. a requirement would have a title, a priority and a description.  
 
Each Document Object Template this defines a Document Object Type. The default installation of Aligned 
Elements provides the following document object types: 
 

Requirement Failure Mode Issue 

Specification Hazard Attachment 

Use Case Mitigation File 

Test Case Review Executed Test Case 

DHFLineItem Wizard Report Change Request 

 
You can modify the existing document object templates or create new templates in order to accommodate 
to your local quality and development process. 
 
The data belonging to a Document Object is under strict version control. All committed changes made to a 
document object create a new revision of the object. Consequently, each document object has a so called 
revision number indicating how many times it has been altered. Old revisions of a document object cannot 
be altered. 
 
Document Objects can be linked to each other via so called traces. A trace is a one-way relation between 
two document objects with a defined direction e.g. a trace from a requirement to a specification indicates 
that the requirement has been fulfilled by the specification. 
 
In Aligned Elements, you can trace any document object to any other document object. 
 
Aligned Elements is a client/server system allowing multiple clients to work on the same project 
simultaneously, provided that they have access to the central server. 
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2.2 Open Project 

When Aligned Elements is started you are instructed to select a project on the selected server to log in to: 
 

 
 
The Server is an SQL Server running somewhere on your local network or in the cloud. Aligned Elements 
can scan for available servers on the local network by clicking the <Scan > button.  Alternatively, type in 
the server name manually. For Cloud scenarios, type in the DNS for the server. 
 
To connect to a server and display the available Projects, click <Connect >. To open a Project, select it in 
the list and click <OK > or double click on the Project Item. 
 
Note! Beware that scanning for databases may be blocked by the local firewall settings.  
 
If you know that a database exists, you can manually type in the name on the form 
ServerName\SQLEXPRESS where “SQLEXPRESS” is the name of the database instance. The name can be 
different depending on your database setup. 
 
Note! The path to the Server name uses backslashes! 
 
You can also create a new project by clicking the <New Project> button and entering a unique project 
name in the Name field. The project will be created on the defined server. 
 
Clicking <OK> will load the project and proceed to the login dialog.  
 
The last 25 successfully loaded projects are stored in the File -> Recent Project menu for fast access. 
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2.2.1 Loading linked projects 

If the current project is linked to dependent project a.k.a linked projects (see Work with Linked Projects 
3.33), there emerges a possibility to load a selected subset of these linked project. Linked projects can also 
be dynamically opened later on using the Project Hierarchy (see Work with Linked Projects) 
  

 
 

2.3 Main Screen 

When the project is loaded, you will be presented with the main screen:  
 

  
 
Aligned Elements consist of a few different dialogs and windows as displayed above. These are all 
explained in detail in the sections below. If any of the windows disappear, you can display all of them again 
by pressing View -> Show All in the menu tool bar. 

Views 

Explorers 
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2.4 Menus 

The File menu allows you to open a different project or to link to an external project. You may also exit the 
application from here. 
 

 
 
The View menu displays all available views in Aligned Elements. Here the views can be displayed or hidden 
by toggling the check mark for each entry. 
You can also toggle to views belonging to linked projects or snapshots that you have displayed. 
 

 
 
Use the Restore Windows option to revert to the default window configuration. 
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Group Document Objects by assigning them to Tags, more information in section 3.14 
 

 
 
Create and Run Trace Tables, using the Traces option, more information in the section 3.8 
 

 
 
Use the Queries option to access existing queries or add new queries, more information in the section 3.6 
 

 
 
Existing queries are grouped according to Document Object Type Name. Use the Import and Export menu 
items to export and import Queries to/from xml. 
 
Note! When exporting a query, the exported file does not contain any references to the items in the Input 
set. The input set is always empty in the exported file. 
 
Similar behavior is used for Charts,  access existing queries or add new charts, more information in the 
section 3.23. 
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Import and Export Charts work in the same way as for Queries. 
 
The Inspect menu item contains functions for analyzing  the Project content.  
 

 
 
Display inconsistencies is described in section 3.21, Consistency Coverage is described in 3.22, 
For information on Display the 3DHF Index, see 3.24, or Display a Risk Summary, see 3.25. 
 
The User Management menu allows managing your users and user groups, more info in the section 6.1. 
 

 
 
The Wizard menu allows creating and running regulatory wizards. Before this feature can be used, you 
must define a wizard directory where defined wizards are stored, more info in the section 3.34. 
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The Project Menu contains a number of project wide functions. 
 

 
 
The Project Menu has a Refresh Project function for forcing a refresh of the complete project. This is used 
to get the most up to date information about any inconsistencies and trace-relationship.  
 
There is also access to the Project settings and User Settings, which are described in detail in section 6.4 
and 6.5 and the possibility to Unlock Objects, explained in 0. 
 
The Project Information is explained in section 3.27. 
 
The Project Hierarchy is explained in section 3.33. 
 
You can copy the current content of a Project using the Copy Project to Other Server option, in the 
following ways: 

- to a different server with the same project name.  
- to a different server with a new project name 
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- to the same server with a new name 
 
Note! The new name must not be the same as an existing project name (case-insensitive)! 
 
When copying a project you have option to select which Document object types to include in the 
operation: 
 

 
 
Note!  
When copying a project to a different server or by giving the target project a new name, the following 
applies: 

- Only the most current revisions of the document objects are copied. No previous revisions are 
copied. 

- The project history is NOT copied. 
- Document Object locks are NOT copied 
- Test Runs are not copied but the Test Cases and Executed Test Cases are copied including their 

internal traces. 
- Signatures are not copied. 

 
Note! Copying in linked projects: If the original project is a project in a linked project structure with items in 
other projects tracing to items in the original project, these incoming traces from document objects in other 
projects will not be automatically copied and tracing to the resulting project. These traces need to be 
recreated manually!! 
 
Note! Backlinks in External Issues: if the project contains document object that trace to items in external 
systems (such as Jira, GitHub, Azure DevOps etc), these traces will be recreated in the project BUT if the 
external items contain fields for backlink information to Aligned Elements Document Objects, these 
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backlinks in the external items are not updated to reflect that items in the resulting project now also point 
to these external items! 
 
The Branch Project and Merge Project operations are described in 3.35. 
 
The Project Settings can be Exported into an xml file and later imported into a different project. This is 
especially handy when distributing company-wide SMTP Settings and Signature Preferences. 
In menu, click Export Project Settings to export the current project settings to an xml file. 
 
When importing the exported Project Settings xml file in a different project, the following parameters are 
ignored: 

▪ Project Name  

▪ Project Creation Date  

▪ Project Version  

▪ Current Project Phase 

▪ Any information about linked projects 

 
Note! You can modify and trim the exported xml file to only contain the parameters you want to be 
imported. Since this feature can have significant consequences on your project, treat it with considerable 
consideration! 
 
In this menu you may Display Snapshots and Compare Snapshots from this menu. A snapshot can be 
compared with other snapshots or with the project itself in its current state. 
 
Displaying currently logged in users makes it possible to see who is currently working in the project. Note 
that only users logged into the master project, not in linked projects, are displayed. 
 
Taking a project Offline (and back Online) is described 3.35. 
 
The Help menu provides a link to the User Manual and lets you to display an about box with the current 
version number or to send log-files to Aligned AG for support (see 5.4). 
 

 
 
If no email properties are configured for the current user, the log files will be zipped and placed on the 
desktop, available for manual emailing to support@aligned.ch. 
 
Click on the About entry obtain the current release version of your installed Aligned Elements version. Click 
the Display Logfile entry to open the current log file for diagnostic purposes. 
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2.5 Explorers 

2.5.1 Project Explorer 

The Project Explorer gives an overview of the document objects 
available in your Aligned Elements project. 
 
The content of the Project Explorer is loaded on-demand when the 
user clicks to expand a Document Object Type ribbon. 
 
You can create and rename chapters (use the context menu 
through right-click on an item with the mouse) to structure the 
document objects as you please.  
 
Double-clicking on a document object will display it in full 
details (see 2.6). 
 
You can also move document objects into chapters or reorder 
chapters using drag and drop. 
 
Document objects belong in their respective type section. You 
cannot place e.g. a requirement into the folder for 
specifications. 
 
The listed order of a document object, chapters and type 
sections can also be altered through drag and drop. To change 
the display order, drag the object to the left until the icon 
turns to a double pointed arrow (→) and drop it on another 
object. When an object is dragged and dropped on an object 
below its original position, it is placed below the drop-target. If 
dropped on an object above its original position, it is placed 
above the drop-target. 
 
The Project Explorer context menu contains a number of 
useful functions. 
 

▪ Open <document object type> 

Select this menu item to display the selected document 
object(s) in a Document Object Form. This is equivalent 
to double-clicking on a document object. 

▪ Open <document object type> as read-only 

Select this menu item to display selected the document 
object(s) in a Document Object Form as read-only. In 
this case the object is not locked for editing and can be 
modified by other users. This is equivalent to Shift-
double-clicking on a document object. 
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▪ Add <document object type > 

Select this menu item to display a new document object in a Document Object Form. The new 
document object is not saved/committed until you have clicked <OK> in the Document Object 
Form. 

▪ Update Multiple Items 

Select this menu item to update an attribute value for the selected document objects of the same 
time i.e. a batch update. 

▪ Create Copy (of a document object type) 

Select this menu item to create a new document object(s) with the attribute values copied from the 
original document object.  

Note! Traces are copied optionally when you select this option (both incoming, outgoing, issues and 
attachments). An exception is made for Failure-mode like Document Objects, where all traced Hazard 
Document Objects (outgoing) are always copied and any traces towards existing Mitigation Document 
Objects are automatically set for the copy. 

▪ Chapter 

Select this menu option to create, rename or remove chapters. For information on how to copy chapter 
structures resp. exporting and importing chapter structures, see 3.3. 
 
Note! Only empty chapters or chapters that contain empty chapters can be removed. 

▪ Generate 

Select this menu option to generate new document objects of another type based on input 
information of the selected document objects. Using this option will automatically create a trace 
between the parent object and the generated object, see 3.4. 

▪ Trace To / Trace From 

Select this menu item to set or remove traces to/from this document object to/from other 
document objects, see 3.4. 

▪ Expand / Collapse 

Expand or collapses the selected chapters (nodes) or all chapters (nodes). 

▪ New Query 

Use this menu item to create a new static query with the selected items as input objects.  

▪ Run Query 

Use this menu item to run an existing query on the selected document objects. This will create a 
copy of the selected query with the selected items as input objects.  

Note that the copied query (created when using Run Query) is always a static (input set) query, regardless 
of the input set type of the original query. 

▪ Match Query 
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Use this menu item to run an existing query on the selected document objects. If the selected 
document objects is found in the output set of the query, they will be marked with a red icon in the 
Project Explorer.  

▪ Snapshot 

Select this menu option to add a snapshot to the project or part of the project (see 3.19 for details). 

▪ Add to Review 

Select this menu option to automatically add a number of Document Objects to a new or an existing 
Review. See more at 3.11 

▪ Save File to Disk 

Use this menu option to save files in File Attributes in e.g. Attachments or Files to disk. There is an 
additional option to save the files to disk maintaining its structure. This means that chapters are 
converted to directories and files in the chapter are saved in that directory. 

Note! If several files have the same name and are saved in the same directory, the file name is prepended 
with the parent Document Object ID. 

▪ Save as PDF to Disk 

This option is similar to Save File To Disk but here all files are converted to PDF (to the extent the 
Aligned Elements PDF converter can convert the file type). 

To use a custom PDF converter, see 6.9. 

▪ Find Object In…  

Select one or more Document Objects and click a sub-menu item to have them selected in the Trace 
Explorer (provided that the Document Object has any incoming or outgoing traces), Project History 
(provided that the Document object belongs to the master project) or File Explorer to locate the File 
Objects in the File Explorer that contains the Document Object (provided that the Document Object 
has been placed in one or more Word Files). It can also be used to locate in which Test Runs a 
particular item is used, 

▪ Find Object via ID 

Use the option to find a particular document object in the Project Explorer by typing an ID in the 
search field. This field can also be used for free text search in the object titles.  

▪ Filter on Category 

Hides/exposes document object books/types according to their Category in the Project Explorer. 
This is helpful when a large number of templates are used in the Project. When the filter is applied, 
the Project Explorer caption indicates it with a [filtered] text. User defined Categories can be set in 
the Document Object Templates. For the default templates, the following Categories are applied: 

Document Object Type Category 

Requirement Design Input 

Specification Design Output 

Use Case Design Output 

Test Case VnV 

Executed Test Case VnV 

Configuration VnV 
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Potential Hazard Risk Management 

Failure Mode Risk Management 

Hazard Risk Management 

Mitigation Risk Management 

WizardReport Project Management 

DHFLineItem Project Management 

▪ Add Tags 

Select a number of objects and select this option to assign a Tag to the object set.  

▪ Lock Document Objects 

Select Document Objects and lock them to prevent them from being updated, in order to control 
the change workflow if these items. 

▪ Sort 

Select this option to automatically sort the document objects in a chapter based on ID.  

▪ Inspect 

Click this item to access the following three display options: 

• Display Inconsistencies - Display all inconsistencies for a chapter or for individual document 
objects. See 3.21 for details. 

• Display Consistency Coverage - Display a consistency coverage report for the selected 
objects. See more about Consistency Coverage in 3.22.  

• Display Chart - Displays a breakdown chart for the selected objects. More information about 
Charts in 3.23. 

▪ Create Report 

Use this option to create a report on one of the following formats: 

• Excel Report (one attribute per column except Table attributes, all attributes in plain text) 

• Word Report using a neutral look-and-feel 

• A template based Word Report using a selectable template for a customized look-and-feel. 

▪ Create File For Objects 

Use this option to automatically create a new File Object which also creates a Word file from a 
select Word Template and inserts Document Objects into the Word document in one single action. 

▪ Copy to Clipboard 

Copy the ID and title of the selected objects to the clipboard. 

▪ Export, Import and Copy Document Objects to other Projects 

Use these options to Export Document Objects to XML files. These objects can later be imported in 
other projects. A second alternative is to copy the objects to a different project using an automation 
of Export and Import. More information in 3.28, 3.29 and 3.31. 
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2.5.1.1 Inserting objects into an existing file. 

 

When choosing Create Word Report (from template) it is possible to create a word report using the 
customizable MS word representation (see 6.8) of the objects. When doing this, you will be asked if 
you want to insert the objects into an existing file. 

When selecting to do so, Aligned Elements will insert the objects at the location of the text 

<<<Aligned Elements objects are inserted here>>> 

If no such text exist in the target document, the objects will be inserted at the end of the document. 

It is also possible to insert the objects into an empty document by just selecting „No“, when you are 
prompted if you want to insert the objects into an existing file 

The option to insert the objects into an existing file is also available when selecting Create File for 
Objects 

 

2.5.2 Trace Explorer 

The Trace Explorer is divided in two sections. 
The top section Traces displays a tree for all traced objects in the project (as well as to external projects if 
you have linked your project to external projects). 
 

 
 
Each root node in the project represents the document objects of that type that have no incoming traces. 
Thus, the node “Use Cases” contains use cases which have no incoming trace from e.g. a requirement. The 
use cases that DO have incoming traces from requirements can be found as child nodes to the requirement 
section. 
 
If a document object appears multiple times in the trace tree the full sub-tree is only displayed once and 

for all other occurrences a reference node is displayed as . On double-clicking the node, you will 
navigate to the real node which contains the full sub-tree. 
 
If a trace is set to suspect status (occurs when the parent object has been changed after it was traced to a 

child object), the child object is displayed with the  - symbol. 
 
Traces to document objects that are not of the last existing revision (only applies to traces between 

document objects in different projects) are displayed as: . 
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To display a document object, double click on its entry in the Trace Explorer. 

  

The Traces context menu contains the following functions: 
         

▪ Clear Suspect 

Use this option to clear suspect traces either on the selected 
objects or on all objects in the trace tree. Read more about 
suspect traces in 0. 

▪ Snapshot 

Select this option to create a snapshot on the selected 
document objects. 

▪ Trace To/Trace From 

Set and remove traces to and from document objects, see 3.4. 

▪ Remove Trace 

Select this option to remove the trace from the parent 
object(s) to the selected object(s). 

▪ Trace to the Latest Revisions 

Traces across project boundaries are not automatically 
updated to point at the latest revision of a document object. 
This function allows you to manually ensure that the last existing revision of a document object is 
traced (see 3.33). 

▪ Expand / Collapse  

Expands or collapses the nodes in the tree in different ways. 

▪ Find Objects In..  

Select Document Objects and click a sub-menu item to locate the Project Explorer, Project History 
or File Explorer. 

▪ Find Object via ID 

Use the option to find a particular document object in the Trace Tree by typing an ID in the search 
field. This field can also be used for free text search in the object titles.  

▪ Inspect  -> Display Inconsistencies on Nodes 

Display all inconsistencies for the selected nodes and their sub nodes.  

▪ Generate Reports on Nodes 

Generates one of three available reports: 

• Excel report of the trace branches of all selected. When using this function you will be 
prompted to select which Document object types to include in the traces. 

• MS Word report using a neutral look and feel. 

• MS Word report using a selected template for a customized look and feel. 
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▪ Add Tags 

Select objects and assign them to a Tag. 

▪ Create File For Objects 

Use this option to automatically create a new File Object which also creates a Word file from a 
select Word Template and inserts Document Objects into the Word document in one single action. 

▪ Copy Trace chains to Clipboard 

Copies the trace branches of all selected nodes into semi-colon separated text lines into the 
Clipboard. When using this function you will be prompted to select which Document object types to 
include in the traces. 

▪ Export Objects 

Use this option to export objects. See 3.28. 

▪ Re-draw View 

Use this option to force a refresh and re-draw of the Trace Explorer. 
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2.5.3 File Explorer 

The File Explorer allows you to manage a special type of 
document objects, called File Objects. A File Object is like 
any other document object under version control but 
also contain a file which is implicitly under version 
control.  
 
More specifically, if the file in a File Object is a Microsoft 
Word Document it in turn can contain other document 
objects. 
  
You can consider File Objects as the Word Document 
view of your project. Read more in the section 4.2. 
 
In this explorer, the context menu works very similar to 
the one in the Project Explorer. 
 
In the context menu, there is the additional possibility to 
set a snapshot on all objects that are contained in a 
Word Document.  
 
There is also a possibility to Save File To Disk without 
having to open the individual Document Objects. 
 
Furthermore, File Objects can be Synchronized directly 
from the context menu, without having to explicitly open 
the File Object and the attached Word Document. It is 
also possible to directly perform a Force Update of the 
file. 
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2.6 Document Object Forms 

Double clicking on a document (from anywhere) will display the document object in its form: 
 

  
 
In the form you can see the current revision and all attributes that belong to the document object (in the 
example above Title and Description).  
 
There exist a number of available attribute types such as String, Rich Text, Table, Date, Enum, bool 
(Checkbox) etc. For information on how to change the attributes, see 6.7. 
 
You may not delete any document object but you can disable them by checking the Disable check box and 
click <OK> (deleting a document object violates the requirement of keeping an intact audit trail for all 
changes made).  

2.6.1 Working with Rich-Text attributes 

In the picture above, the Description attribute is an example of the Rich Text attribute. Rich text attributes 
support any rich content such as Text formatting, hyper-links, images, tables, symbols or bullets and lists. 
 
To insert these into please use the context menu you get when you right-click in the text area. 
 
You can insert special symbols like €,Ω or ∑ by using the <Insert> -> <Symbol…> entry. 
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Almost all rich text features are also available for the Table Attribute with the only limitation that a cell 
cannot contain a table 

2.6.2 Hyperlinks 

With hyper-links you can also create textual references to existing document objects, files or internet urls. 
In the example below a link will be created to RQ 1 in the project ElementsV2. 
 

 
 
Hyperlinks to Document Objects can also be created by dragging and dropping a Document Object into the 
Rich Text Attribute / Table Attribute. 
 
When clicking on a link, the Document object is highlighted in the Project Explorer. 
 
It is possible to create hyperlinks to Aligned Elements Document Objects by dragging and dropping a 
Document Object to a Word document or a rich text email client. When clicking on such an external link, 
an Aligned Elements client will be opened, the corresponding project loaded (after authentication) and the 
Document Object is displayed in its Document object form. 

2.6.3 User defined formats 

To define and reuse a rich text format, select a formatted text in the rich text box and use the context 
menu to select Format-> Save Format. The selected format is saved in a xml file in the Template Folder 
with a name of your choosing.  
 
To save the format of a user defined list, make sure that the list number/bullet point is part of the selection 
before you save the format. 
 
A saved format is available in the context menu and can be applied on any selected text. 

2.6.4 Spell-checking 

In the available text, spell checking ids used. The spellchecker will underline misspelled words, just like you 
are used to from MS Word. Right click in a text field to get access to the context menu. 
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The checked Dictionaries are active when spellchecking is performed. You can also add a User Dictionary 
via the Options entry. For more info see 6.1 Spell-checking Dictionaries. 
 
Aligned Elements includes dictionaries for English, German. As default only the English dictionary is loaded. 
To activate additional Dictionaries please see 6.1 Spell-checking Dictionaries. 
 
You can also display additional details for the object in the bottom part of the form by toggling the 
<More/Less> button. The tab pages at the bottom contains (in order): 
 

▪ the revision history for the object. 

▪ the snapshots that this document object is contained in. 

▪ the reviews in which the document object has been reviewed (including review state). 

▪ a list of the current inconsistencies of the document object. 

▪ a list of tags which the document object is a part of. 

▪ a list of the signatures that have been done for the document object.  

▪ a list of document objects tracing to this document object. 

▪ a list of document objects that this document object trace to. 

▪ all attachments that this document object traces to. 

▪ all issues (open as well as closed) that this document object traces to. 

 

2.6.5 The Revision History Tab 

Open the Revision History Tab and display a previous revision of a document object by clicking on an entry 
in the revision history list. The revision of the document object will be displayed in a separate document 
object form in read-only mode.  
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The context menu can be used to display the gap between two revisions by selecting two revisions in the 
revision list and right-click with the mouse and select Show Gap. 
 
You can load attribute data from previous revisions by selecting a revision, right click with the mouse and 
select Revert to This Revision in the context menu. This will copy the attribute data from that revision to 
your current Document Object Form. This only applies to attribute data, not traces. 
 
Note! The Revert to This Revision does not activate an old revision, only copies the attribute data from that 
revision to your current Document Object Form. 
 
For File Objects, the additional possibilities exists to: 

▪ Compare Documents 
▪ Compare File Content and  
▪ Copy File Compare Summary to Clipboard.  

 

2.6.5.1 Compare Documents 

Compare Documents uses MS Words on Document Comparison mechanism. Click Compare Documents to 
automatically start Word with the document versions from the two selected revisions. 

2.6.5.2 Compare File Content 

Select two revisions of the file object containing Document Objects and use the context menu to select 
Compare File Content . This will display a comparison view, listing the Document Objects in both file 
revisions and their changes. 
The following color coding applies: 

▪ Grey lines indicate non-existing (in older revisions) or removed (in newer revisions) document 
objects. 

▪ Pink lines indicate document objects that have been changed between the two revisions. 
Double-clicking on the red lines will display a gap dialog indicating the differences between the 
two object revisions in detail. 

▪ Green lines indicate added document objects. 

▪ Yellow lines indicate modified traces. 

 
It is also possible to select one revision of the file object and apply the Compare File Content function. This 
will display a comparison view, listing the document objects in the file compared to the current state of the 
same document objects in the Project right now. 
 

2.6.5.3 Copy File Compare Summary to Clipboard 

Select two revisions of the file object containing Document Objects and use the context menu to select 
Copy File Compare Summary to Clipboard. This will copy a textual comparison summary of the Document 
Objects between the File Object revisions to the clipboard on the format: 
 
“Added Document Objects: 
<Document Objects in the later File revision, not exiting in the earlier File revision> 
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Removed Document Objects: 
<Document Objects in the earlier File revision, not exiting in the later File revision> 
 
Modified Document Objects: 
<Document Objects existing in both File revisions but updated in the later File revision>” 
 

2.6.6 Work with Table Attributes 

The table attribute is a grid-based, excel sheet-like attribute. To add new rows, use one of the following 
options: 
 

▪ Right click on the left-most number column to access the context menu to a add row above or 
below the current row. 

▪ Use the shortcut Ctrl-Shift-R to add a row above the current row and Ctrl-R to add a row below 
the current row. 

▪ Place the cursor in the last cell and click the Tab key. 

 
To delete a row, right click on the left-most number column to access the context menu to delete the 
current row or use shortcut Alt-R to achieve the same result. 
 
To copy and paste rows: 
There are a number of column types available for optimal control the user input, including: 
 

▪ Rich text column 

▪ Text column 

▪ Check box column 

▪ Date Time column 

▪ Enum Column 

▪ User Enum Column 

▪ Trace columns 

 
All these column types can be configured in the Document Object type templates, see 6.7.3. 
The trace columns can be used to designate and in some cases create traces to a particular row. 
 
Note! The Trace column contains a textual attribute reference to the row. If a trace is removed from outside 
the Document Object form, the Trace Column is not automatically updated. Only when the Document 
Object is opened again in the document object form, the traces are automatically removed from the row. 

2.6.7 Inconsistencies, Resolutions and Positive Cues 

Aligned Elements uses configurable Validation Rules to validate the existing state of the Document Objects. 
If the deviates from the Validation Rules' expectations, the deviations are displayed as Inconsistencies. 
The Inconsistency Tab displays the current inconsistencies for the Document Object. 
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The inconsistencies ought to be solved according to your development process before e.g. next milestone, 
before submitting the documentation or before an audit. 

2.6.7.1 Resolve Inconsistencies 

Aligned Elements does not only display currently outstanding inconsistencies. It also provides the user with 
direct actions to solve them. Click on the Fix button next to an inconsistency to get informed about 
available resolutions. 
 
The resolution mechanism provides available options based on the current user's permissions, the item's 
state and the project context. Select the option that is the most appropriate to resolve the inconsistency. 
 

2.6.7.2 Positive Cues 

At the top of the Document Object form, Positive Cues are optionally displayed. These are great ways to 
rapidly indicate the "health" of the current Document Object.  
 
A Positive Cue is a collection of inconsistency rules that are evaluated together. The Positive Cue bar 
displays all Positive Cues available for the Document Object. 
 
If any of the rules in a cue is not fulfilled, the dot is coloured with a negative colour (usually red) and the 
number of unfulfilled rules.  
 
If all rules are fulfilled, the dot is coloured with a positive colour (usually green) and the number zero. 
 
Use the Context Menu on a Positive Cue to access the Resolution Options for each outstanding 
inconsistency. 
 

2.6.8 The Gap Dialog 

When you have completed your changes in the document object form, you can click <OK> to commit your 
changes to the database or <Cancel> to discard the changes made. 
 
As a part of committing your changes, you will be requested to add a change comment which should state 
the reason to why the changed were performed. 
You can chose to reuse existing change comments, to use standard comments and optionally to suppress 
that automatic mechanism that sets traces from the Document Object to “suspect” after the commit. 
Read more about Gap Dialog options in 3.39. 
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In this form you can also propagate the change comment to related issues by selecting the relevant traced 
issues from the drop down form provided that you have clicked OK -> Close Issues in the Document Object 
Form. These issues will consequently be closed after the commit. 
 
To compare the current modifications with the previous revision of the document object, click on <Show 
Differences>. 
 

 
 
 
Note! If several document objects traces to this object, beware of that the Issue is closed for all the related 
document objects. 
 
To display more than one document object next to each other in the Document Object Form, see 3.38. 
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If multiple document objects have been changes, you may re-use the change comment for all of them (e.g. 
when modifying a Failure-mode and underlying Hazards). To do this, check the Use comment for all check-
box (is only displayed when multiple document objects exist) in the Gap Form.  
 

 

2.7 Shortcuts in Explorers and Document Object Form 

The following shortcuts are available: 
 
Project / File Explorer 
Enter  Open the selected Document Object(s) 
Ctrl-O  Open the selected Document Object(s) 
Ctrl-Shift-O Open the selected Document Object(s) in read-only mode 
Ctrl-N  Create new Document Object 
Ctrl-Shift-N Create a new Chapter 
Ctrl-C  Copy a Document Object or Chapter structure 
Ctrl-V  Paste a Chapter Structure 
F2  Change name on Chapter 
Delete  Delete empty Chapters 
Ctrl-S  Set Snapshot on selected objects 
Ctrl-F  Find Object via ID 
Shift-C Copy ID and Title of select Document Objects to clipboard 
 
Trace Explorer 
Ctrl-D  Expand All 
Ctrl-S  Set Snapshot on selected objects 
Ctrl-F  Find Object via ID 
 
Document Object Form 
Ctrl-S  Save Document Object 
Ctrl-Shift-S Save Document Object without closing it 
Ctrl-Alt-S Save Document Object and Open new Document Object Form 
Esc  Cancel Document Object form 
Ctrl-Y  Toggle display of Detail Panel 
 
Various Views 
Ctrl-C  Copy to Clipboard 
Ctrl-Q  Find Object in Trace Explorer 
Ctrl-W  Find Object in Project Explorer 
Ctrl-E  Find Object in Project History 
Ctrl-T  Find Object in File Explorer 
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2.8 Views 

2.8.1 Attributes 

The Attribute view displays a quick preview for the currently selected document object without having to 
open it in the document object form. 
  
Note! Every time an object is selected in a View, the details are displayed in the Attribute View. This 
requires the object to be loaded from the database. If the Attribute View is not displayed, the object is not 
loaded and performance is increased. To increase the performance of Aligned Elements, do not display the 
Attribute view more than necessary. 
 

 
 

2.8.2 Project History 

The Project History View displays all changes that are made in the project. 
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With the use of the context menu (right-click in the view), you get access to the following functions: 
 
 
 
With the Filter option, you can decide which type of Project Events 
that shall be displayed. Normal modification events (i.e. when a 
document object is added or modified) are always displayed. 
 

 
 
With the Set Time Span option you can select to display the 
Project Events for a certain period. Default is set to 1 Week. 
 

 
 
Use can use the Expand / Collapse All options to expand and collapse subgroups. You can also click on the 
list headers to sort the Project History according to the column.  
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Find Object In will select/mark the corresponding Document Objects in the Project Explorer, Trace 
Explorer or File Explorer when applicable. 
 

 
 
Find Object via ID allows you to filter the content to events that are associated with individual Document 
Objects. You can search for several IDs simultaneously by entering the IDs separates with semi colons (‘;’) 
(e.g. TC123; RQ 2; PS 3). 
 

 
 
Just like in the other views, this option can optionally be used for finding a particular word in the Project 
History.  
 
Use the Copy To Clipboard option to copy the text of the selected events to the Clipboard. 
 
Use the Create Excel Report option to generate an excel report of the currently selected Project Events. 
 
Tip: To see any changes since your last login, select Set Time Span -> Since Last Login in the context menu. 
 

2.8.3 Search Results 

The Search Result View displays all results (Document Objects and Chapters) found after performing a 
free-text search in the Search Tool in the menu toolbar. Here you can search for a text in all document 
object types as well as within the set of a specific document object type as you select in the drop down 
menu.  
 
Note! The search applies to String, Rich Text, Table attributes, chapter names, content of files and 
Document Object IDs. It is for example not possible to search for an integer (e.g. Priority or Severity) or a 
status value with this method. 
 
Use (double) quotes to define combined notion i.e. if you look for all document objects containing the 
word Use Case, then enter “use case” (with quotes) in the search field instead of use case (without quotes) 
which will look for the occasions of the word ‘use’ and the word ‘case’ individually. 
 
You may also search for document objects based on their IDs, e.g. RQ 4. The result will include document 
object RQ 4 but also return any textual references. 
 
Note! The search function is case-insensitive but does search for exact matches. Thus, if you enter “empt”, it 
will not find objects containing the word “empty”. You can apply the asterisk (*) to search for word stems. 
In the example above, “empt*” would find objects containing the word “empty”. 
 
The default search only retrieves currently enabled document objects but you may also include currently 
disabled objects using the additional selection arrow next to the binocular icon.  
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Note! Short search expression such as ‘0’, ‘a’, ‘i’ or ‘or’ will not produce any results since these are 
considered “noise-words” that are ignored when database full-text indexing is used (see 6.10.5). 

 

 
 
Double-clinking on an entry will display the Document Object page. 
 

 
 
With the use of the context menu (right-click in the view), you get access to: 
 

▪  Update Multiple Items – works just like in the Project 
Explorer. 

▪ Copy To Clipboard – copies the text of the select objects to 
the clipboard. 

▪ Find Object In which will select/mark the corresponding Document Object in the Project 
Explorer, Trace Explorer, Project History and File Explorer when applicable. 

▪ Add Tags assigns a tag to the selected objects. 

 
 
Note! Aligned Elements relies on Sql Server full text search including using so called Ifilters which enables 
search in attached and uploaded documents, see 6.10.5. When applied the search function searches the 
content of attached files of a large number of file types. 
 
The Search Result View also supports drag functionality for setting traces using drag and drop in the 
Project and Trace Explorer. 
  

2.8.4 Issues View 

The Issues View displays all issues in the project. Click on the table headers to sort the list according to the 
values in each column. 
 
Double click on a line to open the corresponding issue in a Document Object Form. 
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Use the context menu (right-click in the view) to access the following functionality:  
 

▪  Open Issue and Add Issue, opens the selected 
Issue(s) for editing and creates a new Issue 
accordingly. 

▪ Update Multiple Items with attribute changes in 
batch mode. 

▪ Use the Assigned To option to assign an issue to a 
user without opening the Document Object form. 

▪ Use the Filter settings to display subsets of all 
issues. The last filter settings are stored. 

▪ Find Object in the Project, Trace or File Explorer. 

▪ The Inspect menu allows access to  

o Display Inconsistencies on the selected issues. 

o Display Consistency Coverage of the same issues. 

o Display Chart of the selected issues. 

▪ The Create Report menu allow access to 

o Excel Report generates an Excel file containing the currently selected Issues. 

o Word Report generates a report in word format containing all selected Issues. 

o Word Report (from Template) generates a report in word format containing all selected 
Issues. The format of the issues will be based on the currently defined word templates 

▪ Add Tags assigns tags to the selected objects. Also see 3.14 

▪ Lock Document Objects prevents document object from being updated by other users.  

▪ Create File for Objects creates a file object for the selected issues. Also see 2.5.1.1 

▪ Copy to Clipboard copies the selected information to the clipboard. 

▪ Export Objects exports the selected objects to files. See 3.28. 
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2.8.5 Reviews View 

The Reviews View displays all reviews in the project. Click on the table headers to sort the list according to 
the values in each column. 
 

 
 
Use the context menu (right-click in the view) to get the same options as in the Issue View. 
 
You can also use the context menu to set filter options on the Reviews View such as Status and Due Date, 
Assigned Users or to display the inconsistencies. The pre-defined filter “My open Reviews(s)” displays 
currently open reviews where the logged in user is assigned. 
 
Double click on a line to open the corresponding review in a Document Object Form. 

2.8.6 Signature View 

Note! The digital signature functionality is contained in an add-on package and needs to be ordered 
separately from Aligned AG.  
 
The Signature View displays all Signatures in the project. Click on the table headers to sort the list 
according to the values in each column. 
 

 
 
Use the context menu (right-click in the view) to create new Signatures. 
 
You can also use the context menu to set filter options on the Signature View such as Status and Due Date, 
Assigned Users or to display the inconsistencies for all (select only one signature) or selected (select 
multiple signatures) signature. The pre-defined filter “My open Signature(s)” displays currently open 
signatures where the logged in user is assigned.  
 
Double click on a line to open the corresponding Signature in a Document Object Form. 
 
To sign a signature directly from the view, select it in the list and use the option ‚Sign‘ in the context menu.  
Note! Before a user can successfully sign, the reason for the signature has to be set.  
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2.8.7 Favorites View 

 
 
The Favorites View contains Document Objects marked as favorites by the user. Marking a Document 
Object as favorite can be done in the Document Object Form (by clicking on the Star icon making it yellow) 
or by dragging and dropping objects into the Favorites View.  
 
 
The View can contain Document Objects of different types and also Document Objects from linked 
projects. When a Document Object is modified by anyone, the View is automatically updated to display the 
most current revision of the Document Object.  
 
By activating the Notify me on change option for a Document Object, an email will be set to you as soon as 
the Document Object in question is updated (attributes are changed) containing a description of the 
changes and a hyper link to the Document Object.  
 
By using the Set Group on Selected option in the context menu, it is possible to associate the selected 
items to an entered text label. Use the Group function to organize your Favourites. 
 
Note! Notify me on change only works if your User has been set up with an email address in the User 
Manager and if the Smtp Mail option has been set up in the Project Settings. 
 
The content of the Favorites View is personal i.e. only applicable to the logged in user. 
 
A number of options are available in the Favorites View context menu, similar to the ones of the Issue 
View and/or Project View. 
 
Note! Document Objects of non-current revisions can be added to the Favorites View. However, it is the 
most current revision of the object that is stored in the database i.e. if the Document object is updated, the 
Favorites View is refreshed to display the most current revision. Likewise, if the project is closed and 
reopened, it is the most current revision of the object that is displayed.  
 
 

3 How to… 

3.1 Create a Project 

Select Open/Create Project from the File menu option (or just start Aligned Elements). Click on the <New 
Project> button and type a new and unique name for the project in the name field.  
You are then prompted browse to the location of your document object templates. Do so by browsing via 
your network locations to the document object template share to ensure that other users also can reach 
the same location from their PC:s (If you want to adapt any templates, please read the section 6.7.) 
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Thereafter you are asked to create the Initial User (see 3.2 for password standards): 
 

 
 
Please keep your Initial user credentials in a safe place. This is the original administrator for the project. 
 
An empty project is loaded and you can start managing your project (e.g. create additional users) and enter 
data. 
 

3.2 Change Your Password 

When opening a project you are prompted with the following login dialog. 
 

 
 
To change your password, check the Change Password check-box and log in as normal. You will then be 
presented with an additional dialog where you can add your new password: 
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A password needs to be at least 6 characters long and should contain a combination of upper and lower 
characters, numbers and special characters to be approved as safe.  
 
If you have forgotten your password, ask your administrator to reset it for you. 
 
Note! If you are working with linked projects, it can sometimes be convenient to change the password for 
your user(s) in all linked projects at the same time. If projects are linked to your current project and you 
change your password, you will be asked if you want to update the password in all linked projects for your 
user. If you click <Yes>, please note that you have to load the linked projects in order to for the password to 
change. 
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3.3 Work with Chapters 

Use the context menu in the Project Explorer to access the operations available for chapters. 
 

 
 
You can move chapters to other chapters using Drag and Drop.  
 

▪ Use Add Chapter to add a chapter to the root chapter (the ribbon with the Document Object 
Type Name e.g. “Requirement”) or to another chapter. A chapter name does not have to be 
unique. 

▪ Use the option Rename Chapter to change the name of the chapter. 

▪ Use the option Remove Chapter to remove the chapter. 

 
Note! The chapter (or the corresponding sub chapters) cannot be removed if it/they contain one or more 
Document Objects. 
 
If several of your books contain the same chapter structure, you can Copy a Chapter Structure and Paste it 
into the books. 
 
If you want to use a chapter structure in a different project, Export the Chapter Structure to a file, and 
Import it in the target project.  
 

3.4 Create and removing Traces between Document Objects 

There are a number of ways of creating traces between document objects. However, not all ways are 
applicable for creating traces between projects. Traces can be set to and from master and linked projects 
in all explorers, but traces cannot be set from linked projects in the detail view. 
 
Note! The revisions of the document objects involved in a trace operation are NOT incremented. 
 

3.4.1 Using “Generate” in the Project Explorer  

When you use the generate function in the Project Explorer generate a test case from a use case or 
generate a risk analysis from a specification a trace is automatically created between the two objects. 
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Automatic traces are also set in failure modes to any Hazards and further on to any created mitigations 
(see 3.9). 

Generating an object also implies that attribute values are copied from the original to the generated 
document object for all attributes that have the same name and type in both the original and generated 
document object type definition.  

The generation mechanism attempts to place the generated Document Object in the same chapter path as 
the original object, provided that such a chapter path exists. If it does not exist, the generated object will 
be placed under the root of the Document Object Type, unless the corresponding template has been 
configured to automatically recreate the chapter structure in the target type. 

If a single Document Object is generated, the Document Object is displayed in the Document Object form 
and is not committed until the user clicks OK. 

If multiple Document Objects are generated, the Document Objects are automatically committed and are 
not displayed in the Document Object Forms. 

 

 
 
 

3.4.2 Using the Trace To/From context menu option in the Project and Trace Explorer 

Right-click on one or more document object in the Explorer to activate the context menu and click the 
Trace To/From context menu option to open the Select dialog.  
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In this dialog, select the document objects you want to create traces to and click <OK >. You can also use 
this dialog to remove existing traces by simply unselecting these document objects in the Select dialog. If 
you have loaded any linked projects (see 3.33), you may also set traces to/from document objects from 
these projects. 
 
In the Chapter List, the chapter structure of the selected type is displayed. You have the possibility to select 
single objects or all objects that below to a chapter. 
 
In the Searchable List, you have the possibility to search for keyword in the title of the potential traces. The 
List uses a fuzzy logic approach to find potential matches. 
 

3.4.3 In the Document Object Form’s “Trace To / From” tab in the Detail View 

 
In the detailed view for any document form, you have the possibility to create traces from the current 
document object to other objects. Right click in the tab page to activate the context menu and select the 
Set Trace menu option to open the Select dialog. In this dialog, select the document objects you want to 
create traces to and click <OK >. You can also use this dialog to remove existing traces by simply 
unselecting these document objects in the Select dialog. 
 
Another way to remove traces is to mark one or more entries in the detail view and to select the Remove 
Traces menu option in the context menu.  
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This is also what a way to create Attachments or Issue to your document object in the Attachment and 
Issue tab page respectively. 
 

3.4.4 Drag an object from the Project or Trace Explorer onto a tab in the detail view of a Document 
Object Form 

 
You can also drag a document object from the Project or Trace Explorer onto the tab of the Detail View. 
Depending on if you drop the document object in the “Trace To” or “Trace From” tab, a trace is created to 
or from the displayed document object to/from the dragged and dropped document object. You may also 
drag issues to the Issue tab in the same way.  
 

3.4.5 Drag and Drop in Project and Trace Explorer  

You can also set a trace using drag and drop inside the Project and Trace Explorer. Select one or more 
document objects in the Project or Trace Explorer Tree View and drop them on the object you want to 
trace these objects from. You will be prompted with a message box to acknowledge the setting of the 
trace(s). To remove a trace in the Trace Explorer, right-click on the child object of the trace and select 
Remove Trace in the context menu. 
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3.5 Adding and creating an Attachment 

An attachment is a neutral document object that contains a file (like an attachment to an email). Since 
Attachments are just like any other document object, they can be attached to several “parent” document 
objects by tracing. 
 
To trace an attachment to a document object, open the document 
form (double-click on the document object in e.g. the Project 
Explorer) and select the tab Attachments in the detailed view at the 
bottom of the form.  
 
Right click in the list to get a context menu containing two options. 
Here you can either set a trace to already existing attachments or 
create new attachments. A Document Object Form for the 
attachment document object is displayed when selecting the Create option. In this form you can write a 
title and a description of the file you intend to attach. To attach a file, click on the  
<Browse > button and browse to the intended document. Any document type (word documents, pdf, jpg 
images etc.) that your PC can display is valid as attachment files.  
 
Hint: When you create a new attachment you can also just drag and drop your file from your windows 
explorer into the attachment tab or use Ctrl-C / Ctrl-V to “copy” a file from a windows explorer into your 
attachment page.  

 
Create a new Attachment per Drag and Drop 

 
After the file is linked to the attachment, you can click on the <hyper link> to display the file itself. The file 
will then be displayed in its default application (e.g. Microsoft Word, Adobe Reader, Paint etc.). 
 
Click <OK> in the Attachment Form to save the new object. You will now see the attachment listed in the 
detail view of your original document object. 
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Attachments are displayed in the Project Explorer below their parent document objects. 
 

 
 
 

3.6 Update Multiple Items – Batch Updates 

3.6.1 Set new Attribute Values 

Use this action to update an attribute value for several Document Objects in a single action i.e. in a batch 
update.  
Select the Document Objects to include in the batch change and click on the Update Multiple Items 
context menu item in the corresponding View.  
 
Note! Update Multiple Items can only be applied on items with the same Document Object Type. 
 
In the Update Multiple Items dialog, select the Attribute to update and add the new attribute value. 
 
Enter a Change Comment that will be applied to all Document Objects updated in this action. Click OK to 
start the update. All updated items will get a new revision. 
 
Note! If one of the selected Document Objects are currently locked for editing by another user, that item 
will not be updated. It is therefore advisable to check the lock state of the objects before performing the 
batch update. Locked items can be inspected in Project => Unlock Objects. 

3.6.2 Change Fonts in Rich Text and Table Attributes 

Content in both Rich Text and Table Attributes are, as opposed to String Attributes, always styled with a 
font. When a Rich Text or Table Attribute value is inserted into a Word document, the font used in the 
attribute value is applied when depicting the value in the Word document (regardless of which fonts the 
Word document styles prescribe). 
 
Sometimes it is desirable to harmonize the fonts applied in the attribute values with the font of a given 
Word Template. Use this action to update the font and font size in  multiple items in a single action. 
 
Select the Document Objects to include in the batch change and click on the Update Multiple Items 
context menu item in the corresponding View.  
 
Note! Update Multiple Items can only be applied on items with the same Document Object Type. 
 
In the Update Multiple Items dialog, select the Change Font in the attribute dropdown.  
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Select the new font name and font size. Select the attributes in the Document Object type to which the 
change shall apply. 
 
Enter a Change Comment that will be applied to all Document Objects updated in this action. Click OK to 
start the update. All updated items will get a new revision. 
 
Note! If one of the selected Document Objects are currently locked for editing by another user, that item 
will not be updated. It is therefore advisable to check the lock state of the objects before performing the 
batch update. Locked items can be inspected in Project => Unlock Objects. 

3.6.3 Replace Words in String, Rich Text and Table Attributes 

 
Use this action to replace words in String, Rich Text and Table Attributes of multiple items in a single 
action. 
 
Select the Document Objects to include in the batch change and click on the Update Multiple Items 
context menu item in the corresponding View.  
 
Note! Update Multiple Items can only be applied on items with the same Document Object Type. 
 
In the Update Multiple Items dialog, select the Replace Word(s) in the attribute dropdown.  
 
Enter the Search Term and Replace Term and apply the Match Case checkbox if needed. 
Select the attributes in the Document Object type to which the change shall apply. 
 
Enter a Change Comment that will be applied to all Document Objects updated in this action. Click OK to 
start the update. All updated items will get a new revision. 
 
Note! The Replace Word(s) function does not have a Whole Word option and will therefore replace any 
occurrence of the search term with the replace term, including when the search term is _part_ of a word. 
 
Note! If one of the selected Document Objects are currently locked for editing by another user, that item 
will not be updated. It is therefore advisable to check the lock state of the objects before performing the 
batch update. Locked items can be inspected in Project => Unlock Objects. 

3.7 Perform a Query 

A query is a way to filter out Document Objects based on certain filter criteria. In Aligned Element you can 
add Queries, modify, copy and rename Queries and also delete them. A query essentially consists of:  

▪ an input set of document objects  

▪ a search mode 

▪ a number of filters 

 
These three in combination yield an output set of Document Objects. Queries can be performed on 
Document Objects in the master project and the linked projects.  
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To create a Query, click Query -> New… in the main menu. As a second step you define the target 
Document Object type for your query. A Query can only be performed on a Document Objects of the same 
type e.g. Requirements or Specifications.  
 
The third step is to define if you want to use a Static or Dynamic Input Set. The difference can be explained 
as follows: 
 

▪ A Static Input Set consists of a defined number of document objects. If a Document Object 
becomes disabled, it is automatically removed from the input set. If a Document Object in the 
input set is modified, the input set is updated to include the new revision of the object. 
However, if a Document Object created/added, it is NOT automatically added to the input set. 
The user has to explicitly add it to the input set using drag-and-drop. 

▪ A Dynamic Input Set consists of a defined number of chapters (and optionally their sub 
chapters) and implicitly of all Document Objects in those chapters. The set is updated for 
disabled and modified Document Objects just as for Static Input Sets. The big difference is that a 
Dynamic Input Set automatically includes Document Objects that have been created/added or 
moved to its chapter set.  

 
 
When the input set type has been defined, the Query form is displayed. 
 

 
 
Drag and drop Document Objects or chapters from the Views and Explorers into the Input List on the left 
side. You can click on the headers to sort the Input set or double click on an item to display it. 
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Note! When dragging and dropping a File Object containing a word document that holds Document objects 
into the Input List, the ObjectsInFile of the File Object corresponding to the target Document Object type of 
the query are listed in the Input List. This is only available when using a Static Input Set. 
 

3.7.1 Search Mode 

The Search In dropdown defines how far in the Document Object history the query shall search and what 
to include in the output. The following search modes are available: 

3.7.1.1 Current Revision (exclude disabled) 

This is the default search mode. The search is only considering the most current revision of the Document 
Objects in the input set, but excludes currently disabled Document Objects. 

3.7.1.2 All Revisions (exclude disabled) 

The search mode considers all revisions of the Document Objects in the input set, but excludes currently 
disabled Document Objects. The output set can thus include several revisions of the same object. 

3.7.1.3 All Revisions, Get Last (exclude disabled) 

The search mode considers all revisions of the Document Objects in the input set, but excludes currently 
disabled Document Objects. The output set yields only the (chronologically) latest match of all revisions of 
the same object. The output set thus only contains one revision for each Document Object. 

3.7.1.4 Current Revision, include disabled 

This search mode only considers the most current revision of the Document Objects in the input set, and 
includes currently disabled Document Objects. 

3.7.1.5 Current Revision, only disabled 

This search mode only considers the most current revision of the Document Objects that are disabled. 

3.7.1.6 All Revisions include disabled 

The search mode considers all revisions of the Document Objects in the input set, including currently 
disabled Document Objects. The output set can thus include several revisions of the same object. 

3.7.1.7 All Revisions only disabled  

The search mode yields all disabled revisions of the Document Objects in the input set. The output set can 
thus include several revisions of the same object. 

3.7.2 Adding Filters 

Then select and add filters using the plus sign next to the Filter selection box. 
 
As a next step, define the Attributes be included in the Output grid. A separate column is created for each 
attribute. 
 

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  55 / 269 

 
 
Click Refresh to update the Output set. The output set can be sorted by clicking on the headers. 
 
Click Save to commit the query. If the Query has not been saved before, you will be prompted to add a 
(unique) name for the query. You can also use the Save Drop Down button to Rename the Query or to 
Create A Copy of an existing query. 
 
Use the Delete button to delete the Query. 
 
Note!  
Queries are really deleted, not disabled. You cannot re-access a deleted Query. 
The Filters are combined using the AND rule. 
 

3.7.3 Attribute Value Filter 

Matches Document Objects that corresponds to the given value of the selected attribute. First select the 
attribute to filter on, then set the Modifier to either “contains” , “not contains”, “is empty” or “is not 
empty” and then enter the attribute value (or part of the attribute value).  
 
E.g. the following Filter yields all objects that have a Description that does not contain the word “blue”.  
 

 
 
Note!  
This filter is case-insensitive. Quotes do not apply. 
Aligned Elements provides the option to use Sql Server full text search to increase the performance of 
attribute queries, see Using Sql Server Full Text Search 
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3.7.4 Trace To Filter 

Matches Document Objects that trace (or not trace) to Document Objects of a given type in given projects. 
Select the Document Object Type to trace to (can be one or more), then in which Projects these traced 
objects may reside and finally set the Modifier to either “any”, “all” or “none”. The Modifier work as 
follows: 
 

▪ Trace to “any” of “Specification” and “Use Case” yields objects that trace to at least one 
Specification OR at least one Use Case (or both). 

▪ Trace to “all” of “Specification” and “Use Case” yields objects that trace to at least one 
Specification AND at least one Use Case. 

▪ Trace to “none” of “Specification” and “Use Case” yields objects that do not trace to any 
Specification or Use Case. 

 
 
E.g. the following Filter yields all objects that have at least one trace a Specification OR a Use Case in the 
Master Project “Test Project”. 
 

 
 
 

3.7.5 Trace To/From Query Filter 

Matches Document Objects that trace (or not trace) to/from Document Objects in the Output set of other 
Queries. You can use this filter to combine Queries. Set the Modifier to “any”, “all” or “none” and then the 
Query that contains your target set. The Modifier work as follows 
 

▪ Trace to “any”  yields objects that trace to at least one object in the Target Query Output set. 

▪ Trace to “all”  yields objects that trace to all objects in the Target Query Output set. 

▪ Trace to “none”  yields objects that trace to none of the objects in the Target Query Output set. 

 
E.g. the following Filter yields all objects that have at least one trace to an object that is member of the 
Target Query’s Output set.  
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3.7.6 Trace From Filter 

Matches Document Objects that have incoming traces from Document Objects of a given type in given 
projects. Select the Document Object Type for the incoming traces (can be one or more), then in which 
Projects these incoming-trace objects may reside and finally set the Modifier to either “any”, “all” or 
“none”. The Modifier work as follows: 
 

▪ Trace to “any” of “Specification” and “Use Case” yields objects that have incoming traces from 
at least one Specification OR at least one Use Case (or both). 

▪ Trace to “all” of “Specification” and “Use Case” yields objects that have incoming traces from at 
least one Specification AND at least one Use Case. 

▪ Trace to “none” of “Specification” and “Use Case” yields objects that do not have incoming trace 
to any Specification or Use Case. 

 
E.g. the following Filter yields all objects that have at least one incoming trace from a Specification OR a 
Use Case in the Master Project “Test Project”. 
 

 
 

3.7.7 Revision Date Filter 

Matches Document Objects that have been created or modified before or after a certain date. Set the 
Modifier to “created before”, “created after”, “modified before”, “modified after” and then set the target 
date.  
 
E.g. the following Filter yields all objects that have been modified after April 18th. 
 

 
 

3.7.8 Revision Number Filter 

Matches Document Objects that have a revision number greater, less, equal or not equal a certain number.  
 
E.g. the following Filter yields all objects that have been modified more than twice. 
 

 
 

3.7.9 Revision Author Filter 

Matches Document Objects that have a revision author that has created/not created, modified or not 
modified an object.  
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E.g. the following Filter yields all objects that have been created by the user “Kallis”. 
 

 
 

3.7.10 Revision Comment Filter 

Matches the Document Objects where the most current revision has a Change Comment containing or not 
containing a particular word.  
 

 

3.7.11 Inconsistency Filter 

Matches Document Objects that have (or have not) a certain inconsistency.  Select the Inconsistency Type 
and then set the Modifier to either “any”, “all” or “none”. The Modifier work as follows: 
 

▪ Modifier “any” of Inconsistencies “Issue Open” and “NotReviewed” yields objects that have at 
least one open issue OR is not Reviewed (or both).  

▪ Modifier “all” of Inconsistencies “Issue Open” and “NotReviewed” yields objects that have at 
least one open issue AND is not Reviewed. 

▪ Modifier “none” of Inconsistencies “Issue Open” and “NotReviewed” yields objects that have no 
open issue AND is Reviewed i.e. that have none of the described inconsistencies 

 
E.g. the following Filter yields all objects that have an issue open OR is not Reviewed. 
 

 
 

3.7.12 RPN Filter 

The filter allows you to define a query based on the calculated Risk Priority Number value. It only applies to 
document object types such as Failuremode or RiskAnalysis and their underlying 
Hazard/ProbabilityOfHarm.  
You can apply the filter before or after Mitigations and include the RPN and/or RPNThreshold values in the 
query result.  
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3.7.13 RPN Threshold Filter 

The filter allows you to define a query based on the calculated RPN Threshold (e.g. Acceptable, In-
Acceptable, ALARP/ALAP). It only applies to document object types such as Failuremode or RiskAnalysis 
and their underlying Hazard/ProbabilityOfHarm.  
You can apply the filter before or after Mitigations and include the RPN and/or RPNThreshold values in the 
query result.  

 
 

3.7.14 Function Filter 

The filter allows you to define a complex condition using c# syntax. The result of the function must be a 
Boolean (true/false) and as parameters any Document object attribute string values can be defined where 
the name of the parameter is the name of the attribute. 
 

 
 

3.7.15 Tag Filter 

The filter allows you to sort out all Document Objects that belong (or not belong) to one or more tags. 

 
 

3.7.16 Signed Filter 

This filter is primarily used for File Objects. It filters out items that has (or has not) a Signature with a 
particular Signature status (as configured in the Signature.rvt). 

3.7.17 Test Run Filter 

Document Object types (Test types, Configuration types and Test Result types) that belong to a Test Run 
can be filtered based on them being part (or not being part of) one or more Test runs. 

3.7.18 Locked Queries 

Users with Project Management user rights have the possibility to Lock (and unlock) a query by checking 
the Locked checkbox. A locked query design cannot be edited or disabled by other users. 

3.7.19 The Query Output List  

The context menu of the Output List contains the following options: 
 

▪ The Number of Objects that meet the filter conditions. 

▪ Select all objects displayed in the list. 

▪ Group Results display of the objects in a tree structure. 
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▪ Display -> Expand / Collapse all entries (only valid for Tree 
display) 

▪ Update Multiple Items in batch mode. 

▪ Set Snapshot on Selected or on All Document Objects in the 
output view. 

▪ Trace To / From the selected objects. 

▪ Find And Highlight a particular word in the output list. 

▪ Find Object in a Project Explorer, Trace Explorer or File 
Explorer 

▪ Inspect the selected document objects by: 

o Display Inconsistencies on the selected Document Objects. 

o Display Consistency Coverage on the selected Document 
Objects. 

▪ Add Tags by assigning Tags to the selected Document Objects 

▪ Lock Document Objects to prevent them from being updated. 

▪ Create Report menu allow access to: 

o Excel Report generates an Excel file containing the selected objects from the output set. 

o Word Report generates a report in word format containing the selected objects from the 
output set. 

o Word Report (from Template) generates a report in word format containing the selected 
objects from the output set. The format of the issues will be based on the currently defined 
word templates 

▪ Create File for Objects creates a new File Object which also creates a Word file from a select Word 
Template and inserts Document Objects into the Word document in one single action. 

▪ Copy the data of the selected rows to the clipboard for editing outside Aligned Elements. 

▪ Export the selected Document Objects 

 
You can also use drag and drop items from the Query Output to the Project or Trace Explorer to set traces. 
 
Furthermore, Query Output Sets can be used in the Word Integration, see more information about this at 
4.8. 
 

3.8 Create and run a Trace Table 

 
A Trace Table is a table where the traceability between Document Objects is depicted as table row, 
showing the trace chain from left to right. In Aligned Element you can create, run, modify, copy, rename 
and delete Trace Tables. 
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The Trace table essentially consists of three parts: 
  

▪ an input set of document objects  

▪ a number of column definitions defining the trace chains 

▪ the output view, running the input set through the column trace chain definitions 

 
Trace Tables can be performed on current Document Objects in the master project (when using the From 
Database, Query or Custom input set) and the linked projects (when using the Query input set). Document 
Objects from snapshots or of older revisions cannot be included in a Trace Table. 
 
To create a Trace Table, click Traces -> New Table… in the main menu. 
 

 
 
Use the buttons Add Column and Remove Column to add and remove columns. Columns are added and 
removed from the right. 
 
Each column is of a designated Document Object Type. Furthermore, use the plus and minus buttons to 
add the attributes to be displayed for the Document Object Type. In the output view, each attribute is 
displayed in a separate column. The IDs are displayed as hyperlinks. Double-click on an ID to open the 
Document Object in the Document Object Form. 
 
To run the Trace Table, click <Refresh>. This will populate the output view with the column definitions. The 
sort order is based on the IDs in the left most column (the input set). You can also use the <Refresh> drop 
down button to save the Trace Table as Excel or Word document. 
 
Click <Save> to commit the Trace Table definition to the database. If the Trace Table has not been saved 
before, you will be prompted to add a (unique) name for the trace table. You can also use the <Save> drop 
down button to <Rename> the Trace Table, to <Save a copy> of the definition or to use the <Save as Word 
Template> to save the definition as a Word template to be used in Word (see section 4.14). 
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Use the <Delete> button to delete the Trace Table. 
 
The <Wrap Text> checkbox is used to wrap long texts within their visible cells. 
 
The <Column Size> dropdown can be used to modify how the columns are distributed and displayed. 
 

3.8.1 Trace Table Input Sets 

The input set specifies the Document Objects that make up the “root” of the Trace Table. These objects are 
used to populate the trace table’s left most column in ascending ID order. There are three different Trace 
table input set types: 
  

▪ From Database – all most current document objects of the selected type in the main project 

▪ Query – the Document Objects that are resulting from the selected query. 

▪ Customized – a hand-picked set of Document Object among the most current document objects 
of the selected type in the main project. 

▪ Snapshot – the left most column is populated with items of the given type from the snapshot 
and the rest of the trace table is populated with items from the time of the snapshot 

3.8.2 Upward trace tables  

Tick the checkbox Upward traces to define a Trace Table showing traces in the upward direction 
(remember that Aligned Elements traces are unidirectional, pointing from a source to a target; using the 
upward trace table enables depiction in the reverse direction). 
 

 
 

3.8.3 Trace Tables in Advanced Mode 

Tick the checkbox Advanced Mode to activate a multi-branch Trace Table.  
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When activating this mode, all columns to the right of the second column receives an additional number 
selection field for specifying the parent column. In the example above, the third column (the Use Case 
column) specifies the first column (the Requirement column) as parent column. 
 
In the output view, the second column shows specification tracing from the requirements in the first 
column and the third column shows use cases tracing from requirement in the first column. 
 
This can be particularly useful when compiling trace tables for Risk Items such as for Failuremodes or PHA 
which involves several Document Object Types. 
 
Note that all Risk Factors (Severity, Probability etc) and Risk Reduction Factors (Probability Reduction, 
Severity Reduction etc) must be present in the table in order for RPN, NRPN, Thresholds etc to be correctly 
calculated. 
 
Furthermore, the Advanced Mode also permits the use of Queries to populate the columns in order to 
restrict the search set of the Trace Table. 
 

3.9 Perform a FMEA 

When performing an FMEA, three different document object types are involved. The central document 
object is the Failure Mode that contains and combines entered causes and effects into Hazards (which is 
the second document object type involved). Hazards generate a Risk Probability Number which grades how 
serious the danger of the hazard is. The Risk can be reduced by creating and assigning Mitigations to the 
Hazard. 
 
Failure mode, Hazards and Mitigations are connected through traces visible in the Trace Explorer. 
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A Failure Mode is generally an output from a specification i.e. “what risks are involved in the requirement 
solution being specified in this way”. However, it is also possible to create Failure modes as free standing 
objects. 
 
To perform a FMEA (Failure Mode Effects Analysis) risk analysis: 
 

1. Generate a Failure mode from e.g. a specification via the context menu in the Project Explorer 
(right-click with the mouse on a specification and select Generate Failure mode) 

 
2. In the Failure mode document object form you can describe the Failure mode in the title which is 

usually a functional family which applies to the specification. E.g. for the specification Create 
analyses of serum you could have the failure mode No result created. 

 
3. Define one or more effects for the Failure mode and quantify their severity according to your 

company standards. 
 

4. Define one or more causes for the Failure mode and quantify their probability according to your 
company standards. 

 
5. As you see, each permutation of the listed causes and effects generates a hazard in the Risk table in 

the lower part of the form. 
 

6. Define the visibility for the Hazard and quantify it according to your company standards. 
 

7. The risk probability number (RPN) is calculated as severity (from the effect) x probability (from the 
cause) x visibility (from the combination of cause and effect). 
An acceptable RPN is displayed in green. However, if the RPN is higher than a pre-defined threshold 
(configurable as described in 6.7.7), the number is displayed in red. Optionally you may also 
configure an intermediate level, ALARP (as low as reasonably possible), in which case the RPN 
would display itself in yellow. 

 
8. For the generated hazards you may add Mitigations with the intention to reduce the RPN to an 

acceptable level.  
 

9. To create a new mitigation click on the <New> button for the applicable hazard. The Mitigation is 
traced from the Hazard which means that the Mitigation can be assigned to other Hazards in this or 
other Failure Modes by clicking the <Add> button on the applicable row. 

 
10.  To edit an existing mitigation click <Edit> button for the applicable hazard. Since the mitigation is 

traced to one or more Hazards the changes are propagated to all Hazards tracing to this Mitigation. 
 

11. In the Mitigation form you can set the reduction for either the severity or the probability or the 
visibility. By atomizing the reduction of a Mitigation in this manner, the application of the 
Mitigation on other Hazards is facilitated. 

 
12. When you finish the editing of the Mitigation you will see the impact of the reduction of the risk 

factors through the mitigation. It is calculated as the new RPN (NRPN).  
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Failure mode form containing one effect and two causes which render two Hazards where the first  is mitigated by a 
Mitigation lowering the Probability of the cause with 2. 

 
 
Note!  
To remove a Mitigation from a Hazard, click the < Add > button in the applicable Hazard row and deselect 
the Mitigation in the Select dialog and click < OK >. 
To remove a Hazard from the Risk table, remove either the applicable Cause or Effect by selecting a row in 
the Effect or Cause table (click on left most part of the row to select the entire row) and click Delete on your 
keyboard. 
Entering new lines/row breaks in a text cell in the risk grid can be done with Shift-Enter. 

 

3.9.1 Relative vs. Absolute Mitigations 

Aligned Element is per default configured to calculate the new RPN using so called relative mitigations. This 
implies that each mitigation probability/severity reduction/visibility enhancement is subtracted from the 
original hazard/harm in an accumulative manner. 
 
For example: 
Original Hazard/Harm: Severity=9, Probability=8 => RPN= 9*8=>72 
First Mitigation with probability reduction 2, => new Probability 8-2=6 => NRPN= 9*6=>54 
Second Mitigation with probability reduction 1, => new Probability 8-2-1= 5 => NRPN = 9*5=>45 
 
This means that the NRPN after applying a mitigation is relative to the initial Hazard/Harm RPN. Depending 
on where the RPN start you can get a different NRPN when applying the same Mitigations. 
 
Aligned Elements can also be configured to use so called absolute mitigations. 
This implies that an applied mitigation designates a new probability/severity/visibility to the hazard/harm. 
 
For example: 
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Original Hazard/Harm: Severity=9, Probability=8 => RPN= 9*8=>72 
First applied Mitigation has a new probability 5 => NRPN= 9*5=>45 
Second applied Mitigation has a new probability 6 => NRPN=9*5=>45 
 
Note that the new probability in the first mitigation "overrides" the new probability in the second 
probability (i.e. Min(6,5)=>5) and that the second mitigation therefore has no additional risk reducing 
impact. With this convention the NRPN is absolute to the initial RPN after applying mitigations; where 
relative mitigations are calculated in an accumulative fashion, the absolute mitigations apply a Min/Floor 
function of the applied mitigations. 

3.10 Perform a Risk Analysis 

When performing a Risk Analysis (also known as Preliminary Hazard Analysis), five different document 
object types are involved. The central document object is the Risk Analysis that describes the hazardous 
situation. It links to Harms and optionally Measures in the system and keeps these links as a Probability Of 
Harm object. As input to the Risk Analysis, zero or more Causes may be defined.  
 

 
 
Note!  
Causes, Measures and Harms can only be created directly from the Project Explorer. 
 
Causes, Measures and Harms can be assigned to the Risk Analysis either per Drag’n’Drop from the Project 
Explorer, or via the context menu. To remove an assigned object, please use the context menu. 
 
To create a Risk Analysis as above, please follow these steps: 

1. Create a Harm, Measure and Cause (in any order) 
2. Create a Risk Analysis object 
3. Assign the Cause to the Risk Analysis (top table) 
4. Assign the Harm to the Risk Analysis (bottom table). Here Aligned Elements automatically creates a 

ProbabilityOfHarm object. 
5. Set the probability for the row. 
6. Assign the Measure to the Risk Analysis (bottom table) 
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The example above would look like this in the Trace Explorer: 

 
 
Measures and Causes may be edited directly in the Risk Analysis form whereas Harm can only be edited 
when opened from the Project Explorer. 
 

3.10.1 Potential Hazard 

Sometimes it is useful to keep track of what the Risk Analysis is applied to. For this we recommend having 
a Potential Hazard as a placeholder in the DHF. The Potential Hazard usually depicts a situation required to 
be analyzed from your Quality System or some central Norm (i.e. 60601-1). 

3.10.2 Using the Risk Analysis to check the Software Safety Classification 

You may trace from your Software Items to Causes included in the Risk Analysis. The Validation rule “Has 
Consistent Classification” is then added to your Software Item type and will signal if the Software Item has 
the correct classification according to 62304. Please contact Aligned AG for configuration options. 

3.11 Perform a Review 

Aligned Elements offers a structured approach to conduct reviews of document objects. A Review 
document object works like any other document object in Aligned Elements and operates via a 
combination of attributes and traces. 
 
A document object is considered as reviewed if the revision of the document object is part of an open or a 
close 
 
Three important set of document objects are involved in a Review.  
 

▪ First there is the review itself (which is a document object) acting as main container of the 
review process.  

▪ The second set is the Document Objects Under Review i.e. the document objects that we are 
reviewing which essentially are defined by one or more snapshot. The review uses snapshots in 
order to define the start state of the document objects to be reviewed. 

▪ The third set contains the Issues generated by the review process. These issues are meant to 
sum up the tasks that have been completed before the Review is successfully closed. 

 
How to perform a Review: 

1. Create a new review in the Review View (see 2.8.5).  
 

2. In the Document Object Form, fill in the title, review description (usually stating the reason and 
success criteria for the reviews), set a target finish date, and assign the review participants as well 
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as their roles in the Assigned Users table. Rows can be added or removed by using the context 
menu on the row headers. 
 

 
 

3. Switch to the Target Snapshots and Document Objects tab and select the target snapshot(s) 
containing the Document Objects you intend to review. 
 

4. When the snapshots have been selected, you will see the Document Objects Under Review in the 
Document Object tab listed.  
 
In the classical mode, the Document Objects will be displayed in an Inconsistency list. A Document 
Objects in the list can be opened for editing and inspection by double clicking on the corresponding 
item in the list. Issues can be added to the review by clicking Create Issue in the context menu 
when right clicking on an item in the list. 
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In the modern mode, the Document Objects with their attribute values are displayed directly in the 
Target Snapshot and Document Objects tab. On the right, there is a column for creating and 
associating Issues to the Document Objects. 

 
 

5. If you have any external documents e.g. guidelines for the review, you may attach them as well as 
using the attachment function in the Detail View. 

 
6. Click <OK> in the Review Document Form to save the review. At the first time you save the review 

you will be asked if you want to send up an invitation to the included users. If you click <Yes> and 
the SMTP mail settings have been set up for all involved users including yourself an invitation will 
be sent out. The email contains a link to the Review. Click on the links to open the Review in 
Aligned Elements. 

 
The Review is now prepared. The review participants can access the Review and add any issues that they 
may find and optionally trace them from the applicable source Review Document Objects. 
 
During the Review, you either create new issues or add existing issues to the review. 
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When the review has been performed, close the review by setting the Status to Closed. At this point in 
time, a new snapshot (Snapshot On Close) will automatically be created when you commit the Review. 
 
Hint: To view the changes during a review, compare the Target Snapshot with the Snapshot on Close for 
the particular review.  
 

 
 
When the review has been completed, you can set the Status to Closed. The issues created in the review 
do not yet have to be completed to close the review (some issues might also have a Due time somewhere 
in the future).  
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3.11.1 Add To Review using the Project Explorer  

In the Project Explorer you have the possibility to select a number of Document Objects (similarly to what 
you do when selecting objects for a snapshot) and select Add To Review in the context menu. 
 
As a next step, you are presented with the possibility to select to add the objects to an existing Review or 
to create a new Review for the selected objects. 
 

 
 
After select a Review, you are prompted to add a Snapshot name. When completed, a snapshot has been 
created for your objects and that snapshot has been added to the selected Review.  

3.12 Managing Tests 

 
As of Aligned Elements V2.4, tests can be performed in two ways: 
 

▪ Via Test Runs 

▪ Via Single Test Case execution 

 
These two modes are mutually exclusive and regulated by the template set up. 
To upgrade pre-Aligned Elements 2.4 projects to use Test Runs, contact the support@aligned.ch. 

3.12.1 Test Runs 

A Test Run represents the execution of a number of test cases to be run together in a given context. 
The Test Run is an excellent tool to organize and plan your test activities. 
You can select a set of tests, assign them to your test team members and track progress as the test cases 
are written and executed.  

3.12.1.1 Plan your Test Run 

 
1) Start out by adding a new Test Run in the Test Run 

View. The Test Run View automatically sorts the Test 
Runs according to their Test Run States. 

 
In the Test Run form, you have the possibility to define:  
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▪ Give the Test Run a name 

▪ Enter a description 

▪ Set a planned Start and End date of the Test Run 

▪ Define the Version of the Object Under Test for this Test Run 

▪ Select your Test Team (use the context menu in the Test Team list to select Team Members) 

▪ Select a Configuration set (use the context menu in the Configuration list to select 
Configurations) if Configurations are used  

 
The Test Run contains an overall Test Run Status attribute, designating the states: 

▪ Planning 

▪ Execution 

▪ Completed 

 

 

 
2) Add Test Cases to the Test Run. 

 
Add Test Cases to the Test Run by dropping them into the Test Run or use the context menu in the Test 
Grid to populate the Test Run. The Test Grid is populated with attribute data from your Test Objects. 
 

 
 

3) Assigning Testers to Test Cases 
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Use the context menu in the Test Grid to assign Users to Test Cases. The Test can be configured to 
optionally send an email to the User when a Test has been assigned. 
 
For an overview, use the Grouping function (also in the context menu) to group the Tests according to 
Assigned Users. 
 

4) Assign Test Run specific attributes 
 

Depending on your Test Run template set up, you can also assign Test Run specific values to each Test. The 
available attributes and values to set are accessible from the Context menu. 
 

5) Assign Configurations 
 

The Test Run concept optionally relies on the use of Configurations. 
When executing a Test Case, the Test Case and the related Test Result will appear in the traceability. 
 
If you execute the Test Case again (e.g. for a new version of the Object under Test Case), the previous Test 
Result is now overwritten with a result of the new execution. 
 
However, in some cases, you want to execute a particular Test Case for several variants of your Object 
under Test and keep each variants result available in the traceability. 
 
Preferably, you want to do this without having to copy the Test Case for each of your variants. 
Here is where Configurations come into the picture. 
In Aligned Elements, a Configuration is an aspect (or variant) of your Object under Test (i.e. your device) for 
which you want to keep results “in parallel”. A Configuration is represented by a Document Object type.  
 
Note that it is only possible to have a single Configuration Document Object type in a project. 
 
Good examples of Configurations are e.g.: 

▪ Device Type (Large, Middle, Small) 

▪ Application Platform (iOS, Android) 

▪ Browser type (Safari, Chrome, Firefox) 

 

Essentially, the Configuration contains information that does not change throughout the Product Life 
Cycle. Thus, the Configuration items should not to contain any kind of version information or similar i.e. 
information that changes throughout the product life cycle.  

 
It is crucial that you carefully decide on what a Configuration signifies in your project. Changing the 
definition of Configuration later in the project can have severe consequences. 
It is essentially your traceability plan that dictates which Test Results you want to keep in parallel. 
 
When setting up a Test Run, an important part of the planning is to decide for which Configurations you 
intend to run the Test Cases. 
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You can select a subset of the available Configurations in the Test Run main page and then use the context 
menu in the Test Grid to assign Configurations to the individual tests. 
 
If you want to run a single Test with multiple Configurations in a Test Run, use the Plus-button on the Test 
row to assign additional configurations.   
 
 

3.12.1.2 Testing without Configurations 

 
As the use of Configurations adds flexibility, the also add a degree of complexity. Therefore,  Test Runs can 
optionally be defined to work without Configurations. This option is done on Document Object type level 
and is then valid for all Test Cases of the selected type. 
 
As there is now a one-to-one relationship between Test Case and Executed Test Case, the Executed Test 
Case will then receive the same ID number as the Test Case (similar to Classic Testing). 
 
When Test Runs are configured to work without Configurations, there is no Configuration list on the 
Overview page and no Configuration column in the Test Grid. 
 
Note that a Test Case type defined to run without Configurations can at a later stage be redefined to use 
Configurations. It is however not possible to reverse from a definition with Configurations to a definition 
without Configurations. 
 

3.12.1.3 Executing the Test Cases 

 
Once the Test Run is set up, it is recommended to set the Test Run status to Executing. This indicates to all 
Testers that they can start executing their Tests. The Test Run can be accessed by multiple users in parallel. 
 
To execute a Test, click on the arrow/play button on the Test row and an Execution object will be 
displayed. Data from the Test Case, Configuration and Test Run is automatically copied to the Execution 
copy according to the definition in the templates. 
Fill out the necessary fields in the Test Result object. If applicable, creates and assign Issues/Deviations to 
test steps that are not passed. 
 
Save the Test Result object. The Test Run will now indicate the result of the execution in the Test Grid and 
in the progress bar on the Test Run main page. 
 

 
 
The progress bar in the Test Run main page indicates the Test progress.  
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Use the Context menu on the Test Run progress bar to display the progress aspect that suits your needs. 
 
 

 
 

3.12.1.4 Burn Down Chart 

 
The burn down chart is a depiction of "work left to do" vs. time. On the vertical axis, the outstanding work 
(or backlog) is listed and time is listed along the horizontal. 
The "Ideal Work" trend line represents the predicted rate of work completion calculated from the start 
date, end date and initial work. 
The chart can be used to evaluate the current rate of work completion vs. an ideal one. 
In Aligned Elements, the start and end date of the Test Run is used as the Test Run period for the burn 
down chart. 
The work amount is calculated from the number of Test Cases in the Test Run. All Test Case Types are 
included in the Burn Down Chart. 
 
Note! All Test Cases are assumed to have an equal work load.  
 

 
 
The Burn down chart does not consider available resources. It only calculates the predicted daily work 
completion necessary to finish the Test Run on time given the workload and the stated period. 

▪ Test Cases that are added to the Test Run increase the remaining work. 
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▪ Test Cases that are removed from the Test Run reduce the remaining work. 

▪ Test Cases that are executed reduces the remaining work. 

▪ Executed Test Cases that are invalidated (due to e.g. changes in the Test Case) increase the 
remaining work since the Test Case needs to be performed again. 

 
The starting point of the "Ideal Work" trend line is calculated from the first day containing any work during 
the Test Run period. If more work is added (Test Cases are added) after this day, the "Ideal Work" trend 
line is NOT adapted. 
 
The time granularity used is a full day (24h) i.e. all activities done before 23:59:59 on a given day. 
Only changes that spans from one day to another are visible in the Burn Down Chart. 
A Work item (Test Case) that has been added and completed (Executed) within the same day will not show 
up. 
 
The Burn down chart can be configured to omit Weekends as working days and adapt the chart time line 
and ideal work line accordingly. 
 

3.12.1.5 Editing Test Cases, Configurations and Test Results in a Test Run 

 
As long as a Test Case has not been executed, the user is free to update the Test Case. 
The Test Run will automatically update itself to reflect your changes. 
The same goes for the Configurations. 
 
However, as soon as a Test has been executed, updating the Test might invalidate the result. Therefore, 
when opening a Test that has been executed and is part of a non-completed Test Run, you will be duly 
warned that editing the Test might invalidate the current Test Result. 
 

 
 
If you go on and update the Test, Aligned Elements will: 
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▪ Mark the Test row as invalid in the Test Run, painting the corresponding row gray. 

▪ Prevent you from making any changes to the objects in the Test Row. 

 

 

 
The Test Run is now in an inconsistent state. 
To resolve the situation, you must use the context menu to select Update Test to most current revision. 
This will present you with two choices: 
 

 
 

1) Update the Test to the most current revision and invalidate the Test Result. The Test Result is 
removed from the Test Run. This situation is applicable if the change to the Test was major and 
makes the existing result invalid. 
 

Note! Even though the Test Result is removed from the Test Run, the trace between Test Case and the Test 
Result remains. 
 

2) Update the Test to the most current revision and declare the existing Test Result to be consistent 
with the update of the Test. This implies automatic copying of the attribute values in the Test Case 
to the Executed Test Case where applicable.  
This situation is applicable if the update to the Test was minor and does not affect the result. In this 
case, the data from the Test Case is written into Executed Test Case. 

 
Note! This second option is not applicable if the same Test Case has been executed in a different Test Run 
with the same configuration. 
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Note! The second option cannot be applied if the Test Case has changed the number of rows as part of its 
change. 
 
A similar behavior is triggered if you modify a Configuration that has been used in a Test Result. 
 

3.12.1.6 Complete the Test Run 

 
When the Test Run Status is set to Completed, the Test Run becomes read-only and can no longer be 
updated. Optionally, the user can set a snapshot on all objects being part of the Test Run. 
 

3.12.1.7 Test Run Functions 

 
A number of Test Run functions are available in the Test Run context menu: 
 

▪ Display Columns regulate which columns to display in the Test Run Grid.  

▪ Assign Test Cases provides a dialog to select which Test Cases to add to the Test Run. Note that 
only unselected Test Cases are available. 

▪ Assign Configuration assigns a configuration to the Test Case. Note that only configurations 
from the Configuration list on the Planning stathe are available. 

▪ Assign User assigns a Tester to the Test Case. Note that only testers from the Test Team list on 
the Planning stathe are available. 

▪ Options – It is possible to define further selection options in the Test Case In Run objects in 
order to add additional meta data to the Test Run. In this example the “Method” parameter 
allows the user to set the Test Case to “Functional” or “Regression”. The “Result” option allows 
user to set the test result. 

▪ Inspect Test Case / Configuration displays a gap form for invalid Test Cases and configurations. 

▪ Update Test Case / Configuration to latest revision is described in 3.12.1.5. 

▪ Assign to New Test Run automatically creates a new Test Run and assigns the selected Test 
Cases to the new Test Run 

▪ Assign to Other Test Run assigns the selected Test Cases to another existing Test Run (without 
removing them from the current Test Run). 

▪ Refresh Test Run retrieves the latest state of the Test Run from the database. 

▪ Remove Test Cases is used to remove Test Cases from the Test Run. 

▪ New Query adds the selected object to a Query input set of a new Query. 

▪ Find Objects In… works as in other views. 

▪ Add Tags assigns the selected objects to a Tag. 

▪ Lock Document Objects locks the selected set to prevent them from being updated. 

▪ Group Results displays the Test Grid in a Tree View based on the last sorted column. 

▪ Create File for Objects works as in other views. 
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▪ Export to Excel exports the selected rows to an Excel file. 

 

3.12.1.8 Test Runs and Linked Projects 

It is possible to add Tests from linked project to a Test Run. The corresponding Test Result will be created 
in the linked project. Note that Configurations used in the Test Run can only come from the project in 
which the Test Run resides. 
 

3.12.1.9 Test Runs in Offline-mode 

Test Runs performed or worked on in offline mode can only be taken online if the project has never been 
online before i.e. projects that have been created offline.  
 

3.12.1.10 Test Runs in Branches 

Test Runs are not copied to branches and cannot be merged back from the branch to the source project. 
However, the Test Cases and Executed Test Cases involved (including their traces) are copied to branches 
and can be merged back to the source. 
 

3.12.2 Single Test Case Execution 

To execute a Test Case document object and create an Executed Test Case. Follow these steps: 
 

1. In the project explorer right-click on the Test Case you want to execute. In the Context Menu, select 
the entry Execute -> ExecutedTestCase. 

 
2. This will create a new Executed Test Case where the ID number is identical to the ID number from 

the Test Case. A trace is also created from the Test Case to the Executed Test Case (equivalent to 
Generate Document Object). Also all attributes that are common to the parent Test Case have been 
copied to the Executed Test Case. After having created the Executed Test Case, the Execution 
number will be equal to “1” (first execution of the Test Case). 

 
3. Follow the test case instructions and fill out the additional fields in the Executed Test Case. 

 
4. When you are done with the execution of the Test Case, you can store your new data by clicking 

<OK> in the document object control. 
 

5. You can continue working on an Executed Test Case by opening it again. Any changes will be stored 
as a new revision but the Execution No will remain. 

 
6. If the execution is completed and successful, set the status to “Passed” (or equivalent). If the 

execution was not successful, set the status to “Failed” (or equivalent). 
 
To re-execute a Test case (the Test Case has already been executed at least once): 
 

1. In the project explorer right-click on the Test Case you want to re-execute. In the Context Menu, 
select the entry Execute -> ExecutedTestCase. 
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2. This will create a new revision of the existing Executed Test Case. Also all attributes that are 
common to the parent Test Case have been copied to the Executed Test Case and any specific 
Executed Test Case attributes are left blank. The Execution number will be increased by one. 

 
3. Continue working as when you executed the test case the first time. 

 
When filling out the test case you can take 
advantage of the large number of available 
column types in the Table Attribute.  
 
E.g. use a CheckBox column to set results or a 
trace column to create/refer to issues for found 
product anomalies on the fly. 
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3.14 Work with Tags 

In Aligned Elements, it is possible to group objects by setting a Tag on the objects in a particular set. 

3.14.1 Add Tags 

Assigning an object to a Tag (or “Tagging an object” as some say), the context menu “Add Tags” is available 
in multiple views and explorers. 
 
When applied on one or more objects, the following dialog is displayed: 
 

 
 
The topmost combobox contains all selected objects. 
 
The Tag name field contains the Tag name to be entered. 
 
The Description field is an optional text explaining the purpose of the Tag. 
 
Finally a list of available Tags is displayed. 
 
In this dialog, the user can assign the selected objects to an existing Tag or create a new Tag for the object. 
 
The Tags to which a Document Object belongs is displayed in the Document Object form’s Detail View Tab 
“Tags”. 
 
Tags can contain Document Objects of several type names. 
Tags can also contain Document Objects from linked projects.  
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3.14.2 Filter views on Tags 

To filter the GUI on one or more Tags, select it in the Main Menu -> Tags menu. 
 
The GUI is now filtered on the selected Tags, only displaying objects belonging to 
the Tag. 
The active Tags are displayed in the status bar and can be switched off by clicking 
on them. 
 
If a view is filtered on Tags, this is visually indicated in the 
view. 
 
Note! This rule only applies to types of which at least one 
Document Object of the type belongs to the Tag. For 
example, if a Tag contains five out of all Requirements and 
no Specifications, the filtered views will display only the five 
Requirements but all Specifications.  

3.14.3 Edit Tags 

Select Main Menu -> Tags -> Edit… to activate the Edit Tags dialog. 
 
In this Dialog, you can remove objects from Tags, delete tags and edit the Tag names and descriptions. 
 

 
 
 
When switching between tags, do not forget to click Apply to apply the changes made to the tag before 
moving to the next. 
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If applying the checkbox Add New Objects if active, any added, copied, generated and executed Document 
Objects will automatically be added to the tag. 
 
Note! Document Objects created at Execution will be added. Document Objects that already exist and are 
modified at execution, will not automatically get added. 

3.14.4 Tags and Snapshots 

Tags are Snapshot sensitive, meaning that when switching on Tags for a Snapshot, the filtering will be done 
as the Tags were defined at the time of the snapshot. 
To activate Tags for Snapshots, first activate the Tag and then display the Snapshot. 
 

3.15 Lock Document Objects 

To prevent users for updating a selected Document Object set at a certain stage, Users with Project 
Management rights can Lock them, meaning that they are locked for attribute editing. 
 
The Lock mechanism is available in the context menu of several views and explores. 
 
Then applying a Lock, the system requires a reason to be given. This reason is communicated to user that 
attempts to edit the Locked Document Object, as well as the person conducting the lock and the time of 
the lock. 
 

 
 
The Document Objects can be unlocked via Main Menu -> Project -> Unlock Objects by users with Project 
Management rights. 
 
Note! The Lock mechanism has no effect on trace-settings. 

3.16 Implement Workflows 

Aligned Elements can support workflows by the use of enumeration attributes. E.g. an issue has the Status 
attribute which may contain the values Open, Misunderstood, Duplicate and Closed, can be configured to 
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only allow certain transitions between these values. A workflow could be defined to implement the 
following schema where green is the start state and red the possible end states: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In this example the workflow e.g. prevents changes from Misunderstood to Duplicate, or Close a 
Misunderstood issue would have to be set to Open before it can be set to Duplicate.  
 
Special transitions can be combined with “Actions”.  
Triggered “Actions” include:  
 

▪ Creating an electronic signature for the Document Object.  

▪ Copy a File (or a PDF version of the file) to a location on the network. 

▪ Set an Attribute in the Document object to a predefined value. 

▪ Send an email about the change to a particular User Group.  

▪ Lock the Document Objects to prevent users from updating it. 

▪ Unlock the Document Objects that has been previously automatically locked. 

▪ Start an external process. 

▪ Add a PDF footer to a PDF document (exclusively valid for signature scenarios) 

 
You can also trigger a transition to a new value depending on if other attributes are modified, e.g. to reset 
a file document object status from ‘Released’ to ‘Draft’ if the file itself is modified. 
  
To define a workflow for a document object type, see 6.7. 
 
Workflows can also be setup with transition permission rules, such as:  
 

▪ Preventing members of a particular user group to set a new state. 

Misunderstood 

Open 

Duplicate Closed 
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▪ Preventing a transitions to be made if a particular consistency constraint is not met (i.e. a 
particular attribute is not set, a review of the Document Object has not taken place or that the 
Document Object has not yet been placed in a Word Document).  
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3.17 Work with Digital Signatures 

Note! The digital signature functionality is contained in an add-on package and needs to be separately 
ordered from Aligned AG.  
 
Aligned Elements supports digital signing of individual objects and documents. 
Signatures can be made with or without electronic certificates. 
 
Digital signatures are triggered by a workflow action (see 3.13) and can be applied to any document object 
type. However for a File Document Object they have a specific meaning since they would produce a signed 
PDF/A version of the contained document.  
 

1. In our example, a signature is created when the Validity is changed from Draft to Release for a File 
Document Object (for any other document object type no PDF will generated and no digital 
certificate is needed): 

 
 
 

▪ When a Signature Document Object has been created as the result of a workflow action, the 
Signature can be found in the Signature View (if the view is not visible it can be displayed via the 
Menu Views). 

▪  
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Opening the Signature displays the Signature Document Object. Here you can enter: 

▪ when the signature is due 

▪ the reason for the signature 

▪ the users that need to sign and their role (default users can be set in the parent DHFLineItem 
see 3.24.6). 

 
 

2. To invite the users listed in the “Assigned users” table, press <Invite Users>. An email will be sent 
out to the participants including a hyper link to the signature. 

3. Press <Sign> you are requested to authenticate yourself with your Aligned Element user and 
password. 
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4. The File Document is converted to a PDF/A and is attached to the signature. You are then prompted 

to add your comment and current location 
 

 
 

 
5. The comment is added to the table of assigned users and a signature is stamped on the defined 

page of the PDF which contains the reason, comment, location, local PC time, user name and the 
digital certificate.  
 
 
 
 
  

 
 

6. Perform the actual signing one user at a time. You can have all users signing on the same client 
after each other or close the Signature Document Object with OK in-between to allow users on 
other clients to sign. 

 
7. When all signatures have been collected you can signal this by setting the status of the signature to 

Closed. 
 

Note! Assigned users can also initiate their sign-off directly from the signature view using the <Sign> action 
in the context menu.  
 
Page location and placement of signatures are described in 6.5. 
 
A signature is set on a specific revision of a Document Object. You can navigate from a Signature Document 
Object to the signed Document Object via the Detail View (click <More> to display) of the signature: 
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In the same way you can navigate from signed Document Objects to the current revision of a Signature: 
 

 
 
If the signed object is a File Object, the File Object revision list will indicate which revisions that lead to a 
completed signature, including links to that signature object and the signed document. 

3.17.1 Handling of Digital Certificates 

You need to acquire a digital certificate for each user. These must be of the standard X.509 V3 Class I and 
can be bought from e.g.: 
 

▪ SwissSign (www.swisssign.com) 

▪ Veri Sign (http://www.verisign.com/certified-document-solutions/individual/index.html) 

▪ TC TrustCenter (http://www.trustcenter.de/en/products/my_certificate.htm)  

 
Aligned Elements will safely store these certificates files for each user in the project database. 
 

3.17.2 Signing without digital certificates 

Aligned Elements can be set up to use electronic signatures with using digital certificates. Note that the 
application needs to be validated for this purpose (e.g. according to FDA CFR 21 Part 11). 
 

3.17.3 User Groups as Signees 

It is possible to configure the signature template to not only display Users as signees but also User Groups. 
In this case any person belonging to the User Group can sign on this location in the Assign Users table. 
When signing the name of the user is resolved and inserted instead of the User Group Name. 
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3.17.4 Enforce Signature Order 

There exist several configurable options to enforce the signatures to be conducted in a particular order.  
These include: 

- A person cannot sign if any person before him in the Assigned User list has not signed. 
- A person cannot sign if any person with a particular trait (governed by the order of values in an 

enum column) has not signed. 
 

Contact the Aligned Elements Support team for more information on these options.   

3.18 Enable/Disable a Document Object 

To disable an object just check the Disabled check box in the Document Object Form and press <OK> to 
save this change. The disabled document object will then disappear from all Explorers. 
 
Note! Traces to disabled objects are not automatically updated to always trace to the most current revision 
i.e. after enabling an object again, please revise all traces from the document object and if needed add 
traces to most current revisions. 
 
To enable the document objects again, select the filter Display Currently Disabled Objects from the 
context menu (right-click) in the Project History View.  
All currently disabled document objects are now displayed in the view. 
 
Double-click on the row header for the document object in the Project History View. In the Document 
Object Form you may now enable the object again by un-checking the Disabled check box. 
 
The enabled document objects will now appear in the Explorers again. 
 

3.19 Create a Snapshot 

A snapshot is a selected set of document objects in their current revision.  
A snapshot is used to unambiguously identify the state of the project e.g. at a project milestone or at a 
product release or as input for a review. 
 
You can create a snapshot of the project or parts of the project at any time. 
 
To create a snapshot, use the context menu (right-click with the mouse) in an applicable view. When you 
select Snapshot  -> On Selected (e.g. on a set of chapters and pages), the content of the selected objects 
(including all sub chapters of selected chapters) and document objects are included in the snapshot.  
 
To create a snapshot of the complete project (including issues and reviews), select Snapshot -> On Project 
anywhere in the Project Explorer.  
 
To create a snapshot of an arbitrary set of document objects you can keep the <CTRL> key pressed to 
select multiple document objects in the Project Explorer or Trace Explorer and create a snapshot of them 
by selecting Snapshot -> On Selected in the context menu. 
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Note! For failure mode like objects, the user is inquired if the corresponding hazards shall be included in the 
snapshot. Since failure modes and hazards are conceptually closely linked, we recommend this option. 
 
The File Explorer offers a special Snapshot action called On Content for MS Word Files, which includes all 
objects inserted (in their current version) in the Word File provided that the objects are not frozen or 
belong to linked projects. 
 
Display a snapshot by selecting Project -> Display Snapshot in the file menu. Additional explorers are 
displayed for the content of the displayed snapshot. When you double click on a document object from a 
snapshot, you will notice that it is always displayed in read-only mode in the Document Object Form. 
 
Note!  
The traces displayed for a snapshot only include traces to objects that are part of the snapshot. 
Snapshots cannot be set on linked Document Objects or objects from external systems such as Jira Issues or 
Trac tickets. 
 

3.20 Compare Snapshots with the Project State 

Sometimes it is interesting to find out what the difference between two project states i.e. between two 
snapshots or between a snapshot and the current project state.  
This comparison can be displayed from the Project -> Compare Snapshots/Project.  
 
Select either: 

▪ Two snapshots or  

▪ A snapshot and the current project state 

in the selection dialog and press <OK>. 
 
Thereafter a message box is displayed: 
 

 
 

▪ If you select to compare chapters and document objects results in displaying the document 
objects within their chapter structure. Document object that have been moved are only 
displayed in the most recent chapter. 
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▪ If you select to display document objects only, you may compare revisions of the document 
objects regardless of their location in the chapter structure. 

 

 
Changes between two project states are highlighted in the Comparison Form 

 
In the Comparison Form you see a comparison between the Project Explorer structure of the two project 
states and at the bottom of the page, a list of all project history entries recorded between the two events. 
 

▪ Grey lines indicate missing, non-existing or removed document objects. 

▪ Pink lines indicate document objects that have been changed between the two occasions. 
Double-clicking on the red lines will display a gap dialog indicating the differences between the 
two object revisions in detail. 

▪ Green lines indicate added document objects. 

▪ Yellow lines indicate changed traces. 
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3.21 Displaying Inconsistencies 

3.21.1 Inconsistencies are in Aligned Element gaps, incompatibilities or contradictions in your project 
according to a set of defined but customizable rules called Validation rules (for help on configuring 
see Configuring Chapter Descriptions 

Note! This feature is only available in the Aligned Elements Web Client. 
To activate the chapter description feature, set the web.config parameter: 
    <add key="useChapterDescription" value="true" /> 
 

The font definition used in the Chapter Description is similar to RichText and Table attributes, i.e. a rtf file 
is referenced. Therefore, in each .rvt template, define the font of the chapter description in the Type Info 
tag such as: 
  <TypeInfo TypeName="User Need" Prefix="UN" IsVisibleBook="true" DisplayOrder="5"> 
    <Category Name="Design Input" Order="0" Color="#1bade8"/> 
    <ChapterTemplate>Calibri11.rtf</ChapterTemplate> 
  </TypeInfo> 
 
Furthermore, update all Chapter docx templates to include a tag for the chapter name as well as for the 
description such as: 

 
 
Configuring Validation Rules).  
 
The following validation rules are applicable to the different document object types: 

▪ Trace missing (e.g. a requirement should at least have a trace to one Specification) 

▪ Incoming Trace missing (e.g. a Specification should at least have a trace from a Req) 

▪ Risk is not mitigated (i.e. too high NRPN (risk) after mitigation (or mitigation missing)) 

▪ Severity is not mitigated (i.e. too high severity after mitigations) 

▪ A document object has not been reviewed (or only in a previous revision) 

▪ A document object has an open issue. 
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▪ A document object contains an attribute whose value is not as predefined, e.g. an executed test 
case has the Result = Failed. 

▪ A Test case has not been executed in its current revision. 

▪ A trace is set suspect if the parent document object tracing to another object is changed after 
the trace to the child object is created. 

▪ Document Object is not included in any file document object 

▪ A file document object contains document objects that are not up-to-date 

▪ The document object has a date attribute whose value is overdue 

▪ A document object has a signature that is not closed 

▪ A DHF Line Item defines a deliverable that is not fulfilled. 

▪ A DHF Line Item has a current status that does not match the “Status per Phase” definition setup 
for the document. 

▪ Illegal traces or incoming illegal traces i.e. an object has a trace to an objects of a type that is 
formally not making sense. 

▪ Obsolete linked traces i.e. an object has a trace to a linked object of a non-most-current revision. 
Note that this only applies if the linked project is loaded. 

▪ Has Consistent Classification, can be applied to Software Items with a classification attribute (i.e. 
A ,B ,C) and checks if the severity on a Harm traced via Risk Analysis and Cause match the 
current classification. Tracing to a No Cause is a way to justify Safety Classification ‘A’. 

▪ A Document Object is missing a Signature. 

 
If a validation rule criteria is not met this is listed under the objects inconsistencies. 
 
The inconsistencies are always updated when a project is loaded at start. Most of the inconsistencies are 
also updated directly after each commit of an object or trace change. You can also refresh the 
inconsistency states by clicking Project -> Refresh Project to force an update. 
 
You can also request a complete list of all current inconsistencies from the menu Inspect -> Display All 
Inconsistencies. Here you have a possibility to select either a snapshot or the current project. Select one 
entry in the Selection Dialog and click <OK>. 
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All inconsistencies for the current project state displayed 

 
You are able to sort the content of this view by clicking on the column headers. 
 
To view a document object in a Document Object Form, simply double click on an inconsistency. 
 

3.21.1.1 Resolve Inconsistencies 

Aligned Elements does not only display currently outstanding inconsistencies. It also provides the user with 
direct actions to solve them. Click on the Fix button next to an inconsistency to get informed about 
available resolutions. 
The resolution mechanism provides available options based on the current user's permissions, the item's 
state and the project context. Select the option that is the most appropriate to resolve the inconsistency. 
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 Use the context menu for the following functions:  
 

▪ Refresh the currently displayed view. 

▪ Filter out the validation rules that interest you. 

▪ Take a Snapshot of the selected Objects. 

▪ Clear Suspect traces on selected Objects. 

▪ Create an Issue for the selected Objects.  

▪ Find Object in the Project, Trace, File Explorer or Project History. 

▪ The Create Report menu allow access to 

o Excel Report generates an Excel file containing the selected 
Document Objects. 

o Word Report generates a report in word format containing selected Document Objects. 

o Word Report (from Template) generates a report in word format containing selected 
Document Objects. The format will be based on the currently defined word templates. 

▪ Create File for Objects creates a new File Object which also creates a Word file from a select 
Word Template and inserts Document Objects into the Word document in one single action. 

▪ Resolve Inconsistencies Some inconsistencies, such as Not Reviewed, Suspect Trace and Not In 
File, can be resolved in batch mode. Use the Resolve Inconsistencies menu item to select and 
resolve inconsistencies in batch mode. 

 

Note! If the Display Inconsistencies form is empty, then either: 
▪ The selected object have currently no inconsistencies or 
▪ The Filters for the inconsistencies are not switched on 

 
 
The Inconsistency View also has drag support for trace setting in other Explorers. 
 
In a review, the inconsistencies that apply to the identified review input (the snapshots that are added to 
the review) are listed in the Document form to help the review participants. 
 

 
Inconsistencies in a Review Document Form 
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3.22 Displaying Consistency Coverage 

In conjunction with the inconsistency concept, Aligned Elements also support the option of displaying the 
Consistency Coverage of a selected Document Object set. The Consistency Coverage indicates to which 
degree a Document Object is consistent in terms of percent. If a Document Object does not have any 
inconsistencies, then its Consistency Coverage is 100%. 
 

 
 
 
Note! Hover with the mouse over a line item to access the tool tip containing all open inconsistencies for 
the selected Document Object. 
 
The Consistency Coverage Estimation View can be displayed on a selected Document Object subset from: 

▪ The Project Explorer 

▪ The Query Output List 

▪ The Inspect Main Menu Item 

 
The context menu functions available in the Consistency Coverage list are described in 3.7.19. 
 
The view also has drag-support for setting traces in other Explorers. 
 
The Coverage idea is based on a granting “points” for not having inconsistencies. Depending on the current 
state of the Document Object, it is awarded “potential” inconsistency points and “actual” consistency 
points. Subtracting the “actual” coverage points from the “potential” inconsistency points, causes a 
“deficit”. 
 
The coverage is then calculated as actual points divided by potential points. 
 
The potential inconsistency points are calculated by inspecting the Validation Rules for the type and 
comparing it with its current state. Some of the Validation rules are concerned with the Document Objects 
internal state, other are concerned with the state of the Document Objects traces. 
 

Validation Rule Deficit 

Missing Trace  + 1 if there is no trace of the specified type. 

Missing Incoming Trace + 1 if there is no incoming trace of the specified type. 

Illegal Trace  + 1 if at least one trace is of illegal Document Object Type  

Obsolete Linked Trace 
+ 1 for each obsolete linked trace to a Document Object in a loaded 
linked project 
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Not Reviewed 
+ 1 if the most current revision of the Document Object has not been 
reviewed. 

Attribute State + 1 if the current attribute state is not expected. 

Suspect Trace + 1 per suspect trace. 

Open Issue + 1 per open issue  

Risk/Harm Not Mitigated + 1 per traced and insufficiently mitigated hazards / harms. 

Object Not In File + 1 if most current revision of object is not in a Word document. 

Date Overdue  + 1 is the date is overdue. 

Objects in File Up to date 
+ 1 if any of the Document Objects in the document is of most current 
revision. 

Open Signature + 1 per associated open signatures. 

Not Executed From Latest 
Rev 

+ 1 if test case has not been executed from its current revision 

Missing Signature + 1 if no signature exists for the Document Object 

Invalid Table Trace + 1 per invalid trace in a table cell 

Advanced Attribute State + 1 if the current attribute state is not expected. 

 
Note: The Consistency Coverage view only evaluates and displays the inconsistencies activated in the 
Inconsistency View filter. 
 
Validation rules can be explicitly exempted from the coverage calculation in the Document Object 
templates. The consistency coverage can also be subjected to a weight factor in the Document Object 
Template, making some inconsistencies having a greater or smaller effect on the total coverage 
calculation. For exact notation, see 6.7.5.   
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3.23 Defining Charts 

 
Aligned Elements can display breakdown charts on a selected set of Document Objects. 
 
In Aligned Element you can add Charts, modify, copy, rename and delete them.  
A chart essentially consists of:  

▪ an input set of document objects  

▪ a number of chart properties 

 
These two in combination yield a Chart to be displayed. Chart can be performed on current Document 
Objects in the master project and the linked projects. Objects from snapshots or of older revisions cannot 
be included in a Chart. 
 
To create a Chart, click Chart -> New… in the main menu. As a second step you define the target Document 
Object type for your chart. A Chart can only be performed on a Document Objects of the same type e.g. 
Requirements or Specifications.  
 
The third step is to define if you want to use a Static or Dynamic Input Set. The difference can be explained 
as follows: 
 

▪ A Static Input Set consists of a defined number of document objects. If a Document Object 
becomes disabled, it is automatically removed from the input set. If a Document Object in the 
input set is modified, the input set is updated to include the new revision of the object. 
However, if a Document Object created/added, it is NOT automatically added to the input set. 
The user has to explicitly add it to the input set using drag-and-drop. 

▪ A Dynamic Input Set consists of a defined number of chapters (and optionally their sub 
chapters) and implicitly of all Document Objects in those chapters. The set is updated for 
disabled and modified Document Objects just as for Static Input Sets. The big difference is that a 
Dynamic Input Set automatically includes Document Objects that have been created/added or 
moved to its chapter set.  

 
 
When the input set type has been defined, the user is prompted to select along which dimension the 
breakdown shall be perform. You can select an attribute (if it is of Enum, UserEnum, Boolean, Multiselect 
or IntegerRange) or an inconsistency type as breakdown parameter. 
 

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  100 / 269 

 
 
After selecting the breakdown parameter, the Chart Design View is displayed: 
 
 

  
 
Drag and drop Document Objects or Chapters from the Views and Explorers into the Input List on the left 
side. You can click on the headers to sort the Input set or double click on an item to display it. 
 
Note! When dragging and dropping a File Object containing a word document that holds Document objects 
into the Input List, the ObjectsInFile of the File Object corresponding to the target Document Object type of 
the query are listed in the Input List. This is only available when using a Static Input Set. 
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Click Refresh to update the Chart.  
 

 
 
The default name (also displayed as caption) indicates the Document Object type and breakdown 
parameter. The legend on the right hand side indicates details on the distribution of the selected 
parameter. 
You are free to set the: 

▪ The chart name 

▪ Chart type – Display the chart as pie chart, bar chart or column chart 

▪ Number Format – Display the values as absolute or percentage values 
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▪ Color Scheme – Set the chart colors to predefined themes 

▪ The breakdown parameter – click on the browse button to change break down parameter. 

 

Click Refresh to run the Chart according to the defined parameters. 

 
Click Save to commit the Chart. You can also use the Save Drop Down button to Save A Copy of an existing 
Chart. 
 
Use the Delete button to delete the Chart. 
 
Note! Charts are really deleted, not disabled. You cannot re-access a deleted Chart. 
 
Use on the Refresh drop-down button to access the following functions: 

▪ Print – Use Print Preview, Page Setup and Print to print the chart 

▪ Save as Image – Save the chart as image file to disk. 

▪ Save as Image to Clipboard – Copy the chart as image to the clipboard 

When selecting a chart component (a bar or a pie slice), a different context menu appears with the 
following functions operating on the selected Document Object set: 

▪ Drill down – Display a subsequent breakdown chart with the chart component as input set.  

▪ Update Multiple Items – Set a new attribute value for a selected attribute on the Document 
Object set. 

▪ New Query – Create a new query with the chart component as input set. 

▪ Add Tags - Select a number of objects and select this option to assign a Tag to the object set.  

▪ Lock Document Objects - Select Document Objects and lock them to prevent them from being 
updated, in order to control the change workflow if these items. 

▪ Inspect - Click this item to access the following three display 
options: 

• Display Inconsistencies - Display all inconsistencies for a 
chapter or for individual document objects. See 3.21 for 
details. 

• Display Consistency Coverage - Display a consistency 
coverage report for the selected objects. See more 
about Consistency Coverage in 3.22.  

▪ The Create Report menu allow access to 

o Excel Report generates an Excel file containing the 
selected Document Objects. 

o Word Report generates a report in word format 
containing selected Document Objects. 
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o Word Report (from Template) generates a report in word format containing selected 
Document Objects. The format will be based on the currently defined word templates 

▪ Create File for Objects creates a new File Object which also creates a Word file from a select 
Word Template and inserts Document Objects into the Word document in one single action. 

▪ Copy to Clipboard  - Copy the selected Document Object set to the clipboard as semicolon 
separated strings 

▪ Export – Export the selected Document Object set  
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3.24 Work with the DHF Index 

A Design History File Index is a summary of the deliverables (most often documents)  that makes up the 
Design History File. It includes information such as the title, version and location of each deliverable.  
 
Furthermore, it is common that the company Quality Management System (QMS) defines required 
deliverable state at specific project phases. For example, the QMS might require that the DHF contains a 
"Product Requirements Document" and that this deliverable must be available as draft at Milestone 2 but 
released at Milestone 3. 
 
Normally, the QMS provides a DHF Index Document Template, that specifies: 

▪ The deliverables of the DHF (e.g. Product Requirement Document, Master Test Plan, Risk 
Management Plan). 

▪ At which Project Phase each deliverable must be available in which state. (e.g. PRD must exist as 
(at least) draft at M2 but must be released at M3) 

 
The Project then fills out this template with the concrete deliverables. 
 
The Aligned Elements DHF Index has been built to reflect this behavior.  
Note: This feature requires that a DHF Line Item template exists for your project. 
 
From Aligned Elements V1.6 the following four new features make up the DHF Index: 
 

1. The Project Phase declaration in the Project Settings (see Project Settings). 
 

2. The new Document Object type "DHF Line Item". 
 

3. Two new Inconsistency rules for the type "DHF Line Item" which checks: 
 

a. That a DHF Line Item is "fulfilled" by a concrete deliverable. 
 

b. That the deliverable state is valid for the given project phase. 
 

4. A DHF Index Table which summarizes the DHF Line Items. 
 
Your different project deliveries are displayed as DHF Line Items in the Project Explorer. These can be used 
to create your required project documentation and check the consistency and state of your project at the 
current time.  
 

3.24.1 Setting up DHF Line Items according to your Quality Management System 

1. In the Project Explorer, use the context menu to create a DHF Line Item. In the title of the DHF Line 
Item, write the name of the deliverable (e.g. Product Requirement Document or Risk Management 
Plan). 
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A DHF Line Item is a Document Object and therefore can be used as all other Document Object 
Types i.e. traced, updated, checked for inconsistencies etc. Just like for any other Document Object 
you can use Chapters to group your objects.  
 
We recommend that you use the top level Chapters to group which DHF Line Items that belong to 
which Project Phase. This grouping will later be displayed in the DHF Index. 
 

2. Define the required status of the document object according to the QMS. In the “Status Per Phase” 
data grid, specify the required status of the document in each phase according to your QMS. Use 
the Context menu it add rows. 
 

 
 

Note!  
It is not unlikely that your QMS have additional/other attributes or attribute values than the ones specified 
in the default DHF Line Item template e.g. the name of the statuses available in the Status to Phase data 
grid. Please contact us if you want help to modify your DHF Line Item template to fit your QMS. 
The control assumes that the entered status is applicable for all phases up to entered phase.  
 

For example, if you enter only one row with the Phase “M3” and the Status “Draft” it is implied 
that “Draft” is the only valid state for all the phases “M1”, “M2” and “M3” but not for “M4”. 

 
Consequently, if you enter only one row with the Phase “M3” and the Status “Release” it is implied 
that “Release” is the only valid state for all the phases “M1”, “M2” and “M3”. 

 
This can be somewhat confusing. Therefore, you should always enter at least two rows in this table 
with adjacent phases. In the case above, the correct way is to enter one row with Phase “M2” 
Status “Draft” and a second row with Phase “M3” Status “Release”.  

 
3.  If you have a Document (Word) Template for the deliverable (e.g. a Product Requirement 
 Document template) you can add it using the Template File Attribute. 
 

3.24.2 Connect DHF Line Items to your Project Deliveries 

Up until now we have defined what the Design History File should contain, i.e. which deliveries that must 
be included and the "status to phase" rules according to the QMS. 
 
The next step is to define what the Design History File actually contains at this given point in time. 
 
A DHF Line Item may point to documentation within Aligned Elements (Internal mode) or to documents 
stored outside Aligned Elements (External mode). The applicability is defined in the attribute Mode. 
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3.24.3 External Mode 

If the mode is set to External, you shall specify the name of the concrete deliverable that fulfills this 
required deliverable. This is done in the attribute "Fulfilled by External References".  
If this attribute is empty, the DHF Line Item is considered inconsistent. 
 
The “Document Version” and the “Current Status” of the document must be set manually using the 
available Status and Version attributes. 
 

3.24.4 Internal Mode 

For the Internal mode, normal traces define which document objects that fulfill the deliverable. You may 
use one DHF line Item and trace to any number of document objects. 
 
If no trace is set, the DHF Line Item is considered inconsistent. 
 
If the File Object has a status attribute, then this status overrides the “Current Status” attribute in the DHF 
Line Item. The mapping of statuses can be done in the DHFStateToPhase validation rule. 
 
If the File Object has a version, then this version overrides the “Document Version” attribute in the DHF 
Line Item. 
 

3.24.5 N/A mode 

Your project might not apply all documents defines by the QMS. For example, the QMS might require a 
document called "Electrical Wiring Plan". If you are working on a software project it does not make sense 
to include this document. In such a case you can set the mode to N/A ("Not Applicable") to explicitly 
declare that you intend to skip this document in your DHF. You are required to write a qualified reason in 
the attribute "Qualification for N/A" for a N/A item to be consistent. 
 
 
The following convention should be used: 
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▪ For DHF Line Items in internal mode, you may use one DHF line Item and trace to any number of 
document objects. 

▪ For DHF Line Items in external mode, you should create one DHF Line Item for each external 
document to be able to track the individual version and status of the document. 

3.24.6 Assigned Users For Signature (optional) 

If you are using Signatures in your project, you may extend the DHFLineItem template with a table where 
the default users that should sign this type of document including their role can be listed. Please contact 
support@aligned.ch for configuration assistance.    
 

 
 
To create a new file based on a DHF Line item: 
 

1. Select the applicable DHF Line Item and Generate a File Object for the item: 
 

 
 

2. A file document object is created based on the template as defined in the DHF line item. 
 

3. Open the file and add the applicable content (in our case product Requirements) 
 
To track external documentation in Aligned Elements: 

▪ Open the applicable DHF Line Item (or create a copy of an existing DHF Line Item) and set the 
mode to External. Type the name of the document in the attribute Fulfilled by external 
References and the file path in Hardcopy Location.  

3.24.7 Display DHF Index 

To view the complete Design History File Index for a project, select the menu item Inspect -> Display DHF 
Index.  
 
A selection dialog is displayed where you can choose the DHF input set, either the DHF of the current 
project or as the DHF was in any snapshots in your project. Make a selection and press <OK >. 
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In the next dialog you can select the DHF Index view mode: 

 
 
The first option shows you the current state of your DHF Index (as defined by input set).  
 
The second option displays the most recent release version of Documents which primarily makes sense 
when using e-signed documents in the DHF Index. 
 
The third options is similar to the second but also shows all revisions of the Document that have been 
released as opposed to the most recently released revision. 
 
A fully released document means that the document has a completed signature object with the sign status 
set to “closed”. 
 
If such documents exist in your project history, that revision of the document will be displayed. 
 
 

 
DHF Index for a project 

 
Each column represents an attribute in the DHF Line Item. The columns can be rearranged and their 
visibility can be switched on and off using the context menu. 
 
It is also possible to use the context menu to set snapshots, display inconsistencies and print a report. 
 
Note! The DHF Index can be inserted in a word document using the “Insert DHF Index” button in the Word 
Project Explorer. It will then be displayed with the columns and column order defined in the Display DHF 
Index grid. 
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Just like for any other Document Object type, the DHFLineItem template can be modified to accommodate 
for additional attributes. However, uniquely for the DHFLineItem type there exist a number of additional 
hardcoded attribute names that evaluates the corresponding of the traced items (used for internal mode). 
These attribute names are: 
 
Creator 
In external mode, full name (if available, otherwise username) of user that created first revision of the 
DHFLineItem 
In internal mode, full name (if available, otherwise username) of user that created first revision of the 
traced object(s). 
 
Created 
In external mode, date of creation (of first revision) of the DHFLineItem 
In internal mode, date of creation (of first revision) of the traced object(s). 
 
LastModifier 
In external mode, full name (if available, otherwise username) of user that created last revision of the 
DHFLineItem 
In internal mode, full name (if available, otherwise username) of user that created last revision of the 
traced object(s). 
 
LastModified 
In external mode, date of last modification (creation of last revision) of the DHFLineItem. 
In internal mode, date of last modification (creation of last revision) of the traced object(s). 
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3.25 Display or Insert the Risk Summary 

The Risk Summary Excel Report provides an overview of all hazards /probability of harms before and after 
mitigations in the project.  
 
Optionally, the Risk Summary may be based on a query. The query Document Object type must be the 
applicable risk document object type, e.g. a Failure-mode or Risk Analysis.  
 
The Risk Summary Excel report may be generated from the Inspect Menu and is defined like this: 
 

 
 
The Report displays the number of hazards / probability of harms in the 3 regions Acceptable (Green), 
ALARP (As Low As Reasonably Possible, Orange)/ALAP(As Low As Possible) and In Acceptable (Red). In the 
example above the region ALARP/ALAP is not used. 
 
If the configuration for the RPN Table has not yet been made in the project templates, the report cannot 
be displayed. To configure e.g. a Failure-mode to display a Risk Summary see 6.7.7. 
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The Risk Summary can also be inserted into a Word document from the Toolbar in Word.  
The result can look like this, depending on the used template: 
 

 
Risk Summary in Word 

 
Note!  
In the case when 3 parameters for risk calculation are used (e.g. severity, probability and visibility), an 
approximation is done to allow the display in a table. Two factors (typically probability and visibility) are 
combined on one axis. The display of the severity and risk region (i.e. color) will always be correct but the 
absolute value of the probability and visibility may not match the description on the axis and is 
approximated to the nearest possible cell in the table. 
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3.26 Clearing Suspect Traces 

It is fairly obvious that modifying an existing Document Objects might have an impact on objects traced to 
it. E.g. if I make a change in a specification, it is likely that I have to update the Test Cases that test the 
specification accordingly. 
 
Aligned Elements therefore implements an inconsistency rule called “SuspectTrace”. This implies that 
when a Document Object that has outgoing traces is modified, the traces are marked as “Suspect”.  
 
In Elements this manifests in different ways: 

▪ The object that was modified gets an suspect inconsistency  

▪ In the Trace Explorer the objects traced from the modified object are marked with a special icon 

 

 
The Suspect state can be relieved/removed in two ways: 

▪ Update all objects traced from the modified object. 

▪ Remove all the traces from the modified object. 

▪ The user manually removes the Suspect state using one of the following alternatives: 

▪ Clicking “Clear Suspect” in the Trace Explorer on the modified Document Object. 

▪ Clicking “Clear Suspect” in the Display Inconsistency View on the modified Document Object. 

 
Note!  
Both the parent and child Document Object Type must have the suspect trace rule implemented for the 
suspect trace inconsistency to show up. 
It is possible to disable the behavior of automatic clearance of the suspect state by updating the traced 
objects in the Project Settings. 
 
It is a fact that the vast majority of changes made to Design History File Items do not have an impact on 
traced objects since most changes are trivial e.g. correcting spelling or format. It is possible to override the 
setting of the suspect state by ticking the “Suppress Suspect” check box in the Gap Form. Read more about 
this at 3.41. 
 

3.27 Project Information 

 
The Project Information is a place to document project specific information. 
Examples of such information are: 
 

▪ A description of the product being documented 

▪ Intended Use for the product 

▪ Project Leader / Coordinator / Responsible 

▪ Conventions used for documenting the product in Aligned Elements 
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▪ Important decisions taken having an impact on the project documentation conventions 

 
This information is displayed on the application background when no tab pages are displayed. 
Project Information changes are tracked in the audit trail. 
The project information can be inserted in Word files and is also part of snapshots when using the 
Snapshot on All function. 
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3.28 Export Document Objects 

It is possible to export document object to external files. This functionality is available in the Project 
Explorer, the Trace Explorer and the Issue View. 
 
The exported data includes: 

▪ General Document Object data such as type, ID, revision, chapter and title 

▪ Attribute data 

▪ IDs of incoming and outgoing traces 

▪ Revision information 

▪ Tag names 

 
To export Document Objects: 

1. Select the document objects in the applicable View 
2. Click <Export Objects> in the context menu.  
3. In the Export dialog you have the following options: 

 
 

 
 
 
Select Export Transformation  
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The exported document objects are treated by a (selected) xsl transformation file which converts the 
object to the applicable format. The following xsl transformation files are delivered with the default 
templates: 

▪ Default Xml Transformation 

▪ A CSV Transformation 

▪ An Excel Transformation 

▪ A HTML Transformation 

▪ An MS Outlook Transformation 

Export Directory  
The directory where the export file is stored. 
 
Export File Name 
The name of the file (not including the file extension which is defined in the transformation file.) 
 
Include underlying traces to 
When exporting Failuremode-like objects, the user is inquired if the traced Hazard and Mitigation objects 
should automatically be included in the exported set. Since Failuremode-like objects are closely tied to the 
traced Hazard objects, it is recommended to include these during export. 
 
Convert Rich Text content to Plain Text  
Converts the content of all Rich Text attributes to plain text. 
 
Open File after export  
Opens the exported file when the export is completed using the default application for the file extension of 
the exported file. 
 
For document object types that contain FileAttributes (such as Attachments), a copy of the file associated 
with the file attribute is placed in a new folder (placed in the target export directory) with the same name 
as the ID of the document object. 
 
Note! It is possible to define a document object to not be importable. An example of such an object is the 
File Object. Since a File Object can contain a Word Document that might contain document objects from a 
different project, synchronization of a Word Document from such an imported File Object might cause 
damage through ID confusion. Therefore, File Objects are defined as non importable in the rvt template file 
by setting the “TypeInfo” attribute ImportableDocObjType="false". 
 
Note! The Default XML Export contains the Aligned Elements version number to indicate which version was 
used for the export. 
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3.29 Import Document Objects 

It is possible to import Document Object from files exported using the default xml Transformation as 
described in 3.28 or manually/externally created. Importing Document Objects is only possible from the 
Project Explorer. 
 
To import Document Objects: 
 

1. Select the target chapter or book in the Project Explorer. 
 

2. Click Import Objects in the context menu.  
 

3. You will now be prompted to select the files to import. The Directory Browser 
is set to  display xml files. Note that you can import several files at a 
time.  

 
4. The Import Dialog will now be displayed. The top drop down box contains the 

objects that  have been selected for Document Objects to copy. The 
following options are available: 
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▪ Change Comment  

You can hear customize the initial change comment (set for revision 1) used when the objects 
are created e.g. “Imported from internal system so-and-so”. 

 

▪ Recreate chapters  
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By default, exported Document Objects also contain their original chapter path. With this option 
selected, the chapter path is recreated (if it does not already exists) and the imported object is 
automatically placed in that chapter. 

 

▪ Keeping / Recreating Incoming, Internal and Outgoing Traces 

Trace information are also, by default, included in the export object description and traces can be 
recreated if the options are selected.  
 
Keep Internal Traces signifies traces that exist between the imported objects. When this option is selected 
the traces between the imported objects are recreated. 
 
Keep Outgoing Traces signifies traces from the imported objects to other objects in the source project. 
When this option is selected traces from the imported objects are created to these other objects in the 
source project. Therefore this feature only applies when working with Linked Projects. 
 
Keep Incoming Traces signifies  traces from other objects in the source project to the imported objects. 
When this option is selected traces from the other objects in the source project are recreated to the 
imported objects in the target project. Therefore this feature only applies when working with Linked 
Projects. 
 
Note!  
For correct processing of traces, the ID:s of the imported objects MUST be unique within the trace set. If 
two imported items have the same ID in the imported set, traces cannot be set correctly. 
 
Note!  
For outgoing and incoming traces to be set, these objects must be loaded and available at the time of 
import. 
 
Note! On exporting and importing Failure modes, it is recommended that the corresponding Hazards are 
exported and imported in the same operation, since the cause, effect, probability, severity and visibility 
information is stored in the Hazard. Use “Keep Internal Traces” at import. 
 

▪ Import Tags 

If the Document Objects in the import file have been associated with Tag names (in the import 
file), the Import Tags option will, if enabled at import, automatically add the imported 
Document Objects to the specified tags in the target project, provided that these tags already 
exist in the target project at the time of import. 

▪ Create Tags if not existing 

As an additional option, to the Import Tags feature described above, the Create Tags if not 
Existing, will, if enabled at import, automatically create the tags found in the import file in the 
target project (provided that they do not exist) and subsequently add the imported Document 
Objects to these newly created tags. 

▪ Synchronized Import 
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See below. 

 

3.29.1 Overwriting Existing Data with Synchronized Import 

 
Synchronized import implies that the data of an existing object is overwritten with the data of an imported 
object.  
Note! Only Document Object attribute data are synchronized, not traces. A new revision is created for the 
target Document Object when it is synchronized. 
Aligned Elements offer three modes of synchronized import: 

3.29.1.1 Synchronization Without Map File 

For each imported object the user manually selects which existing objects that shall be overwritten. 
 
For this option there is the additional option of Auto-proposition of the synch object. If the imported 
object has an equivalent ID in the book of import, that object is automatically suggested as the object to 
synchronize with. 
 
Synchronization without map file has the additional options when the user select not to map the imported 
object to an existing object.: 
 

▪ Skip import of object – The object is NOT imported. 

▪ Import as normal – The object is simply imported as a new object. 

▪ Abort the entire import process (no objects are imported or synchronized). 

 

3.29.1.2 Synchronization with Map File 

A Synchronization Map is an xml file that contains ID-mapping information from previous import sessions. 
It is a key-value collection where: 

▪ The key is the ID of the object in the import file (i.e. from the exported object)  

▪ The value is the ID created for the object when imported. 

 
It is assumed that these object IDs are contained in the imported files and the target project respectively. If 
the Synchronization is done regularly for the same objects set, this mode is clearly preferable. 
Consequentially, there also exists an option to “Create Synchronization Map File” at import. 
 
Synchronization with a Map file has the additional options for objects that are found in the import file but 
not found in Map file: 
 

▪ Import as normal – The object is simply imported as a new object. 

▪ Skip import of object – The object is NOT imported. 

▪ Manually select the map target – Prompts the user with the option to manually  designate an 
object to overwrite with the imported data. 
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3.29.1.2.1 Merge Synchronization Map Files after Import 

In the case where synchronized imports are done regularly and where new Document Objects are added to 
the import set, it can be of interest to update the synch map file with these new Document Objects using 
the “Merge Synchronization Map Files after Import”.  
 
This is done in the following manner: 
 

1. Check the “Create Synchronization Map File” to generate the import map for the new Document 
Objects which shall be merged with the existing map files. 

 
2. Load the Synch Map file(s) to be used during import for the existing mapping. 

 
3. Check the “Merge Synchronization Map Files after Import”. 

 
As a result, the generated map file for the new Document Objects will be merged with the existing Synch 
Map files, creating a new, updated Synch Map file. 
 

3.29.1.3 Synchronization using ID key in an attribute (ExtID) 

As the handling of synchronization map files can be somewhat cumbersome, an alternative is to write the 
ID-mapping information from previous import sessions into an attribute in the target object. 
 
A necessary prerequisite is that each type that is subject to synchronized import has a String Attribute with 
the name “ExtID”. Note that this is a strictly synch import relevant attribute that ought not to be included 
in any formal output. 
 
By selecting the option “Write Synch ID in ExtID Attribute” during the first import, the ID in the import file 
is written into the attribute value of the ExtID. If the IDs of the import file are Aligned Elements ID, the IDs 
written into the attribute is the full ID including project name but not revision. 
 
At subsequent imports, select the option “Synchronize using the ExtID” to overwrite objects in the project 
with information from the import files where the ID in the import file matches the existing ExtID value. 
 
The mode has the additional options for objects for which no matching object is found, i.e. no object in the 
project has an ExtID value that matches the ID in the import file: 
 

▪ Import as normal – The object is simply imported as a new object. 

▪ Skip import of object – The object is NOT imported. 

 

Note! If several objects are found in the project for a given ID, no synchronization is made and an error is 
displayed. 
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3.30 The Import Process 

The following rules apply to importing: 

▪ Document Objects of the same type as the target chapter will be placed in the target chapter. 
Document Objects of different types are placed in the applicable book (under the root chapter). 

▪ The Document Objects will receive new IDs as they are imported. 

▪ If a Document Object is imported several times, a copy with a new ID of the object is created 
each time. 

 
Regardless of the type of import, to start the import, click OK in the Import Dialog. Initially, the user also 
has the option to deselect Document Objects from the import file.  
 

 
 
Selecting the second option takes you to a dialog where you can deselect Document Objects from the 
import set. The deselected objects are not imported. 
 

3.30.1 Import mapping of unknown Object Types 

If the imported Document Object is of a type that is not available in the target projects template directory, 
the user will be asked to map the unknown type to a known type (i.e. a type available in the template 
directory). 
 
If the user selects to map to a valid, existing type, all subsequent objects of the unknown type found in the 
input session will automatically be mapped to the selected type. 
 
If the user declines to map the object of the unknown type to an existing type, all subsequent objects of 
the unknown type found in the input session will be discarded / not imported. 
 

3.30.2 Import mapping of unknown Attribute 

If the imported Document Object contains an Attribute of a name and type that does not match an existing 
Attribute in the given Document Object Type, the user will be asked to map the unknown attribute to a 
known/existing attribute of the same attribute type.  
 
If the user selects to map to a valid, existing attribute of the same attribute type, the attribute in all 
subsequent objects found in the input session will automatically be mapped to the selected attribute. 
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If the user declines to map the unknown attribute to an existing attribute type, the unknown attribute in 
all subsequent objects found in the input session will be discarded / not imported. 
 

3.30.3 Import mapping of unknown Attribute Enum Value  

If the imported Document Object contains an Enum or UserEnum Attribute Value that does not match an 
existing Attribute Value in the given Document Object Type, the user will be asked to map the unknown 
value to a known/existing value.  
 
The user has to map the unknown attribute value to a valid, existing value and consequently the unknown 
attribute value in all subsequent objects found in the input session will automatically be mapped to the 
selected attribute value. 
 

3.30.4 Applying xsl-transformations on the import file 

If the import file is not conformant to the default import-xml schema, the user is inquired if an import 
transformation should be applied. If applicable, the user will be asked to supply a valid xsl-file defining the 
transformation. 
 

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  123 / 269 

3.31 Copy Document Objects to a different Project 

It is possible to Copy Document Objects from the current (source) project to a different (target) project. 
This mechanism is essentially only an automation of the existing export and import functions described in 
3.27 and 3.29. 
 
It is only possible to Copy Document Objects from the Project Explorer context menu. 
 
To copy Document Objects to a different project: 
 

1. Select the document objects in the Project Explorer. 
 

2. Click Copy Objects to Project in the context menu.  
 

3. You will now be prompted with the following dialog. 
 

3.32 Import Files 

For Document Objects containing File Attributes, existing files can be imported in batch mode. 
 
To upload/import offline documents to e.g. Attachments or File Objects, use the Import Files function. 
Prepare the import set by zipping the files into a zip file.  
 
Select Import Files and in the displayed dialog, browse to the zip file and click OK. 
 
For each file in the zip file:  

1. A document object will be created 
2. The imported file will be associated with the first found File Attribute in the document object 
3. The title of the object will be set to the file name (including file extension) 
4. If the original files exist in a folder structure, an equivalent chapter structure will be automatically 

created and the files will be placed in the chapters corresponding to the folders of the original files. 
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The options available here are essentially the same as in 3.29. 
 
You can now use the Target Project Browse button to select a target project. 
 
If the “Disable source objects after copy” is selected, the selected Document Objects will automatically be 
disabled after the copy session has been completed. This applies when the Document Objects is intended 
to be “moved” from one project to another. 
 
Note!  
Just like in export, there is an option available to include underlying traces in the export e.g. Hazards and 
Mitigations when exporting Failuremodes. 
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Again, to recreate traces (including traces to and from linked projects) the relevant Document Objects / 
Projects must be currently loaded. 
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3.33 Work with Linked Projects 

Projects can be linked to each other in a hierarchical order to allow the re-use of common documentation 
in multiple products (or modules).  
 
The most common scenario is to create documents for components and refer to the documentation in 
these components through traces from a master project that represents a System.  
 
E.g. the sub module A is used in Product 2 and 3. The normal case is that a Product contains multiple sub 
modules, e.g. Product 1 has the linked projects sub module A, B, C and D. 
 
To create a link to other projects, select the menu File > Add Linked Project in the menu tool bar and select 
the project you want to link to. 
 
Note! It is not possible to create circular linked-project structures. 
 
The chain of linked projects can be of arbitrary length. The project linking hierarchy is displayed when 
clicking Project -> Display Project Hierarchy. 
 

 
In the Project Hierarchy view, loaded projects are displayed in green. Yellow colored projects may be 
loaded later / on demand (right click and select <Load Project>) and red colored projects can only be 
loaded if their parent projects are loaded as well. 
 
In this view, parent project can also be loaded if one exists for the current project. The parent project will 
be loaded as a linked project i.e. no changes can be made in the document object attributes but traces can 
be set to and from objects. 
 
The project that is linking to other project is called a master project (Product 1 above) and all other 
projects are called linked projects or sub projects (Sub modules A, B, C and D above). When linked projects 
are loaded (either after they are added or when the master project is loaded again), all their Explorers are 
also displayed in the Master Project.  
 
When you open a master project linked to sub projects you will be prompted with a Login dialog for each 
sub project. If you click <Cancel > in the login dialog, the sub project in question (and all sub projects linked 
to it) will not be loaded.  
 
Note! To open a sub project you have to use credentials from the sub project in question, not the master 
project. If the credentials in the sub project are identical with those in the master project, you will be 
automatically logged in. 
 
It is possible to create traces from the master project to your linked projects (e.g.: You can trace a 
requirement in Product 1 to a specification in sub module A.) and vice versa. 
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Note!  
Traces from master projects to sub projects are not automatically updated to the latest state of the 
document objects in the linked projects. Consequently you have to manually perform updated traces to 
these document objects every time the document objects in the sub project changes. The trace explorer (see 
2.5.2) provides the function Trace to the latest revisions, to perform these updates in a convenient way. 
Linked projects are ignorant of the traces from master project. Traces from master project will not appear 
in linked projects. This also applies to traces from linked projects to their master project. 
 
To unlink a project, select the File -> Remove Linked Project and in the menu tool-bar and select the 
project to unlink. 
 
Note! Traces from a master project to any unlinked projects still exist but are not displayed after the project 
has been unlinked. 
 

3.34 Running a Regulatory Wizard 

A user may run a regulatory wizard to either perform an audit or to e.g. classify the system according to a 
regulatory standard and generate initial requirements to implement a system according the standard. To 
run a wizard, select the applicable wizards from Wizard -> Run a Wizard and follow the instructions.  
At the end a Wizard Report is generated to document the outcome of the wizard. The Wizard Report is 
found in the Project Explorer in the book with the same name. 
 
To load a downloaded wizard (an xml file), place the wizard xml file in the designated Wizard Directory. 
The Wizard Directory is usually a sub directory to your template directory. Click Wizard>Set Wizard 
Directory to set the designated location. The download wizard should now appear under Wizard -> Run a 
Wizard. 
 
 
To define a Regulatory Wizard, please refer to 6.3. 
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3.35 Branching and Merging Projects 

3.35.1 Branching 

Aligned Elements projects can be branched in order to create an independent line of the documentation. 
 
When triggering a branch from Main Menu -> Project Settings -> Branch , a new Aligned Elements Project 
will be created. The user must select the types of Document Objects that shall be copied from the origin to 
the branch project. The branch project will then contain the latest revisions of Document Objects of the 
selected Document Object types. 
 
Note that if a type is not selected for Branching, the ID counter for that type is not reset for the Branch 
project.  
For example, if  
1) Four User Needs exist in the Origin project and  
2) the Origin project is Branched and  
3) the user selects to not include the User Needs in the Branch (resulting in an empty User Need section in 
the Branched project) 
4) the user creates a new User Need in the Branch, it will receive ID 5 (UN 5) and not 1 (UN 1) 
This is done in order for the trace integrity between then Branched and Origin project to remain intact.  
 
At branching, Project History events are added to both the origin and the branch projects to record the 
branch action. 
The branch project will indicate the name of the origin project in the lower left corner of the application. 
 
Note that the following restrictions apply when branching a project. 
The branch project will not contain the following elements form the origin project: 
 

▪ Test Runs 
▪ Signatures 
▪ Snapshots 
▪ Old revisions of Document Objects 

 
Note that backlinks in traced External Issues such as Jira, GitHub; Azure DevOps etc. are not adapted when 
a branch is made!! These backlinks still point to the original project! 
 

3.35.2 Merging 

When merging a branch back to the origin project, Document Object changes in the branch are added to 
the origin. 
If any conflicts exist between changes in the origin and the branch, they will be displayed, and you can 
decide which version to use (i.e. the origin change or the branch change. 
 
Note that the following elements are not merged back to the origin: 

▪ Test Runs 
▪ Signatures 
▪ Trace Tables 
▪ Queries 
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▪ Charts 
▪ Tags 
▪ Locked Document Objects 
▪ Snapshots 
▪ Reviews 
▪ Users and User Groups 

 
Template Paths – The Template path for the original and the branch project must be exactly the same at 
the time of merge. 
 
Users – The users in both the original and branch project must be the same at the time of merge. 
 
Note that the branch project still exists after merging. Although it is possible to continue working on the 
branch and merge additional changes back to the origin, only changes after the last merge occasion will be 
considered during a subsequent merge.  
 

3.36 Working Offline 

In case you want to work on your product documentation but do not have online access to the server, you 
can make a temporary local copy of the project on your hard-drive. 
 
When you have completed your changes and have access to the server again, you can upload your changes 
to the server.  
 
In the Project menu, select Take Project Offline to copy the project to your local drive. 
 
This will create a local copy of the most recent revisions of all your document objects. The operation can 
take several minutes.  
 
It is possible to select a sub set of Document Object types to take offline. If the Review type is not selected, 
then snapshot is not taken offline (which reduces the time to take a project offline considerably). 
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To use the offline version of the project the next time you log in, select the Work Offline entry in the 
Server combo box of the Create / Open Project dialog: 
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The project will load as normal and you can work without having to connect to the central repository 
server.  
 
The function scope for working offline is restricted in some areas. Therefore, when working offline you will 
not be able to: 
 

▪ Creating and modifying user and user groups 

▪ Creating snapshots 

▪ Linking and unlinking projects 

▪ Closing Reviews 

 
When you have completed your work and wish to synchronize your changes back to the online project, 
select the menu entry Project ->Take Project Online in the menu tool bar. If any conflicts exist between 
changes online and offline, they will be displayed to you and you can decide which version to use (i.e. the 
online or the offline version). 
 
Note!  
If you take a project offline several times you will be prompted that your existing offline version of the 
project will be overwritten with the current online version of the project. 
When taking an offline project online, Aligned Elements will do its best to synchronize all changes back to 
the online version of the project. You will be asked if you want to delete the offline project after it has been 
merged online, which is also the recommended action to perform. Otherwise taking the same offline project 
online a second time without having taken the synchronized version of the online project offline in the 
meantime might corrupt the online project. 
 
It is only the last state of the project content is merged back online. The project history in the online 
project will therefore not contain the complete project history of the offline project, but rather the 
changes made to accommodate for the merges.  
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Furthermore, there are a few content items that when changed offline will not be merged online: 
 

▪ If a document object has been created offline but also disabled offline, this object will not be 
merged back to the online project. 

▪ Project Settings changes will not be merged back. 

▪ Query changes will not be merged back. 

▪ Trace Table changes will not be merged back. 

▪ Chart changes will not be merged back. 

▪ Tag changes will not be merged back. 

▪ Trace Run changes will not be merged back. 

 
Note!  
Chapters deleted offline and moved online will be merged back as deleted i.e. the user will not have the 
possibility to resolve this conflict. 
When the offline changes are merged back online, Aligned Elements will assign new timestamps to the 
merged project changes i.e. the server time of the merge action, which is not the same as the time as when 
the changes where originally made offline. Due to the merge algorithm, the order of the merged actions 
may differ slightly from the order of the original changes made offline.    
 
If the document object templates have been modified in either your Online or offline project, you will not 
be able to take the project online straight away. Before taking changes online again, load the offline 
project using the same templates as for the online project (contact your system administrator to handle 
this properly). 
 

3.37 Create a project offline 

It is of course possible to create a project offline. Just select the Work Offline entry when clicking < New 
project > in the Create/Open Project dialog. As usual you will be prompted to define the directory where 
your document object templates reside.  
 
Note! Offline projects will be stored in the path C:/AlignedElemenets/Offline. If this path does not exist, 
Aligned Elements will try to create it. If your current Windows user does not have enough permission to 
create this path, Aligned Elements will fail and you will have to create this path manually. 
 
You can at any point in time take the project online by selecting Project->Take Project Online. You will 
then be prompted to select a server (at this time you might have to click the < Scan > button to scan for all 
available servers on the network). 
 
Note! If the online server contains a project with the same name as your offline project you will not be able 
to take it online on that server without manually deleting the online project from the server using SQL 
Management Studio. 
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3.38 Display two Document Object Forms next to each other 

Display the document objects in the tab control by double-clicking on them in e.g. the Project Explorer. 
When both objects are displayed, right click on the tab of one of the tab pages: 
 

 
 
Select New Vertical Tab Group and the forms will be displayed next to each other: 
 

 
 
If you have more document objects displayed in your tab control, you can move them to the right or left 
tab group with the help of the same context menu using Move to Next Tab Group or Move to Previous 
Tab Group: 
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3.39 Open a Document Object from a Hyper-link 

If you are invited to e.g. participate in a review you may have received a mail invitation with a link to the 
review. To open the Review Document Object, just click on the hyperlink to the review. This will open the 
Document object in your Aligned Elements application, provided that Aligned Elements is started and the 
project is opened.  
If Aligned Elements is not started, a new instance is started and after you have logged in, the Review 
Document Object will open. 
 
The format of the hyperlink is: 
 
elementslink:<server name>,<project name>-<ID> <Revision> 
 
E.g. for Revision 2 of Requirement 1 in the project AnalyzerDB:  
 
elementslink:dbserver1,AnalyserBA-RQ 1 3 
 
To designate a Document object of the most current revision, just omit the revision number and associated 
space, such as: 
 
elementslink:<server name>,<project name>-<ID> 
 
or in the concrete example: 
 
elementslink:dbserver1,AnalyserBA-RQ 1 
 

3.40 Creating a Document Object Hyperlink using drag-and-drop 

 
By dragging and dropping a Document Object from the Project Explorer or Trace Explorer into an a 
Microsoft Outlook Email or a Word Document, a hyperlink to that Document Object is automatically 
created. 
 
Creation of such hyperlinks can also be done within Aligned Elements. Drag and drop a Document Object 
into a  
 

3.41  Modify the Gap Form Settings 

It is possible to customize a few settings to define the behavior of the Gap Form. 
The settings are stored in an xml file in your template directory called 
GapFormSettings/GapFormSettings.xml 
 
If you open the file you see the following information: 
<?xml version="1.0" encoding="utf-8"?> 
<GapFormSettings MaxUserEntries="5" AllowAutoReuse="false" AllowSuppressSuspect="false" 
xmlns="urn:GapFormSettings.xsd"> 
  <StandardUserComment Comment="Corrected Spelling." /> 
  <StandardUserComment Comment="Corrected Formatting." /> 
</GapFormSettings> 
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The first option, MaxUserEntries, defines the number of User Comments that shall be saved for reuse. The 
Gap Form uses a rolling list meaning that the last “x” comments are stored. When the user adds an x+1 
comment the first comment is deleted and this comment is added. This setting is an integer (a number) 
and is set to 5 by default. 
 
Note! The User Comments list is stored in a file in your Working Directory, i.e. not in the GapFormSettings 
file.  
 
The second option, AllowAutoReuse, is a True/False setting. If set to True, the last entered user comment is 
automatically inserted in the Change Comment dialog. If set to False, the change comment field is left 
blank. 
 
The third option, AllowSuppressSuspect, is also a True/False setting, to enable or disable the “Suppress 
Suspect” check box. If the user ticks this check box, the change will not set the object to suspect (provided 
that it has outgoing traces). The final True/False setting in the GapFormSetting.txt file enables or disables 
this check box for all users (i.e. ‘True’ enables it and ‘False’ disables it.) 
 
Last but not least are the standard comments available in the Gap Form. This can be any number of 
standard comments. The Standard Comments can be used to classify specific changes tied to a statement 
in your own SOPs e.g. you can define in an SOP that any changes made to Document Objects that imply the 
Change Comment “Corrected Spelling” do not have to be reviewed in detail at the next review. Default 
comments are “Corrected Spelling” and “Corrected Formatting”. 
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4 Microsoft Word Integration 
Aligned Elements is tightly integrated with Microsoft Word for easy creation and maintenance of Word 
documents. 
 
The Aligned Elements Word Integration not only allows you to insert and display your document objects in 
a Microsoft Word document, but also enables you to work with your document objects in the Microsoft 
Word document, using bi-directional synchronization between the Aligned Elements database and the 
Microsoft Word document. 
 
Note: As of Aligned Elements V2.3 Service Pack 2, support of Word 2003 has been depreciated. 
 

4.1 Trust message from MS Word 2007 and above. 

When opening a Word document from AE the first time, you will be prompted that the calling application 
(i.e. Aligned Elements) is not trusted. To avoid this problem, add Aligned Elements as a Trusted Location.  
 

 
 
Do this by selecting “Add new location…” and browse to the installation path of Aligned Elements which is 
located under <document and settings>\<user>\AppData\Local\Apps\2.0. Do not forget to select “Valid for 
all Subfolders”. 
 
When the Word document has been loaded, it might be the case that the Document Action panel is not 
visible. The Document Action panel is under the “View” menu option. 
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4.2 Adding a Microsoft Word document to your Aligned Elements Project 

In order to load and integrate a Microsoft Word document in your Aligned Elements project, create a File 
Document object in the File Explorer. See 2.5.3 for details about the File Explorer. Then use the browse 
button to select the Microsoft Word document from your local harddrive or network that you want to 
integrate. The default directory displayed when clicking the browse button, is the “Document Template” 
sub folder in your template folder. 
 

4.2.1 Templates on Azure 

If your template files reside on an Azure File Storage, a selection box of the available Document templates 
in your Azure Template directory will be displayed.. 
 
If you, in this situation, want to select a document from your local harddrive or network instead of the 
Azure File Storage, click Cancel in the dialog and then select the document  
 
 
When adding a file with the extension “docx” Aligned Elements assumes that the file is a Microsoft Word 
document.  
 
When the file is opened and displayed by clicking on the filename link, the Word Document is opened in 
Microsoft Word.  In addition the Document Actions Pane is displayed next to your document in Word.  
 
Note! The Aligned Elements integration will only work with the Microsoft Word “docx” file format, available 
in Microsoft Word 2007 or later.   
 

4.3 The Word Integration Document Action Pane 

When working with a Microsoft Word document, the Document Action Pane will show a toolbar with the 
most common functions within the word integration. Just below the toolbar, a slightly modified Project 
Explorer is displayed.  

4.3.1 The Word Integration Toolbar 
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The toolbar provides buttons for the following functions (Each of the functions will be explained in detail 
further down in this manual.): 
 
Synchronizing 

 Synchronize the document with the current state of the Aligned Elements database. For details see 
4.6. 

 
Forced Update 

 Forced update implies that all Document Objects in the Word documents are replaced with the 
latest revision of the document object in the database. For details see 4.6.2.  

 
Insert Snapshot 

      Insert objects from a snapshot. For details see 4.7. 
 
Insert Query 

      Insert objects from a query. For details see 4.8. 
 
Insert Revision History 

 Insert revision History, creates a revision history that is automatically maintained with any 
 changes to the document objects. For details see 4.12 

 
Insert DHF Index 

 Insert the current DHF Index. For  
 
Insert Project Information 

 This inserts the project information for the current state of the project or for a snapshot. 
 
Insert Test Runs 

        This inserts one or more test runs. For more details on test runs, see 3.12.1 
 
Insert Risk Summary 

 Insert the Risk Summary, see 3.25. 
 
Filter Document Objects on Tags 

  Use the dropdown and select a Tag to filter the Explorer according to the Tag. For more details on 
Tags, see 3.14.  

 
Insert Charts 

       This inserts a selected chart. All charts are listed for selection. 
 
Refresh Project 

      Refresh the project explorer with the newest data. For details see 4.9 
 
Insert Trace Table 

 Insert trace table. For details see 4.14 
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Perform manually Import from the Word document 

   This toggles the display of the additional controls to manually import content from the  document. 
For details see 4.13. 
 
Select alternative Word Template variant 

 Activates an alternative Word Template variant in order to alter the look-and-feel of the word 
insertions. For details see 4.15  

4.3.2 The Word Integration Project Explorer 

Just below the toolbar, the Project Explorer is displayed. The Project Explorer is used to access the 
currently existing document objects.  
 
The bottom section is used to display information about the current actions of the system e.g. when 
synchronizing, the system will indicate which document object it is currently working on.  
 
Note! The Word Project Explorer does not update automatically on changes. To update the Word Project 
Explorer see 4.10. 
 

▪ Insert at Cursor 

▪ Insert the currently selected objects into 
the document. For details see 4.4 

▪ Insert Chapter at User-defined Level 

▪ Inserts the selected chapter at a defined 
word heading level. See 4.4.1. 

▪ Insert old revision at Cursor 

▪ Insert an old revision of the currently 
selected object into the document.  

▪ Find in Document 

▪ Finds the currently selected object in the 
word document. 

▪ Find in Explorer 

▪ Search for a specific ID in the Project 
Explorer. 

▪ Synchronize Selected Objects 

▪ Performs a selective synchronization where 
only the objects selected in the Project 
Explorer are checked for modifications. 

▪ Update Selected Objects 

▪ Perform a forced update on the selected 
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objects. See 4.6.2. 
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4.4 Inserting objects into a Microsoft Word Document 

In order to insert and display a document object into your word document, select the object in the Project 
Explorer and then drag it to the desired position in your document.  
 
Insert multiple objects at the same time, by selecting multiple objects in the project explorer by using the < 
Shift > key (select a continuous range of objects) or by using the < CTRL > key. 
 
You can also drag one or more chapters into the word document. Consequently all objects in the chapters 
are inserted in the document. Note that it is also possible to drag a whole document object type section, 
e.g. requirements, into the document by simply dragging the header “Requirements” into the document. 
 
Instead of using drag and drop it is also possible to just select the object in the Project Explorer and then 
press the < Insert at Cursor > item in the context menu to insert the object at the cursor position. 
 
Note! Each document object can only be added once to the document. However, it is possible to make a 
document object part of multiple documents. 
 

4.4.1 Insert Chapters at User-defined Level 

Per default, Aligned Elements maps its internal Chapter levels to Word headings when inserting chapters 
and objects into word i.e. inserting a book will map to a word heading of level 1, using its existing Word 
chapter templates accordingly. 
 
 It is however possible to customized this behavior and map the inserted chapter to a user-defined heading 
level. To perform this, use the Insert Chapters at User-defined Level in the context menu. 
 
All sub chapters will be inserted on Word heading levels relative to the top chapter heading.  
 

4.5 Edit a document object in Word 

When a document object is placed into a Word document, you may edit the text fields directly in word. 
 
Note!  
Not all available document object attributes are editable in Word (see 4.5.2) 
Only non-frozen document objects can be edited in the Word document. 
 

4.5.1 Deleting an object from the document 

In order to remove a document object from your document, just mark the complete object and click the 
delete button on your keyboard.  
 
This removes the document object from your Microsoft Word Document, but does not disable the object 
in the Aligned Elements database. 
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4.5.2 Invalid Entries 

If an invalid text is entered into a field, e.g. a text where a numeric value is expected, the invalid text will 
be automatically reverted to the original text when you click somewhere else in the document.   
 
  

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  143 / 269 

4.6 Synchronizing a document with Aligned Elements 

The Aligned Elements Word synchronization mechanism is bi-directional.  
 
When you click the < Synchronize > button, the entire word document is scanned to detect deviations 
between the object displayed in the word document and the status of the same object in the database. 
 
This means that the document objects stored in the Aligned database are updated with the changes you 
have made to the objects in the word document when you click the < Synchronize > button in the 
Document Action Pane toolbar. You will be prompted with a normal Gap Form dialog before you commit 
your changes to the database. 
 
However, the bi-directional mechanism also implies that the document objects displayed in your Word 
document are updated with changes in the database made by yourself or other users if you have not made 
any changes to the objects in your word document (automatic update). 
 
Note! When you open a word document from a File Object containing document objects, the objects are 
not automatically synchronized as the word document is displayed. You have to explicitly click the < 
Synchronize > button to update the document objects in the word document to the latest revision. 
 

4.6.1 Synchronizing Chapters 

Aligned Elements also synchronizes chapters. This affects the name of the chapters as well as their 
contents.  
 
Chapter names that are changed in the database are updated in the document during synchronization and 
vice versa. When synchronizing chapters, Aligned Elements also checks if all Document Objects in a chapter 
are already part of the document. If they are not, the Document Objects are automatically added to the 
document.  
 
The position of the added Document Objects in the Word document is based on the display order in the 
Project Explorer and is determined in the following way:  
 

1. First, the Document Object preceding (in the Project Explorer) the object to be inserted is located in 
the Word document. 

 
2. The Document Object to be inserted is inserted after the located Document Object. 

 
3. If the preceding Document Object cannot be located in the document, the object is inserted directly 

after the chapter, before any other Document Object. 
 
For details, how to adapt the chapter templates for synchronization, contact support@aligned.ch. 
 

4.6.2 Forced update of Document Objects 

This option is intended to align the document content with the current state of the objects in the database. 
Even if objects are not changed in the database, they are still updated in the word, overwriting any 
changes. This can f.e. be used to update the document with a new definition of the word template for the 
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objects. This can either originate from a new definition of the word template (see 6.8.1), or by choosing a 
different template variant. (see 4.15) 
  
This action can also be performed on selected document objects using the context menu in the Word 
Project Explorer. 
 
Note! Any unsaved changes made to document objects in the document are ignored. The object content is 
replaced with the content from the database. 
 
Note! Document Objects already having the most current revision in the document are also replaced. This 
allows you to update all objects to a different template. 
 

4.7 Inserting objects from a snapshot 

When inserting document objects from a snapshot, the system will prompt you to select an existing 
snapshot. After this the system will enter the document objects which are part of the snapshot into the 
document. The first object is inserted at the current position of the cursor. The fields of these document 
objects cannot be edited in the document. 
 
Note! If the snapshot contains objects which are not part of the word integration these are not displayed.  
 

4.8 Inserting objects from a query 

When inserting objects from a query, the system will prompt you to select an existing query. After one of 
the queries is selected, the following prompt appears. 
 

 
 
It is either possible to simply insert all objects from the query into the document or create a list of them. 
  

4.8.1 Inserting objects from a query as a Table 

When inserting objects from a query as a list, the objects are listed in a table. The appearance of the table 
is determined by a word template for query tables. 
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4.8.2 Inserting objects from a query as individual Document Objects 

When choosing to insert them as individual document objects they are inserted as document objects as 
usual and will be synchronized together with the query. The included document objects cannot be 
manually edited in the Word document. 
 

4.8.3 Inserting objects from a query as Chapters and Document Objects (Remove Chapters) 

When choosing to insert the set as chapters and document objects, all chapters are included for the 
Document Object Type but only the Document Objects that matched the query. When the document is 
synchronized, the content of the query is updated. The included document objects cannot be manually 
edited in the Word document. 
 
You can optionally choose to not display empty chapters. Parent chapters are however still displayed even 
if they don’t contain any Document Objects of their own. 
 
Note that there is the optional possibility to define the word heading level to which the top-level chapter 
shall be mapped. 
 

4.9 Refreshing the Project Explorer 

After launching the word integration, the Word Project Explorer is NOT updated automatically when 
changes are made to objects. However, this does not apply to document objects from linked projects. To 
update your project explorer with the newest data from linked projects use the <Refresh Project Explorer> 
button. 
 

4.10 Working with linked projects in the Word Integration  

If your project has other linked projects, see 3.33, the Word Integration will prompt you to decide if you 
want to display traced objects from these linked projects. If you decide to do so, all objects which are 
directly traced from your project are also displayed in the Project Explorer. For each document object type, 
the traced objects from linked projects are shown in a chapter with the name of the project. E.g. all 
specifications from a linked project (which are traced from your master project) will be inserted into a 
directory with the name of your linked project. The directory structure directly below this chapter is the 
current chapter structure from the linked project. 
 

 
 
Document objects from the linked projects can be inserted into the document, just as any other document 
object, but they cannot be changed in the document.  
 
Note!  
Because traces to objects in linked projects refer to a specific revision of that object, it is possible that the 
object was initially in a different directory than the directory in which it currently placed. 
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4.10.1 Displaying Document Objects from linked projects in Word Project Explorer 

Per default, only those document objects from the linked projects are shown, which have traces from the 
master project in their traced revision i.e. linked objects that are not traced from the master projects are 
not displayed.  
 

 
 
To display all linked objects (including non-traced objects) of latest revision from the linked project, right-
click on the “Linked Objects…” node and select “Show all objects from linked Projects in latest revision”.  
 

4.10.2 Synchronization of Document Objects from Linked Projects 

 
If objects from a linked project were inserted with the “Show all objects from linked Projects in latest 
Revision” option active, the synchronization will update these objects to the newest revision available. If 
the option was not active when the object was inserted, the object will be updated to the currently traced 
revision. In both cases the objects cannot be edited in the document.  
 

4.11 Conflicts at synchronization 

When working with document objects in a Microsoft Word document, the following situation can occur: 

▪ The same document object was changed by another user in the database. 

 
As a result, the document object was changed in both places. 
 
Should the case arise where an object has been changed in the document AS WELL AS in the database, the 
system will prompt you to choose which of the versions of the document should overwrite the other. 
 

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  147 / 269 

 
 
By choosing the current version from the database, the changes made to the object in the document are 
overwritten with the current version of the object from the database. 
 
When choosing to overwrite the changes in the database with the changes made to the object in the word 
document, the document object is updated in the database to a new revision.  
 
Each time a document object is updated in the database, the gap dialog appears as usual. 
 
If you < Cancel > in a conflict situation, the object is not “synchronized”, i.e. the decision in how to resolve 
the conflict is postponed until the next synchronization. 
 
Note! If you cancel the changes are NOT reverted and stored in the word document if you save the 
document. The next time you open the word document the changes are still there. If you wish to revert to 
the original version of the document object, delete it from the word document it and insert it at the same 
place again.  
 
Changes in the document outside of document tags are of course not written to the database and are only 
part of the document. These changes are saved as you click < Save > in your the Word Application. 
 

4.12 Automated Document Revision History 

The Aligned Elements Word Integration features an automated revision history recording. To insert a 
revision history into the document, just place your cursor at the position where the revision history should 
be placed and click the < Insert Revision History > button. The system now inserts an empty revision 
history.  
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Automatic revision history recording 
 
From now on the following changes are automatically recorded in the revision history. 

▪ Changes to any fields of document objects in the document. 

▪ Inserting of document objects into the document from the project explorer 

▪ Deleting of document objects from the document. 
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4.12.1 The revision history and synchronization 

When the word document is updated with newer revisions from the database (during the synchronization), 
the change comments entered when creating these revisions are transferred to the change column in the 
revision history. 
 
Since the recording granularity of the revision history is very fine grained, your revision history will quickly 
become very extensive. It might therefore make sense to place it at the end of the word document rather 
than at the beginning. 
 

4.12.2 The Versions in the Revision History 

The initial version number in the automated revision history starts with 0.1. All changes performed in a 
single session are recorded under the same version number. When opening the document the next time, 
the previous version number is incremented by 0.1.  
 
Note: The version after 0.9 will be 0.10 and not 1.0 
 
The version number can be manually edited. If at a certain time you choose to upgrade your version 
number to 1.0 just edit the version number. From now on, the system will start incrementing from 1.0, i.e. 
the next version number will be 1.1. 
 

4.12.3 Inserting Aligned Elements Metadata as Fields 

It is possible to have the Aligned Element file version and project name displayed in your word document 
(e.g. in the document header or footer) using the Word Document Properties. 
 
In the main menu item "Insert", select "Quick Parts" and then "Field". In the list of available fieldnames, 
select "DocProperty" and then in the second column of available properties, select "Version" or “Project”.  
 
The "Project" document property is automatically created by Aligned Elements, so it will always be 
available.  
 
The "Version" property is created once a revision history is entered (if the history is removed, the property 
stays there of course). If no history is entered, it is possible to manually modify the version by editing the 
field value in the word document. 
 
If a revision history exists, the version field will contain the most recent version entry of the revision 
history. The "Project" is always set to the master project name. 
 
It is possible to have multiple instances of both fields in the document. 
 
In addition to “Version” and “Project”, all attributes from the File object which contains the currently 
opened Microsoft Word file are available. The names of these attributes are prefixed with the text 
“Aligned_”. Per default these are “Aligned_Description”, “Aligned_Disabled”, “Aligned_File”, “Aligned_ID”, 
“Aligned_Revision”, “Aligned_Title”. 
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Note: Fields cannot be populated by texts longer than 255 characters!  
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4.13 Import Document Objects from Microsoft Word 

To import an existing data from e.g. a Product Requirement Word Document into Aligned Elements 
proceed as follows: 
 

1. Create a new File Document object. 
 

2. Add title and a description. 
 

3. Browse to the Microsoft Word document you want to import and select it. 
 

 
 

4. Open the Word document from the File Document object by clicking on the hyper link of the file 
name next to the < Browser > button. 

 
5. The Word document is opened and displayed in Word and the Project Explorer is displayed next to 

the document. 
 

6. In the toolbar above the Project Explorer in the document you can set the current Document 
Object Type (Currently working with). Since we in the case deal with a Product Requirement 
Document, we select Requirement. 

 

 
 

7. Now, select some text in the word document that describes the title of an existing Requirement 
and right-click and select “This is a new Requirement Title” in the context menu. 
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8. Continue to select text and assign to the still available attributes. 
 

9. When completed, click in the toolbar to save as a new object. The Radio button Import 
Only/Import and insert, controls if the Document object should also be inserted into the word 
document.  

 
Note! You can only import one attribute data for one document object at a time. 
 

4.14 Trace Tables 

To create a trace table in your document, select the menu item < Insert Trace Table > from the toolbar. 
The trace table is created according to the available templates. The created table should not be manually 
edited since it is automatically synchronized according to the traces in the project database. 
 
After choosing to insert a query table a dialog similar to the following dialog will appear. 
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Now you choose if you want to insert a trace table for: 

▪ all objects of a given Document Object type from the database  

▪ the objects in the output set for a given Query 

▪ all objects residing in this Word document.  

 
Note!  
The system will only display queries which contain the appropriate Document Object type of objects. 
A trace table contains a number of parent objects from a certain document object type. The trace table 
always contains all available document objects in the project of the parent type i.e. it is not possible to 
display a trace table for a subset of a parent document object type.  
 

 

4.15 Applying Word Template variants 

 
It has been recognized that not all stakeholders are interested in the same document object data from 
Aligned Elements. To accommodate this, you can have several Word templates for a single type name e.g. 
one requirement word template for formal output and a different requirement template for informal 
output. 
 
Defining a Word template variant is done by adding a prefix to the template name i.e. if we want to create 
variants for that we define as “RnDStyle” in the main set a template might be called 
“RnDStyle.Requirement.docx”. 
 
All Word templates prefixed with “RnDStyle” are perceived as belonging to the same variant set. If a 
variant does not define a specific template, the template without a prefix is used. To select which variant 
style to apply, use the “Template Variants” drop down button. The selected variant is then applied for the 
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next insert session. Note that synchronized that are synchronized are also using the currently selected 
templates set. 
 

4.16 Using Tags in the Word Integration 

The Project Explorer in Word can be filtered according to Tags by using the applicable control in the Tool 
Bar. Only Document Objects belonging to the tag are then displayed in the Project Explorer. 
 
Note! The Insert / Synchronization mechanism is oblivious to tags. If the Project Explorer is filtered 
according to a Tag and a particular chapter displays a tag filtered sub set of its total content, then inserting 
the chapter in a Word document will insert ALL Documents in the chapter, not only the tagged set. To 
restrict the objects inserted to a specific tag, use a Query with a Tag filter and insert the Query. 

5 Troubleshooting 

5.1 The Action Pane does not display in the Word Integration 

Either the Action Pane is hidden but accessible or inaccessible all together.  
 
Click Ctrl-F1 in word to attempt access the general task pane and see if you can find the Action Pane in the 
drop-down list.  
 
It might also be the case that the Action Pane Active X component is blocked on your computer. Check for 
the registry key: 
 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\ActiveX Compatibility\{5f61f809-422a-
4152-91f5-9ec1b935efd7} 
 
If you find it, delete it and start Aligned Elements again. This time the Action Pane should be accessible in 
Word 
 

5.2 How to recover the last document changes after a Microsoft Word crash 

When Microsoft Word crashes while editing a word document containing modifications that you have not 
yet committed, you can restore your last changes through the following procedures. 
 

1. If Aligned Elements is still open, close it with the Task Manager to avoid any internal clean up 
actions. 

 
2. Start Microsoft Word in standalone mode (i.e. not from Aligned Elements) 

 
3. Use the recover option to recover the last auto-saved version of the word document in question 

containing your modifications.  
 

4. Select the most recent version of the word document and save a copy to e.g. your desktop (using 
File/Save As). This document contains your modifications but is not yet stored in Aligned Elements. 
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5. Start Aligned Elements, open the project in question and open the corresponding File Document 
Object in the Document Object Form. 

 
 Note! Do not click on the hyperlink in your File Object since this will cause Aligned  Elements to 
retrieve the last stored version from the project database and might overwrite  your unsaved changes. 
 

6. In your File Object in Aligned Elements, replace the linked document with this copy you saved in 
step 4. Browse to the location where you saved the copy of the recovered document. 
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5.3 Aligned Elements has a problem while working in Microsoft Word 

If Aligned Elements e.g. crashes or in another way poses a problem while you work in Microsoft Word, 
please follow these instructions: 
 

1. To not loose and changes to your current Word document, save a copy of the document to e.g. 
your desktop (using File/Save As).  

 
2. Close Microsoft Word. 

 
3. Start Aligned Elements and log in to your project again.  

 
4. Select the file object containing the file you were previously editing. 

 
 Note! Do not click on the hyperlink in your File Object since this will cause Aligned  Elements to 
load the last stored version from the project database and which overwrites  your unsaved changes. 
 

5. Browse to the saved document. This will cause the file object to be updated with your most recent 
changes in your Word document.  

 
6. To continue editing the document, click on the hyperlink with the document name again to open it 

with Microsoft Word. 
 

5.4 Get support if an Error Occurs 

If an unexpected error occurs, the execution trace is logged in the application log files. You can 
automatically report the error and send the log files per mail to Aligned AG. These files are only 
understandable to the developers of Aligned Elements. 
 
In the menu Help you find the entry Mail Logfiles To Get Support. Click on it and the log files from the last 
hour will be sent to support@aligned.ch automatically.  
 

 
 
If you have not set up the name to your company mail server as described in (section 6.3) there may be an 
error while trying to send. In that case, all relevant files are copied to your desktop and you are requested 
to manually send them to support@aligned.ch. 
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Error if no mail server was configured 
 
The sender of the mail is taken from your user information, so make sure that you enter a valid mail 
address for each user account established (see 6.2). It also makes it easier for us to get in contact with you 
for further support. 
 
If an unexpected error occurs in the application, you are this asked if you want to mail the log files for 
support. Please do so. These log files will greatly help us improve the application.  
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6 Tool Administration 

6.1 Spell-checking Dictionaries 

Aligned Elements supports Hunspell dictionaries (can be downloaded from 
http://www.textcontrol.com/en_US/downloads/dictionaries/ ) and includes the dictionaries for English, 
German and French as part of the installation. Due to the memory required to load a dictionary only 
English is active per default. German and French dictionaries can be found in the folder <Installation 
Directory>/DictionariesNotUsed. To allow Aligned Elements to load these at startup, please place a copy in 
the folder <Installation Directory>/Dictionaries.  
 
Note: you may need Administrator privileges on your PC to do this. 
 
You may also define your own dictionaries dynamically. This is called a User Dictionary. User dictionaries 
should reside in on a network location where all project members have read and write access.  
Use the following steps to set up and use a Common User Dictionary: 
 

1) Define a path to an existing location where the user defined dictionaries shall reside in the Project 
Settings “Path” tab page (see 6.5 Project Settings). Reload the project to activate this setting. 

2) Open a Document Object with a Richtext, String or Table attribute and use the context menu to 
select “Spellchecker => Select Language” and select a language. 

3) Then use the same context menu to select “Spellchecker => Options => Spell Checking Dictionaries 
=> User Dictionaries” and click “New…” and add a name for the dictionary. This will create a new 
file for the user dictionary. 

4) To add words to the dictionary, select a word indicated not to be spelled correctly, use the context 
menu to select “Spellchecker => Spellcheck Now (F7)” and select “Add to Dictionary” in the dialog. 

 

6.2 User Management 

In the menu User Management->Manage Users, you may add, modify and disable users. Users cannot be 
deleted (this would make the project history inconsistent) but they can be disabled.  
 

 
Dialog for management of users 
 

6.2.1 User Name 

This is the name of the User. The User Name is used for authentication and is also listed in the Project 
History in association with all data integrity relevant actions the user performs in Aligned Elements.   
If the organization is using Active Directory or LDAP, it is recommended to use the users existing Windows 
user name as Aligned Elements user name.  
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Note that the User name cannot be modified once it has been saved.  
Note that the User name must be unique within the Project i.e. there must no other User with the same 
User Name or Full Name as the new User's User Name. 

6.2.2 Full Name 

The Full Name represent the normal name of the user (first name and last name). Even though it is not 
mandatory, but good practice to fill in the User's Full Name. 
Note that the Full name must be unique within the Project i.e. there must no other User with the same User 
Name or Full Name as the new User's Full name. 

6.2.3 Email 

The Email address is used when Aligned Elements sends emails when e.g. when getting invited or 
reminded about participation in a Signature or Review, when an email is sent out as part of a workflow or 
when changes occurs to a Favourite Document Object to which the user has signed up to be notified when 
changed. 
Note that emails can only be sent by Aligned Elements is the email smtp settings have been set up properly. 

6.2.4 Windows Domain 

The Windows Domain is optionally used when configuring Aligned Elements to allow users to sign in with 
their Windows Passwords.  

6.2.5 E-Certificate 

The E-Certificate option is necessary when the user wants to sign files/documents electronically using a 
digital certificate. 

6.2.6 Disabled 

In Aligned Elements, a user cannot be deleted or removed. However, disabling a user prevents him/her to 
access the system. A user is disabled, either explicitly by another user (ticking the Disabled box and save), 
or automatically when having tried to sign in using incorrect credentials more than three times.  
Note that a User cannot disable himself or reset his own password. 

6.2.7 Password State 

A user must belong to one or more user groups. A user group defines the permissions/rights with regard to 
the available document object types. 
 
When a new user is added, the initial default password is the same as the user name and has to be 
changed after the first login within 5 days of the user creation. The password state is now Pending. If the 
initial login happens within 5 days, the state will change to OK and all is well. If more than 5 days pass until 
the user logs in the first time, the log in will not be accepted and the user’s password state will be marked 
as “Expired”. To allow the user to log in again, an administrator with User Management rights have to 
Reset the password to its default value i.e. the user name.  

6.2.8 Reset Password 

If a user does not remember his password, another user can reset that user's password which means that 
the password is equal to the user name. The next time the user logs in, he/she must select a new 
password.  
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6.2.9 Last Log-in Time 

This reports the last known login time for the user. 

6.2.10 Dashboard 

With this option, a user manager can select a default Dashboard to be displayed to the user when he 
opens the project. If selected, that user cannot select any other Dashboard. 

6.2.11 Tag 

If an existing Tag has been selected with this option, the user in question will only be able to access objects 
within that Tag. Document Objects created by that user will automatically be added to the Tag. 

6.2.12 User Groups 

A user must belong to one or more User Groups. The aggregated rights when belonging to several User 
Groups are the combined positive rights. 
When completed, click Save to save the changes. Alternative click Cancel to cancel the action. 
 
If a user has forgotten the password or failed to log in correctly more than three times, the administrator 
can Reset the password to its default value i.e. the user name. 
 
New users are optionally notified via email about having received a user in a project (provided that Email 
settings have been set up). 
 
Note! User names and Full names need to be unique to each user. A user may not have a User name that is 
a User name or Full name by another user. 
 

6.2.13 Assigning electronic certificates to user 

The Column “E-certificate” provides the possibility to add a certificate (for digital signatures). Click the 
Assign link to upload the user’s electronic certificate. In conjunction with uploading the certificate, the 
password of the certificate has to be added. 
  

 
 

6.2.14 Copying users to other projects 

To copy new or existing users to other projects, tick the check box Copy users to other projects in order to 
display the Copy column in the User Form. 
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Select the users to copy and click OK. 
  
Optionally, select to overwrite/amend information to existing users if found in the target project(s). 
  
Then select the target project(s) in which to copy the selected users. 
  
Note! If you have made changes to users in the User Form, the changes are applied to the users before the 
copy action takes place. 
  
Note! The current logged in user must have User Management privileges in the target project(s) in order for 
the copy to function. 
  
If the User does not exist in the target project(s), a new User with the corresponding user data is created. 
For the new user, the default password will be the same as the user name. 
  
If a User with the same name as the copied user exists in the target project(s), the Full name, Email, 
Windows domain and user groups (provided that they exist) are copied to the user in the target project. 
  
Disabled users cannot be copied. 
  
Passwords are never copied. Password reset does not apply to copied users. 
  
If a user group associated with the copied user exists by name in the target project(s), the user will be 
automatically be associated with that user group. 
  
If a user group associated with the copied user does not exist by name in the target project(s), that user 
group association will not be recreated in the target project. 
  
If the user exists in the target project(s), copied user group associations are only added to the target user, 
user groups are never removed as a result of the copy action. 
  
Note! If no user groups can be associated with the copied user in the target project(s), the user will not be 
created in the target project(s). 
 

6.2.15 Assigning Dashboard to User 

The following only applies in conjunction with the Aligned Elements Web Client: by default, no Dashboard 
is displayed when a user creates a project or is invited to a project. The user can select his/hers own 
Dashboard.  
However, in some situations, e.g. when working with external partners, it can be helpful to assign a 
Dashboard containing work instructions and assistive information to such a user. Use the drop down in the 
User Management dialog to assign a Dashboard to a user.  
 
Note that a user to which a Dashboard has been assigned, cannot select a different Dashboard later.  
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6.2.16 Assigning Tag to User 

When working with external partners, it can be desirable to apply restricted access to the Project content. 
By assigning a Tag to a User, that user has access to the objects in the Tag but no other objects. 
 

6.2.17 User Group Management 

To edit the user groups select the menu User Management->Manage User Groups. In the user group 
dialog, you can add new user groups and also adapt the permissions/rights for each type of document 
object.  
 

 
The rights for a user group listed per document object type 
 
Use the Restrict button to the right to restrict a user group from editing a particular attribute or selecting a 
particular enumeration value for an enum attribute. 
 
Click on the column names to tick or un-tick all checkboxes in a column. 
Click on a type name to tick or un-tick all checkboxes in a row. 
 

6.2.17.1 Type Rights vs. General Rights 

In the left side of the Dialog, access rights can be set on Document object type level. 
On the right side, access to functions in Aligned Elements can be restricted, i.e. if Chapter Management 
rights are removed from a User Group, members of that User Group cannot add, remove, rename, move or 
reorder Chapters (of any type). 
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6.2.18 Using Windows password as alternative login 

It is possible to alternatively use your windows password for login. This can be especially useful if you are 
simultaneously active in a large number of projects and are forced to keep track of many different 
passwords. To enable the Windows login the following conditions needs to be satisfied: 
 
The Aligned Elements user name needs to be identical to the Windows user name. 
 
The global project setting “Allow Windows Logon” needs to be activated. 
 

 

 

The Aligned Elements user needs to define the windows domain in which the windows user is 
active. This is done in the User Management dialog. 

6.2.19 Rename a User Group 

A user group can be renamed to a non-existing name. The rename takes effect at the next log in. 

6.2.20 Remove a User Group 

A user group can be removed if no Users belong to it. To remove a User Group, make sure no users belong 
to the group and then click Remove to remove the group. 

6.2.21 Export Users 

It is possible to export the user information to file. Click User Management -> Export -> Users and select 
and output directory. A file with the name Users@<ProjectName>.urs is created containing all the user 
information except the password about the users in the project. This file can later be imported in different 
project. 
 
Note! Passwords, user certificates, certificate passwords (for electronic signatures) and Proxy Users (users 
for Trac and Jira) are not exported. 
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6.2.22 Export User Groups 

It is possible to export the user groups to file. Click User Management -> Export -> User Group and select 
an output directory. One file per user group with the naming convention 
UserGroup@<ProjectName>@<UserGroupName>.urg is created containing the user group definition. 
These files can later be imported in different project. 
 

6.2.23 Import Users 

To import users, click User Management -> Import -> Users and select a valid .urs file.  
 
For each user listed in the file, you will be asked if you want to import it.  
 
The initial password for a created imported user is set the user name (just like when you create a user) and 
has to be changed at first login.  
 
If a user with the same user name already exists, you will be asked if that user shall be overwritten with the 
data in the file. The existing password for such a user is not altered. 
 
If a user group associated with the imported user does not exist in the target project, that user group 
association is deleted after import. 
 
For existing users, all user groups are removed from the existing user in the target project and the user 
groups defined in the import file are added to the user. If this results in the user having no user groups, 
then the import action for that particular user is skipped in its entirety. 

6.2.24 Import User Groups 

To import user groups, click User Management -> Import -> User Groups and select one or more valid .urg 
files.  
 
If a user group with the same name already exists, you will be asked if that user group shall be overwritten 
with the data in the file.  
 
If an imported user group contains User Rights associated with Document Object Types that does not exist 
in the target project, those User Rights will not be imported. 
 
If an imported user group lacks User Rights associated with Document Object Types that exist in the target 
project but did not exist in the source project, those User Rights will be added with maximum permission. 
 

6.3 Defining Regulatory Wizards 

Creating Wizards is done in a separate application. Contact Aligned Elements support team to get access to 
this application. 
 
To define a wizard, please start with setting the wizard directory Wizard -> Set Wizard Directory to a 
location which all users of the wizards can reach. All created wizards will be stored there. 
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The wizard designer offers a number of building blocks referred to as Wizard steps. Wizard steps are 
placed on the canvas by dragging them from the right hand side onto the drawing canvas with the mouse: 

 
Drag steps onto the canvas 
 
The steps can be connected by selecting 2 steps and pressing the right mouse button: 
 

 
Connect Wizards Steps 
 
Steps or connectors can be deleted by selecting them with the mouse and pressing delete. 
 
The following Wizard steps are available: 

▪ Start - Defines the start of the wizard. Is required in all wizards. 

 

▪ End - Defines the end of the wizard. Is required in all wizards. 

 

▪ Ask a question - Ask the user a question. As a result different paths in the wizard are taken. 

 

▪ Set a Variable - Ask the user for information and store this in a named variable. 

 

▪ Query for Multiple Items - Same as Set a Variable but allows multiple answers from the user. 
These answers can be iterated through with the help of Start of iteration/End of iteration. 

 

▪ Create Document Objects - Create document objects of a certain type. The document object text 
(Title) may contain the value of a variable from e.g. Set a Variable or Query for Multiple Items. 

 

▪ Select Objects - This step is intended for Regulatory Wizards created for audits and allows the 
user to drag document objects from the existing project to prove objective evidence for the 
Question made in the step. 
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▪ Start of Iteration  The step starts an iteration over a list of entries 

 

▪ End of Iteration - The step marks the end of an iteration loop. 

 
As an example on how they can be used, we will look at the Demo Wizard: 
 

 
 

1. The Start step initiates the wizard and provides some introduction text to the user. 
 
 

2. In Set a Variable the user is asked to provide a system definition, the response is stored in a the 
variable {system}: 
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3. In Query for Multiple Objects. The system is asked for possible records that are used by the system. 
The result is stored in the variable {records}. 
 

Note: 
The variable {system} can be embedded in the question.  

All available variables are listed in the bottom left combo box. Select one and click on  to insert them in a 
text field. 
 

4. A loop is started with Start of Iteration. The wizard will iterate through the entries in the list 
{records}. The current value of the list is passed to the variable {record} and can be used within the 
iteration. 

 

 
 

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  168 / 269 

5. In Ask a Question, the user may select between 3 choices. 
 

 
 

6. Depending on the choice of the user, 3 different paths may be entered. We will follow the path 
“Yes”. This leads us to the step Create Document Objects which for each record will create a 
Document Object of Type Requirement. 

 

 
 

7. When done, the iteration will start from the beginning for the next value of {record} until all items 
in the list {records} have been handled. 

 
8. When all {records} have been handled, the wizard reaches the step End which displays some 

information to the user and ends the execution of the wizard. 
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The step Select Objects (which was not part of the demo wizard) could be used within a similar flow to ask 
the user to point to existing Document Objects which are objective evidence for the question of the step. 
 

6.4 User Settings 

Start with: 
1. Log Settings, The default is to use the log level INFO and to NOT log database interaction. Changing 

these options will have a considerable impact on performance but can sometimes be requested by 
your Aligned representative on product support matters. 

 

 
 

2. Email Settings, Settings to send mail to get support. Either your Microsoft Outlook mail client is 
used or you may mail directly from Aligned Elements in which case you have to configure the SMTP 
settings. User and password only has to be entered if your mail server requires authentication. The 
SMTP Server is a name on the form mail.yourcompany.com.  

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  170 / 269 

 

 
 

3. Auto Recovers, Activating auto-recovery of Document Objects implies that an intermediate data file 
is regularly stored for Document Objects that are opened in a Document Object Form.  

 

 
 
If Aligned Elements should crash, these recovery files are displayed at startup 
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The first entry indicates a specification that was created and modified but never saved and therefore has 
no assigned ID. When this specification gets recovered, it is assigned a new ID. 
 
The second entry indicates a specification with the ID PS 1 rev 1. When this specification is recovered it is 
assigned the same ID but a new revision. 
 
The user has the option to recover the last stored changes from these recovery files. Note that only 
attribute data is recovered (not traces). 
 

4. Elements Link Settings, The visible text of the links created using drag and drop can be configured 
using these settings. 
 

 
 

5. Server Hints, Server hints are used for setups using particular server SQL Server Settings such as 
server password and communication ports. Server hint files can be created by the Aligned Support 
Team. For questions, contact support@aligned.ch 
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6.5 Project Settings 

The project settings contain common settings for the project which might change over the project 
duration: 
 

6.5.1 Risk Management Settings 

Risk Management Settings displays the RPN threshold for all risks. This threshold is defined in the 
associated risk rvt template (e.g. in the FailureMode.rvt file).  
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6.5.2 Security Settings 

Password Expires After # Days  
Defines when the password expires due to password aging when the user has to select a new password. 
Max length: 365 days. Default: 90 days. 
 
Warn if Password Expires in # Days 
Informs the user that the password is about to expire. Default: 10 days. 
 
Allow Windows Logon 
If selected, checks the entered login credentials against the current Active Directory. Only applies to user 
which have an Aligned Elements user name identical to their Windows user names. 
 
Allow Automatic Change Comment 
If selected, the value in the Automatic Change Comment will be automatically applied as Change Comment 
when saving an updated Document Object without displaying the Gap Form.  
This option is active for all modifications actions except when performing Update Multiple Items and is 
active for all users in the project.  
 
Automatic Change Comment 
The Automatic Change Comment applied as Change Comment, if this feature is active. 
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6.5.3 Paths  

Project specific path to the Project Templates (see 6.7). 
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6.5.4 Trace Options 
 

Automatically update linked traces to Latest Revision 
Applies to traces between projects. Automatically updates traces between parent objects in other projects 
and modified child object when child object is committed. 
 
Necessary perquisite is that traces between parent and child objects are to latest revisions ("most current") 
before modification takes place. 
 
Suspect Traces are only Cleared Manually 
Overrides the default behaviour of automatic clearing of the suspect trace state when the child object in 
the suspect trace relationship is updated. 
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6.5.5 Project Phases 

Setting up and modifying Project Phases. 
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In order to compare the status of a concrete deliverable and the status that the QMS specifies for a certain 
Project Phase, Aligned Elements needs information about 
 

▪ The name and the order of the Project Phases according to the QMS. 

▪ The name of the current Project Phase. 

 
Add the names of the Project Phases according to your QMS and arrange the phases in falling order. 
 
Use the check box to declare the current Project Phase. 
 

6.5.6 Smtp Mail 
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The values are applied as: 
 

▪ Host – The smtp server address (e.g. smtp.gmail.com) 

▪ User – An email address that has an account on the server  

▪ Password –  The password matching the User 

▪ Sender – The name you want to appear as sender in the email 

▪ Port – The port used (e.g. 465 for SSL) 

▪ Use SSL – check if SSL / TSL shall be used 

 
Use the Test button to check if an email can be sent. 
 

6.5.7 Signature Preferences 

These settings define which signature mode to use and where on a PDF the signatures should be placed. 
Note! The settings apply to all PDF:s in the project. 
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▪ Mode  - Use Electronic Certificates or No Certificates 

▪ Start Page – On which page to place the signature relative the “from”-setting: 

o From Beginning 

o From End 

o Create Page From Beginning – an additional page is created for signatures 

o Create Page From End - an additional page is created for signatures 

▪ Sign Direction – The direction in which subsequent signatures are placed on the page. 

▪ Position – The Lower Left X and Y position (in pixels) of the first signature. 

▪ Height – The height of a signature box on the page. 

▪ Width – The Width of a signature box on the page. 

▪ Gap – the horizontal and vertical gap between signature boxes. 

▪ Add Document Info – Adds information on the Document being signed to the signature page, 
includes: 

o File Name 

o File Object ID 

o Signature Object ID 
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o Reason for signature (from Signature Object) 

▪ The Document Info is always placed 100px from the top of the page and 30 px from the page left 
and right boarder, stretching across the page. The Document Info box height is 100px. 

▪ Use Version – Optionally include the Aligned Elements File Version in the Document Info. 

 

For NoCertificate mode, the following options can be included in the signature stamp: 

▪ Use Location – optionally include Location information. 

▪ Use Reason – optionally include the Reason in each signature. 

▪ Use Comment – optionally include the Comment in each signature. 

▪ Show Time in Stamp – include exact signature time and timezone offset. Note that the Assigned 
User Table Attribute must contain a DateTimeColumn for this option to work. 

▪ Use Small Font – writes the signature information in smaller font to allow more signatures to fit 
on a single page. 

 

Note! The combination of signature preferences and the configuration of the Signature.rvt file must be 
aligned. Ask your Aligned representative for advise on this matter if necessary.  
 
Use the <Test> button to create a PDF page displaying the signature layout using the current settings. 
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6.5.8 Dynamic List Attributes 

If Dynamic List Attributes are configured in the template set, they are listed in the left list. Click on 
an item to display the current dynamic item values. Add or remove items to adapt the list. 
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Note! A list of Dynamic List Attribute items may contain an empty string but may not include duplicates. 
 
Note! Standard items for Dynamic List Attributes can be defined in the templates. These standard items are 
not displayed here.   
 
Note! The Dynamic List Attribute can be configured to allow users to add new values on the fly in the 
Document Object form. 

 

6.5.9 Export / Import of Project Settings 

The Project Settings can be exported and later imported into a different project. This is especially handy 
when distributing company-wide SMTP Settings and Signature Preferences.  
When importing the exported Project Settings xml file in a different project, the following parameters are 
ignored: 
 

▪ Project Name 

▪ Project Creation Date 

▪ Project Version 

▪ Current Project Phase 

▪ Any information about linked projects 
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Note! You can modify and trim the exported xml file to only contain the parameters you want to be 
imported. Since this feature can have significant consequences on your project, treat it with considerable 
consideration. 

6.6 Unlocking Objects 

As long as a document object is displayed in a Document Object Form, it is locked by the user that is 
currently modifying it. The document object is unlocked when the user either cancels the Document Object 
Form or commits the object. There exist occasions when document objects may remain locked, e.g. after a 
computer crash. The Unlock Objects function under the Project Menu offers a possibility to release 
individual locks on selected objects. 
 

 
 
Note! Unlocking an object that a user is currently working on may result in an exception when the user tries 
to commit the locked object. Therefore, make sure that the document objects you unlock are not currently 
used by any user. 
 

6.7 Setting up Project Templates 

The project templates is a set of files that define the an Aligned Elements configuration. The templates 
defines the number and name of your Design Control Items, how they shall look and behave and much 
more. 
 
Upon project creation, an important step is to refer to the location of the template files. This means that 
all clients need (read-)access to the templates and therefore also the template location. The most common 
location for the templates are somewhere on the company’s network. 
 
There exist two sets of project templates: 
 

▪ Definition of document object types including their attributes. These are xml files with the file 
extension .rvt. These files also contain the definition of the rules used to determine if any 
inconsistencies exist.  

▪ Document templates used for the Microsoft Word integration. These files define how a 
Document Object is displayed and formatted in Microsoft Word. The Word templates for the 
trace tables and for the revision history also belong to this set of templates. 
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The following naming convention of the files is used: 
 
For each template for a document object type in the folder \<YourTemplates> the same name exists for 
the Microsoft word templates with the file extension .docx in the folder \<YourTemplates>\RTFTemplates. 
 
The revision history template is called:  
\<YourTemplates>\RTFTemplates\RevisionHistory.xml 
 
Only trace table templates exist in the folder \<YourTemplates>\TraceTemplates 
 

6.7.1 Project Templates in Azure File Storage 

For distributed scenarios, it might make sense to place the templates somewhere outside the company 
network on a location which every project member can reach. To accommodate for such situations, 
Aligned Elements supports storing templates on an Azure File Storage in the Cloud. 
 
To designate a location in an Azure File Storage, you need to supply two pieces of information: 

1) The path to the templates on the form “<file storage name>\<any subfolder>” 
2) The Storage Connection String 

 

 
 
To enter this information during project creation, click Cancel in the “Browse to Template” dialog. You will 
then be asked if you want to designate an Azure File Storage location. Click “Yes” and supply this 
information in the following dialog. 
 

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  185 / 269 

The entered information is later available in the Project Settings / Path Tab page. If you want to 
redesignate a projects template path from a regular file server location on a local network to an Azure File 
Storage, use the Project Settings / Paths tab to enter the information described above.  
 
For easy manipulation, upload and download of files on an Azure File Storage, we recommend 
downloading and installing the “Microsoft Azure Storage Explorer”. 
 

6.7.1.1 Using Compressed Template Files on an Azure File Storage 

 
When Aligned Elements open a project and accesses the templates on an Azure File Storage, this might 
give a slower opening experience than when the templates are located on a local network. To speed up 
this process, you can optionally zip all template files and place it in a file called “CacheRVT.zip” in the 
template root location.  
 
Note that you can either replace all templates with this one zipped file or place it parallel to the files that 
you just placed in the zip. In the latter case, Aligned Elements will use the zip file as long as there is no 
other template file that has a modification date later than the creation date of the zip file. 
 

6.7.2 Changing templates for an existing project 

Template changes are only detected at project load. If any modifications are detected, Aligned Elements 
will automatically update the document objects to match the new template changes, e.g. remove an 
attribute or add a column in a table. This will result in a new revision for all affected document objects. 
During this process the project may only be loaded by one single user and this user must have Project 
Administration rights. 
 

6.7.3 Defining Document Object Types 

You can configure the following items: 
 

▪ Attributes 

▪ Allow to generate other document objects from this object 

▪ Allow to execute e.g. Test Cases. 

▪ Validation rules to show any inconsistencies  

 
Note: For a full xml schema of all possible configurations, please contact support@aligned.ch. 
 
Here are some examples for different types of attributes: 
 

▪ String attribute: 
<StringAttribute Name="Description" DefaultText="None"/> 

▪ Rich Text attribute: 
<RichTextAttribute Name="Description" ValueIfEmpty="Intentionally Left Blank"/> 
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▪ Integer Range attribute: 
<IntRangeAttribute Name="Priority" MinValue="1" MaxValue="10"/> 

▪ Enumeration attribute: 
<EnumAttribute Name="Priority" > 

        <Items DefaultItem="Low"> 

          <Item>High</Item> 

          <Item>Middle</Item> 

          <Item>Low</Item> 

        </Items> 

</EnumAttribute> 

 

▪ User Enumeration attribute: 
<EnumUserAttribute Name="AssignedToUser" SetCurrentUserAsDefault="true"/> 

▪ Multiselect attribute: 
<MultiSelectAttribute Name="Multi"> 

      <Items> 

        <Item value="One" selected="true"/> 

        <Item value="Two" selected="false"/> 

        <Item value="Two and a half" selected="false"/> 

      </Items> 

    </MultiSelectAttribute> 

 

▪ Array Attribute: 
<ArrayAttribute Name="ObjectsInFile" /> 

▪ File attribute: 
<FileAttribute Name="File" /> 

▪ Date Time attribute: 
<DateTimeAttribute Name="DueDate" ShowTime="false" /> 

▪ Dynamic List attribute: 

    <DynamicListAttribute Name="Item" UserCanAdd="true"> 

      <Items DefaultItem="Machine"> 

        <Item value="Machine"/> 

        <Item value="Tool"/> 

        <Item value="Instrument"/> 

      </Items> 
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    </DynamicListAttribute> 

 

▪ Traced Object Attribute 

The Traced Object Attribute displays traced object information in a table. This attribute is only 
supported by the Web Client. 

The definition looks like: 

<TracedObjectsAttribute Name="Dependent Requirements"> 
      <TracedType TypeName="Design Input Requirement" TraceDirection="Outgoing" CanCreate="true"> 
        <DisplayedAttribute Name="Title"/> 
        <DisplayedAttribute Name="Description"/> 
      </TracedType> 

</TracedObjectsAttribute> 

▪ Table attribute: 

 

<TableAttribute Name="Column Variants" ContainsRichText="true"  ValueIfEmpty ="-"> 

      <Columns> 
        <Column Template="Arial10.rtf" ReadOnly="true">My Text</Column> 
        <CheckBoxColumn Name="CheckBoxColumn" ColumnFixedWidth="50"/> 
        <DateTimeColumn Name="DateTimeColumn"/> 
        <UserEnumColumn Name="UserEnumColumn"/> 
        <EnumColumn Name="Number"> 
          <EnumItem Value="One" IsDefault="false"/> 
          <EnumItem Value="Two" IsDefault="true"/> 
          <EnumItem Value="Three" IsDefault="false"/> 
        </EnumColumn> 
        <MultiSelectColumn Name="Colors"> 
          <MultiSelectItem Value="Blue"/> 
          <MultiSelectItem Value="Red"/> 
          <MultiSelectItem Value="Green"/> 
        </MultiSelectColumn> 
        <IncomingTracesColumn Name="References" IncludeTitle="true"> 
          <AllowedTraceType TypeName="Requirement"/> 
        </IncomingTracesColumn> 
        <MixedTracesColumn Name="Incoming and Outgoing Traces"/> 
        <OutgoingTracesColumn Name="Issues"> 
          <AllowedTraceType TypeName="Issue"/> 
        </OutgoingTracesColumn> 
      </Columns> 

</TableAttribute> 

Attributes are displayed in the Document Object Form (see 2.6) in the order they appear in the 
template file. The Document Object Form has a fixed number of columns (8) and a flexible number 
of rows. When all columns are full for a row, the attribute will be placed on the next row. The row 
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has the height of the highest control within the row. You may use the following settings for any type 
of attribute to control the layout: 

▪ ColumnSpan  - a value between 1 – 8, where 8 is the full with of the document object form 

▪ CanGrow - can be true or false and if true, the control will adapt to display the full content. If 
false, a scroll bar will appear to allow the user to see the full content. 

▪ Height  - the height of the control in pixels. A normal 1 row text box is usually 45 pixels high. 

▪ TopPadding - space above the control in pixels 

▪ BottomPadding - space below the control in pixels 

▪ LeftPadding - space left of the control in pixels 
RightPadding - space right of the control in pixels 

An example for 3 string attributes could be: 
<StringAttribute Name="Description" ColumnSpan="3" CanGrow="true" Height="90"/> 
 
<StringAttribute Name="Name" ColumnSpan="2" CanGrow="false" Height="45" TopPadding="4" 
BottomPadding="4" LeftPadding="10" RightPadding="10"/> 
 
<StringAttribute Name="Comment" ColumnSpan="6" CanGrow="false" Height="90"/> 
 
This would result in 2 rows where Description and Name are placed on one row with the nominal height 90 
(the row height could grow). Name has some padding to be positioned more in the middle. On the second 
row Comment would be placed in the first 6 columns: 
 

Description 
 

    

Comment 
 

  

 
You can optionally define a default value that is automatically added to empty fields (ValueIfEmpty) at 
Document Object creation. This is useful if you want to ensure that empty fields also in a word document, 
clearly states that they are empty. 
 
For Rich Text Attributes, you can also optionally add a template: 
<Template>MyRtfTemplate.rtf</Template> 
 
And equivalent for Table columns: 
<Column Template="MyRtfTemplate.rtf">Stimuli</Column> 
 
The template is a file which you can create in word and save in the rich text format (rtf) in the same 
directory as your project templates. It allows you to e.g. set the default font for newly created attributes of 
this sort or to provide some default text in the field. 
 
For Enum Attributes you may also define workflows by configuring the valid transitions between the values 
e.g.: 
<EnumAttribute Name="Status"> 

Name 
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  <Items DefaultItem="Open"> 
    <Item value="Open"/> 
    <Item value ="Duplicate"/> 
    <Item value ="Misunderstood"/> 
    <Item value ="Closed"/> 
  </Items> 
  <Workflow>  
    <Transition Value="Open" NextValue ="Duplicate"> 
          <Conditions> 
            <TracedToRule ToTraceTypeName="Requirement"/> 
     </Conditions> 
    </Transition> 
    <Transition Value="Open" NextValue ="Misunderstood"/> 
    <Transition Value="Open" NextValue ="Closed"> 
          <Action Action="Sign"/> 
          <Action Action="Email" ActionDataId="mail123"/> 
     </Transition>     
     <Transition Value="Duplicate" NextValue ="Open"/> 
    <Transition Value="Misunderstood" NextValue ="Open"/> 
    <Transition Value="Closed" NextValue ="Open"/> 
    <ActionDatas> 
          <EmailData Id="mail123" NotifyUsersInAttribute="AssignedTo"> 
            <UserGroupToNotify>Administrator</UserGroupToNotify> 
            <UserGroupToNotify>Tester</UserGroupToNotify> 
          </EmailData> 
        </ActionDatas> 
  </Workflow> 
</EnumAttribute> 
 
There are a number of workflow options available: 
 

▪ Consistency validation- Use this conditions to validate inconsistencies as part of the transition. If 
the inconsistencies are found, then the user is not allowed to make the transition change.  

▪ Invalidation/Reset – Resets a state (defined as an attribute) if an attribute is changed.  

▪ Signatures - Generates an electronic signature round when a transition takes place to formally 
sign-off on the transition (see section 3.17). 

▪ Send Emails - Send an automatic email when a transition takes place to designated stake holders 
(User Groups) to keep them informed on the change that just happened. The email will contain a 
hyper link to the current Document Object.  

▪ Set Attribute - Allows to set an attribute to a value as a result of the workflow transition. If the 
attribute type is a date-time attribute, the value will default to the time “now”.   

▪ Generate Document Object – Automatically generates a specified item from the source item. 

▪ Copy file objects to an external location - Copies the contained file of a file attribute (if existing) 
to an external location on the network e.g. for DMS processing. 
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o Here the most common options for the copy file action are explained: 

▪ Target Directory, where to place the file outside of Aligned Elements 

▪ Convert To PDF, most file types can be converted to PDF. 

▪ Log-File, a log file common to all users can be enabled, typically in the target directory  

▪ Copy File Strategy, how the file copy will be named: 

• No => No Strategy, copy keeps the same name as the original file, but do not overwrite 
any existing file with the same name 

• No Overwrite => Same as No, but overwrites any existing files if found in the target 
directory with the same name as the original file 

▪ IDDir  => Create a subdirectory in the target directory named after the file object ID and 
revision and copy the file there. File name is the same the original file name. 

▪ Index => append a numeric index to the file name to make it unique 

▪ Create Unique Folder on Error, if something goes wrong after all retries, one last attempt is 
to copy the file using the IDDir strategy. 

▪ Meta-Data Template File, additional information about the file can also be exported. This 
will be included into a metadata file on the form of the configured template. The file must 
exist in the template directory 

▪ Re-Create Folder Structure, if true, the chapter structure in the file explorer will be re-
created in the target Directory and the files copied into their respective location. This way 
the File explorer can be mirrored in the target directory 

▪ PlaceCopyInProjectFolder, if true, an additional folder with the project name is created (if 
not existent) in the destination path. 

▪ PlaceCopyInTypeNameFolder, if true, an additional folder with the type name (of the 
Document Object) is created (if not existent) in the destination path. If 
PlaceCopyInProjectFolder is also true, then the typename folder is placed in the project 
folder. 

▪ Start an external process that optionally can process Aligned Elements data output. Note that 
Aligned Elements does not wait for the process to complete or react to the process execution 
result. 

o The options for starting an external process are: 

▪ ProcessPath, the path to the executable to start. 

▪ Arguments, The arguments to pass at process start. The argument string can contain 
placeholders to pass data (always passed as a string). 

•  To pass attribute data, e.g. the Description, write {attr.Description}. File attributes are 
written to a physical location (see ExportPath) and the arguments will be replaced with 
the full path. 

• To pass user data, write {user.UserName}, {user.FullName}, {user.Email}. 
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• To pass document object data, {do.Title}, {do.Disabled}, {do.ID}, {do.IDRev}, 
{do.Project}, {do.ParentChapter}, {do.Revision}, {do.ElementsLink}, 
{do.ElementsWebLink}. 

• To pass the document object as an export file, {export}. The argument will be replaced 
with the physical location of the export file (see ExportPath) 

▪ ExportPath, the path to which Files are written e.g. in File attributes or fully Exported 
Document Object. 

▪ ExportTransformation, optional xml transformation in xslt when performing an export of a 
Document Object. 

▪ Lock Document Object – This Action locks the Document Object itself, or document objects 
defined in the objects IDArrayAttributes.  

o The following options are available for the Lock Objects action: 

▪ The Lock Reason – is displayed to the user when he tries to edit the locked object. The 
Lock Reason can dynamically replace the following parameters with its corresponding data 
value: 

•             {ID} 

•             {IDRev} 

•             {IDNoProject} 

•             {IDRevNoProject} 

•             {TypeName} 

•             {Title} 

•             {RevisionNr} 

•             {RevisionDate} 

•             {RevisionComment} 

▪ IDArrayAttributeNames – File Objects and Review Objects use IDArrayAttributes to define 
object collections on which they operate. As an alternative to lock the object itself, the 
Lock Action can lock the items defined in these IDArrayAttributeNames. 

▪ Unlock Document Objects – This Action is similar to the Lock action. The optional ID Array 
Attribute parameters works as in the Lock Action. The Reason parameter is used to unlock the 
items (in the set) that have a Lock Reason that contains (i.e. not identical to) the Reason defined 
in the unlock action. 

 
In a similar way, a transition may be triggered by other modifications to the document object. This 
behaviour can be achieved through e.g. Dependent Transitions. The transition is controlled by a condition. 
Here an example from the File template: 
 
<Attributes> 
    <StringAttribute Name="Description" /> 
    <FileAttribute Name="File"/> 
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    <ArrayAttribute Name="ObjectsInFile" Alias="Objects In File"/> 
    <ArrayAttribute Name="FrozenObjectsInFile" Alias="Frozen Objects In File"/> 
    <EnumAttribute Name="Validity" > 
      <Items DefaultItem="Draft"> 
        <Item>Draft</Item> 
        <Item>Released</Item> 
      </Items> 
      <Workflow> 
        <DependentTransition Value="Released" SetValue="Draft"> 
          <Condition AttributeName="File" Operator="AttributeChangedAnd" /> 
        </DependentTransition> 
        <Transition Value="Draft" NextValue ="Released" Action="Sign"/> 
        <Transition Value="Released" NextValue ="Draft"/> 
      </Workflow> 
    </EnumAttribute> 
  </Attributes> 
  
The attribute Validity will automatically be set to Draft if the File Attribute ‘File’ is modified (but not if e.g. 
the Title is changed).  
 
Below is an additional example for a test case result which sets the overall test result based on entries in 
the table ‘TestInstructions’ which has a column with checkboxes called ‘Passed’: 
 
<EnumAttribute Name="Result" ReadOnly="true" ColumnSpan="1"> 

      <Items DefaultItem="NotExecuted"> 

        <Item>NotExecuted</Item> 

        <Item>Failed</Item> 

        <Item>Passed</Item> 

      </Items> 

      <Workflow> 

        <DependentTransition Value="" SetValue="Passed"> 

          <Condition AttributeName="TestInstructions" Column="Passed" Operator="All" Ma

tchValue="True"/> 

        </DependentTransition> 

        <DependentTransition Value="" SetValue="Failed"> 

          <Condition AttributeName="TestInstructions" Column="Passed" Operator="AtLeast

One" MatchValue="False"/> 

        </DependentTransition> 

      </Workflow> 

</EnumAttribute> 

 
The Workflows can be configured to return a user defined message to notify the user that the workflow 
action has been / is being performed. 

6.7.4 Attribute modification in Templates 

If you change add, remove or rename any attributes for an existing project, you will be asked if you want to 
update all affected objects during the loading of the project. If the change is intentional, respond yes, 
otherwise no and revert your changes to the template (to avoid the same question the next time you load 
the project). 
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If you responded yes for all affected document objects of this type a new revision will be created 
containing the modified attributes in the following manner: 

▪ If an attribute is removed, the attribute will be removed from the new revision. 

▪ If an attribute is added, it will also be added to the new revision. 

▪ If a table attribute receives a change to the columns, the new revision will receive this change as 
well. 

 
It is important to understand that old revisions are not affected of a template change (you will see the 
difference when you compare revisions)! 

6.7.5 Configuring Chapter Descriptions 

Note! This feature is only available in the Aligned Elements Web Client. 
To activate the chapter description feature, set the web.config parameter: 
    <add key="useChapterDescription" value="true" /> 
 

The font definition used in the Chapter Description is similar to RichText and Table attributes, i.e. a rtf file 
is referenced. Therefore, in each .rvt template, define the font of the chapter description in the Type Info 
tag such as: 
  <TypeInfo TypeName="User Need" Prefix="UN" IsVisibleBook="true" DisplayOrder="5"> 
    <Category Name="Design Input" Order="0" Color="#1bade8"/> 
    <ChapterTemplate>Calibri11.rtf</ChapterTemplate> 
  </TypeInfo> 
 
Furthermore, update all Chapter docx templates to include a tag for the chapter name as well as for the 
description such as: 

 
 

6.7.6 Configuring Validation Rules 

In the template for the Document Object Type you can also define the possible validation rules that should 
apply to the object. The available rules and their parameters are: 
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The ”Traced to” - rule enforces the relationship between the parent object and at least one child object. 
E.g. A requirement should have at least one trace to a specification: 
<TracedToRule ToTraceTypeName="Specification"/> 
 
The ”Traced from” - rule enforces the relationship between a child object and at least one parent object of 
a given type. E.g. A specification should have at least one trace from a requirement: 
<TracedFromRule FromTraceTypeName="Requirement"/> 
 
The ”Illegal Trace”- rule signalizes if there exists a forbidden relationship between the parent object and at 
least one child object. E.g. A requirement may not trace to a test case: 
<IllegalTraceToRule IllegalTraceToTypeName="TestCase"/> 
 
The ”Illegal Trace From”- rule signalizes if there exists a forbidden incoof a given typeming tracefrom a 
parent object and at least one child object. E.g. A requirement may not trace from another Requirement: 
<IllegalTraceFromRule IllegalTraceFromTypeName="Requirement"/> 
 
The ”Obsolete Linked Trace”- rule signalizes if there exists a trace to linked object of a non-most-current 
revision.: 
<ObsoleteLinkedTraceRule/> 
 
The “Not Reviewed” - rule enforces that the document object has been reviewed: 
<NotReviewedRule ReviewTypeName="Review"/> 
         
The “Open Issue” - rule checks if there parent object has any still open issues : 
<HasOpenIssueRule TypeNameIssue="Issue" OpenAttributeName="Status"> 
      <ExpectedAttributeValue>Closed</ExpectedAttributeValue> 
      <ExpectedAttributeValue>Duplicate</ExpectedAttributeValue> 
      <ExpectedAttributeValue>Misunderstood</ExpectedAttributeValue> 
</HasOpenIssueRule> 
          
The “Suspect Trace” - rule, decides if the traces to the child objects should be set suspect if the parent 
object is changed to a new revision: 
<SuspectTraceRule/> 
 
Conversly, by applying the “IncomingSuspectTrace”-rule, an inconsistency will be raised of the object have 
an incoming suspect trace from another document object. 
 
    <IncomingSuspectTraceRule> 
      <FromTypeName>Requirement</FromTypeName> 
    </IncomingSuspectTraceRule> 

 
The “Risk Not Mitigated”- rule is implemented in the Failure Mode and checks if the risk probability 
number for the hazard after mitigation is above the treashold: 
<RiskNotMitigatedRule RiskTypeName="Hazard" MitigationTypeName="Mitigation" 
StopAtFirstInconsistency="false" AnyMitigationClearsSeverityInconsistency="true"/> 
 
The “Harm Not Mitigated” - rule, is the equivalent for Risk Anylsis and checks the probaility and severity for 
the combination on the ProbailityOfHarm object before and after measures: 
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<HarmNotMitigatedRule ProbabilityOfHarmTypeName="ProbabilityOfHarm" HarmTypeName="Harm" 
MeasureTypeName="Measure"/> 
The “Consistent Classification” – rule, can be used in systems where a Risk Analysis is used. It checks that 
the Safety classification for e.g. a Sw Item is consistent with the Risk Analysis. For Sw Items with the lowest 
Safety Classification , i.e. ‘A’, there may optionally be a trace to a NoCause to justify that the Item is not 
implying any Harms in the system: 
<HasConsistentClassification AttributeName="SafetyClassification" TypeNameCause="Cause" 
TypeNameRiskAnalysis="RiskAnalysis" TypeNameNoCause="NoCause"> 
      <CheckTracesOfType> 
        <Trace TypeName="SoftwareItem"/> 
        <Trace TypeName="SoftwareUnit"/> 
        <Trace TypeName="SOUP"/> 
      </CheckTracesOfType> 
      <ClassificationMapping> 
        <Classification Value="A" MaxSeverity="1"/> 
        <Classification Value="B" MaxSeverity="3"/> 
        <Classification Value="C" MaxSeverity="5"/> 
      </ClassificationMapping> 
    </HasConsistentClassification> 
 
The “Attribute Value”- rule allows to consider an object inconsitent if an attribute doesn’t hold a certain 
value, e.g. an executed test case was not passed: 
<AttributeValueRule AttributeName="Status"> 
    <ExpectedValue>Closed</ExpectedValue> 
    <ExpectedValue>Duplicate</ExpectedValue> 
    <ExpectedValue>Misunderstood</ExpectedValue> 
</AttributeValueRule> 
 
The “Related Attribute Value”-rule checks that the combination of 2 attribute values in an object are 
consistent. This rule can also be enforced before saving any objects (the user is then prompted with the 
inconsistency). Here an example from a Measure where the type of Measure should match the probability 
reduction: 
<RelatedAttributeValueRule AttributeNameA="Type" AttributeNameB="ProbabilityReduction" 
EvaluateAtCommit="true"> 
      <ValueMap ValueA="Design"> 
        <ValidValue ValueB="4"/> 
      </ValueMap> 
      <ValueMap ValueA="Protective"> 
        <ValidValue ValueB="3"/> 
      </ValueMap> 
      <ValueMap ValueA="Warning"> 
        <ValidValue ValueB="2"/> 
      </ValueMap> 
      <ValueMap ValueA="Information"> 
        <ValidValue ValueB="1"/> 
      </ValueMap> 
    </RelatedAttributeValueRule> 
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To validate if all document objects in a file are up to date (have the most current revision), you can add the 
rule below: 
<ObjectsInFileUpToDateRule AttributeName="ObjectsInFile"/> 
 
To validate if all document objects in a file have been reviewed, you can add this rule. 
<ObjectsInFileNotReviewedRule ConsistentIfReviewIsOpen="false" > 
      <AttributeName>ObjectsInFile</AttributeName> 
      <AttributeName>FrozenObjectsInFile</AttributeName> 
</ObjectsInFileNotReviewedRule> 
 
To ensure that a certain document object type has been added to a file, use the following rule: 
<ObjectInFileRule FileTypeName="File" AttributeName="ObjectsInFile"/> 
 
To ensure that a certain document object is part of a signed file, user the following rule: 
    <ObjectInCompletedSignatureRule FileTypeName="File" SignatureStatusAttributeName="Status" 
SignatureTypeName="Signature" SignatureStatusValueClosed="Closed"> 
      <ArrayAttributeName>ObjectsInFile</ArrayAttributeName> 
    </ObjectInCompletedSignatureRule> 
 
Test Cases can be configured to have the rule: 
<ExecutedFromLastRevision/> 
to ensure that the current revision of the Test Case has been executed. 
 
Test Cases can also be checked for having beeing executed in non-completed Test runs: 
<MissingExecutionInTestRunRule ExecutionTypeName="Test Case Result"/> 
 
The ”Invalid Trace Table”- rule signalizes if a cell in a Table Attribute Column contains the text denoting a 
trace that does not exist for the Document Object: 
<TracedTableColumnRule AttributeName="TestInstructions" ColumnName="Issues"/> 
 
The “Advanced Attribute State”-rule is similar to the “Attribute State”-rule but contain a lot more options. 
For example, the rule can be set up to check that all cells of a column in a Table Attribute actually have a 
value (i.e. are not empty): 
<AdvancedAttributeValueRule> 

<Condition AttributeName="TestInstructions" Column="ActualBehaviour" MatchValue="EMPTY" 
Operator="AtLeastOne"/> 

</AdvancedAttributeValueRule> 
 
To check if a date has been passed or not, use the DueDate rule: 
<DateOverdueRule AttributeName="DueDate" WarnDaysInAdvance="1"/> 
This validation rule is useful in combination with other validation rules which can be linked through the 
usage of the Combine Rule. 
 
To check for existing duplicates of an attribute value, use the Unique Attribute Value rule: 
<UniqueAttributeValueRule TypeName="Requirement" AttributeName="Title"/> 
The rule is case insensitive. This rule is fairly resource instence and can have a limiting effect on 
performance. Therefore, only use this for short string values. 
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Below is an example of a combination of trace rules to ensure that the document object either “has a trace 
to a specification” OR “to a use case”. If one of the rules are fullfilled then no inconsistencies are 
mentioned: 
<CombinedRules Combination="OR"> 
   <TracedToRule ToTraceTypeName="Specification" /> 
   <TracedToRule ToTraceTypeName="UseCase" /> 
</CombinedRules> 
 
It is also possible to create and combine conditional rules. 
<ConditionalRule> 
 <Condition> 
     <AttributeValueRule AttributeName="RequirementType"> 
       <ExpectedValue>Software</ExpectedValue> 

</AttributeValueRule> 
<Condition> 

<EvaluateIfConditionIsMet> 
     <TracedToRule ToTraceTypeName="Specification" /> 
</EvaluateIfConditionIsMet> 
<EvaluateIfConditionIsNotMet> 
  <TracedToRule ToTraceTypeName="TestCase" /> 
<EvaluateIfConditionIsNotMet> 
</ConditionalRule> 
 
The rule above evaluates the AttributeValueRule om the condition clause and then generates 
inconsistencies based the outcome of the condition. If the attribute “RequirementType” has the value 
“Software”, the value rule MissingTrace to specification is evaluated and generates an inconsistency if 
there is no specification trace. If the attribute value is not “Software”, then the MissingTrace to UseCase is 
evaluated. 
 
The conditional rule can use combination rules and nested conditional rules in any of the clauses. 
 
To validate objects based on states of traced objects the following validation rule can be used: 
 
<ValidationOnTracesRule TypeName="Specification"> 
    <RulesToCheck> 
     <TracedToRule ToTraceTypeName="Requirement" /> 

</RulesToCheck> 
</ValidationOnTracesRule> 
 
If the above rule is applied to e.g. the type requirements, a requirement with a trace to a specification with 
a trace back to a requirement would generate an inconsistency for the first requirement. 
 
To validate objects based on states of incoming traced objects the following validation rule can be used: 
 
<ValidationFromTracesRule FromTypeName="Specification"> 
    <RulesToCheck> 
     <TracedToRule ToTraceTypeName="Requirement" /> 

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  198 / 269 

</RulesToCheck> 
</ValidationFromTracesRule> 
 
If the above rule is applied to e.g. the type test case, an incoming traced specification lacking an incoming 
trace from a requirement, would generate an inconsistency. 
 
 
All Inconsistencies can be configured to display a customized text message instead of the default text 
message by using the attribute CustomizedText="My personal message". 
 
The Inconsistencies can be configured to be checked and displayed at commit by setting the attribute 
EvaluateAtCommit="true" which prevents the object from being commited until the inconsistency is 
corrected. 
 
As an alternative, the attribute EvaluateAndWarnAtCommit="true" can be used to notify the user about an 
inconsistency at commit but still permit the user to commit the object.   
 
The RulesID permits you to refer to existing validation rules in other templates using the    
<ValidationRuleReference RuleID="someRuleID"/> 
Note that Rules declared as Conditions in ConditionalRule templates cannot be referred to. 

6.7.6.1 Consistency Coverage parameters in Validation Rule definitions 

 
1) To exclude a validation rule from the consistency calculation, use the ExcludeFromCoverage attribute 
(false by default). 
 
2) To set the coverage weight for a validation rule, use the CoverageWeight attribute to set a weight 
(decimal value). 
 

6.7.7 Special Template Sections 

6.7.7.1 Risk Specific 

The RPN Threshold, the severity limit and the calculation formula (using normal C# syntax) is defined in a 
seprate section below the Compulsory Traces section. For 3 intervals of the RPN threshold, use the 
CodeThreshold section instead of the attribute RPNThreshold. To allow to Display a Risk Summary, add a 
RPNTable definition which describes how Severity, Probability and Visibility should be displayed on the X 
and Y axis: 
<RPNCalculation RPNThreshold="100" SeverityLimit="8"> 
  <Code FunctionName="GetRPN"> 
    public int GetRPN(int severity, int probability, int visibility) 
    { 
      return severity * probability * visibility; 
    } 
  </Code> 
  <CodeThreshold FunctionName="GetThreshold"> 
    public int GetThreshold(int severity, int probability, int visibility) 
    { 
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      int acceptable = 0; 
      int ALARP = 1; 
      int inAcceptable = 2; 
      int rpn = severity * probability * visibility;   
 
      if (rpn &lt; 80) 
      { 
          return acceptable; 
      } 
 else if (rpn &lt; 100) 
{ 
  return ALARP; 
      } 
      return inAcceptable; 
    } 
  </CodeThreshold> 
  <RPNTable Description="Risk Probability Summary"  Acceptable="Good" ALARP="ALAP" 
InAcceptable="Bad"> 
    <XAxis Description="Probability x Visibility"> 
      <Item Probability="1" Visibility="1"/> 
      <Item Probability="2" Visibility="2"/> 
      <Item Probability="3" Visibility="3"/> 
      <Item Probability="4" Visibility="4"/> 
      <Item Probability="5" Visibility="5"/> 
      <Item Probability="6" Visibility="6"/> 
      <Item Probability="7" Visibility="7"/> 
      <Item Probability="8" Visibility="8"/> 
      <Item Probability="9" Visibility="9"/> 
    </XAxis> 
    <YAxis Description="Severity"> 
      <Item Severity="1" /> 
      <Item Severity="2" /> 
      <Item Severity="3" /> 
      <Item Severity="4" /> 
      <Item Severity="5" /> 
      <Item Severity="6" /> 
      <Item Severity="7" /> 
      <Item Severity="8" /> 
      <Item Severity="9" /> 
    </YAxis> 
  </RPNTable> 
</RPNCalculation> 
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6.7.8 Issue Proxy Specific 

To set up an interface to an external bug trackers a special section can be added to a template directly 
after the TypeInfo.  
 
To connect to Trac, define AssemblyName="Elements.TracConnect.dll". 
To connect to a Jira system, define AssemblyName="Elements.JiraConnect.dll". 
To connect to Gemini, define AssemblyName="Elements.GeminiConnect.dll". 
To connect to a TFS system, define AssemblyName="Elements.TFS2.dll". 
To connect to a GitHub system define AssemblyName="Elements.GitHubConnect.dll" 
 
The IssueProxy has 3 sections: 
 

▪ Properties, these define the specific communication properties for the chosen Assembly 

▪ StatusMap, list the used status names and define if the status is considered open or closed. 

▪ UserMap, map the user names between the 2 systems. If they are the same, then you can omit 
this section. 

 
Here is an example for Trac: 
<IssueProxy AssemblyName="Elements.TracConnect.dll" IssueBaseUrl="https://www.hosted-
projects.com/trac/aligned/TracConnect/ticket/" DefaultOwner="somebody"> 
    <Properties> 
      <Property Name="url" Value="https://www.hosted-
projects.com/trac/aligned/TracConnect/login/xmlrpc"/> 
      <Property Name="preauthenticate" Value="true"/> 
      <Property Name="defaultComponent" Value="component1"/> 
      <Property Name="defaultType" Value="defect"/> 
      <Property Name="defaultQuery" Value="status=new|assigned|reopened"/> 
      <Property Name="keepAlive" Value="false"/> 
    </Properties> 
    <StatusMap> 
      <Map Status="new" IsOpen="true"/> 
      <Map Status="closed" IsOpen="false"/> 
      <Map Status="reopened" IsOpen="true"/> 
      <Map Status="not initialized" IsOpen="true"/> 
    </StatusMap> 
    <UserMap> 
      <Map ElementsUser="Bo" ProxyUser="bb"/> 
      <Map ElementsUser="Joe" ProxyUser="jj"/> 
    </UserMap> 
  </IssueProxy> 
 
And here an example for Jira: 
<IssueProxy AssemblyName="Elements.JiraConnect.dll" IssueBaseUrl="http://jira.atlassian.com/browse/" 
DefaultOwner="somebody"> 
    <Properties> 
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      <Property Name="url" Value="http://jira.atlassian.com/rpc/soap/jirasoapservice-v2"/> 
      <Property Name="preauthenticate" Value="true"/> 
      <Property Name="defaultComponent" Value="GUI"/> 
      <Property Name="defaultFilter" Value="Test Project Open"/> 
      <Property Name="jiraProject" Value="TST"/> 
      <Property Name="defaultIssueType" Value="Task"/> 
    </Properties> 
        <StatusMap> 
      <Map Status="Open" IsOpen="true"/> 
      <Map Status="In Progress" IsOpen="true"/> 
      <Map Status="To be reviewed" IsOpen="false"/> 
      <Map Status="Not Qualified" IsOpen="false"/> 
    </StatusMap> 
    <UserMap> 
      <Map ElementsUser="Bo" ProxyUser="xmlrpctester"/> 
      <Map ElementsUser="Joe" ProxyUser="soaptester"/> 
    </UserMap> 
  </IssueProxy> 
 
When connecting to a url, you can optionally use a client certificate. The client certificate must be installed 
in your certificate store (use Microsoft Management Console with the plug in for Certificates to manage 
your certificates). Use the following parameter to refer to the certificate using the display name: 
<Property Name="certificateName" Value="My Client Certificate"/> 
 

6.7.9 Configuring Enforced Signing Order 

Enforcing the order of signatures can be done in one of two ways: 
 
Option 1: Signing order is enforced in the order of the user is in the Assigned Users table, i.e. the person on 
row one must sign before the person on row two and so on.  
 
To activate this behavior, add the attribute EnforceStrictSigningOrder="True" in the <TypeInfo> tag of the 
Signature template. 
 
Option 2: Groups of users are enforced to sign in a defined order, i.e. all Authors must sign before all 
Reviewers and all Reviewers must sign before all Approvers. 
 
To activate this behavior, add an Enum Column to the Assigned User table called “Sign Order” in the 
Signature template. As Enum values, use the numbers 1,2,3,4,5 etc. 
 
To defined the enforced order in the Signature itself, use the values in the “Sign Order” column to defined 
the order, i.e. set the value “1” to the users that must sign first, set the value “2” to the users that must 
sign after the “1” users etc. 

 

6.7.10 Configuring Test Run Templates 

The definition of a Test Run is configured in the rvt templates. 
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The Document Object type representing the Test object contains a TestRunDefinition section in the 
template, exemplified by: 
 
<TestRunDefinition TestCaseInRunTypeName="TestCaseInRun" ConfigurationTypeName="Configuration" 
ExecutedTypeName="ExecutedTestCase" RemoveOldAttachmentTracesAtNewExecution="true" 
SendEmailOnAssigned="true" ExecutedResultAttributeName="Result"> 
    <IssueTypes> 
      <IssueType TypeName="Issue" StatusAttributeName="Status" 
RemoveOldIssueTracesAtNewExecution="true" /> 
    </IssueTypes> 
  </TestRunDefinition> 
 
This definition specifies the combination of Document Object types that make out a Test chain. 
In this example, we can see that the expected Configuration type is called “Configuration” and the Test 
Result type is called “ExecutedTestCase”. 
We can also see that the overall Result attribute (mandatory, must be an enum) in ExecutedTestCase is 
called “Result”. 
Furthermore, we specify the Issue types that should be picked up by the Test Run, including the 
corresponding issue Attribute that specifies the Status of the Issue. 
By using the RemoveOldIssueTracesAtNewExecution attribute we can configure if Issues from previous 
executions should be included in the new executions or not. 
 
In order to function, the Test Run needs an additional object type which is not visible to the user. 
In this example it is called TestCaseInRun. This object type is used to handle Test parameters that are used 
for Test Planning purposes. 
 
To use Test Runs without configurations, use the attribute in the UseConfiguration="false" 
TestRunDefinition tag. 
 
To define the colors displayed in the Test Run status bar, define the colors as hex web colors for each result 
state in the Result enum: 
 
  <EnumAttribute Name="Result" ColumnSpan="1" DisplayInTestRun="true"> 

      <Items DefaultItem="Not Executed"> 

        <Item Color="#018abf">Not Executed</Item> 

        <Item Color="#e64444">Failed</Item> 

        <Item Color="#5fba7d">Passed</Item> 

      </Items> 

    </EnumAttribute> 

 
 
To specify the attributes to display for the involved types in the Test Grids, use the xml attribute: 
DisplayInTestRun="true" 
In the rvt templates.  
 
To prevent attributes being copied from Test Case to Executed Test Cases, in the Test Case use the xml 
attribute: 
CopyToTCXAtExecution="false" 
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To prevent attributes being blanked at Executions, in the Executed Test Case, use the xml attribute: 
KeepAtExecution="true" 
 
To copy the Object / Version Under Test information from the Test Run, configure a String attribute in the 
in the Executed Test Case with the name: 
Name="TestRunObjectUnderTest" 
The corresponding information will be copied from the Test Run to the Execution object at Execution. 
 
The Test Run can contain several Test Document Object Types depending on your templates. 
 
Upgrading a project from Single Test Exeuction (pre V2.4) to using Test Run  
The necessary template changes needs to be undertaken, including: 

▪ Adding a Configuration Object rvt template 

▪ Add a TestCaseInRun object rvt template 

▪ Add a TestRunDefinition in the Test Case rvt templates 

▪ Add attributes in the Execution for, among other things: 

▪ Configuration 

▪ Test Run 

▪ Add a Test Run Word templates 

 
Since the Test Run does not uses a 1-to-1 ID relationship between Test Cases and Execution objects, the 
database tblRevisableObjectId sql table must be adapted and the current ID number for Executed Test 
Cases must be set to the same value as the current ID number for the Test Case object. 

6.7.11 Mapping Projects to Template Files 

Sometimes different document projects want to re-use templates but with slight modifications. To 
accomplish this an optional configuration file can be added to the template directory. The file name must 
be ProjectMapping.xml and the content may be according to the example below: 
<?xml version="1.0" encoding="utf-8"?> 
<ProjectMapping xmlns="urn:ProjectMapping.xsd"> 
  <Project name="ProjectOne"> 
    <Include typeName="JiraIssue" fileName="JiraIssueOne.rvt"/> 
    <Exclude typeName="Ticket"/> 
    <MakeVisible typeName="Attachment"/> 
    <MakeInvisible typeName="UseCase"/> 
  </Project> 
  <Project name="ProjectTwo"> 
    <Include typeName="JiraIssue" fileName="JiraIssueTwo.rvt"/> 
    <MakeInvisible typeName="Specification"/> 
  </Project> 
</ProjectMapping> 
The example above assumes that the Templates contains the types, Requirement, Ticket, Attachment, 
UseCase where Ticket and UseCase are defined as IsVisibleBook="true" and Attachment as 
IsVisibleBook="false". 
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Both projects will have a type JiraIssue, but the definition thereof can differ having the definitions for 
ProjectOne in the configuration file JiraIssueOne.rvt and the definition for ProjectTwo in file 
JiraIssueTwo.rvt. This way, you can e.g. route issues to separate projects but still keep all other definitions 
in dependent templates.    
 
For ProjectOne, the type Ticket will not be loaded at all, Attachment will be visible in the Project Explorer 
and UseCase will not be visible in the Project Explorer. For ProjectTwo, Specification will not be visible in 
the Project Explorer. For any other project using the same templates, all templates will be available having 
the visibility as defined directly in the rvt-templates. 
 
In short, for any Project you may define any number of: 

1. Exclude, Excluded templates, templates that are present in the Template directory but will not be 
considered for the named project. 

2. MakeVisible, Templates which has the property IsVisibleBook="false" will for the named 
project be treated as IsVisibleBook="true". 

3. MakeInvisible, Templates which has the property IsVisibleBook="true" will for the named 
project be treated as IsVisibleBook="false". 

4. Include, Include specific template files, multiple template files for the same type name are 
present in the Template directory but only the named one will be considered for the named 
project.  
Note: For projects that are not listed in ProjectMapping.xml, the first read template for this 
type name will be used. This may be arbitrary which template this is so it is recommended 
to define the include setting for all available projects. 

6.7.12 Project Explorer Template 

The Web-client has the possibility to display a graphical overview of the project explorer. To configure this 
overview a dedicated xml-file ‘ProjectExplorerTemplate.xml’ has to reside in the template directory. The  
Project Explorer Template allows to visually display Document Object Types in panels and arrange them in 
rows and columns. The expected traceability is dynamically displayed but may also be controlled by 
defining Trace Hints. The appearance of the Document Object is possible to control via CSS-styling. The full 
configuration options are defined in the xsl-schema ‘ProjectExplorerTemplate.xsd’ which can be requested 
from support@aligned.ch. Below an example configuration is shown: 
 
<?xml version="1.0" encoding="utf-8"?> 
<ProjectExplorer xmlns="urn:ProjectExplorerTemplate.xsd"> 
  <Style> 
    .skew-left, 
    .skew-right div { 
      transform: skewX(30deg); 
    } 
    .skew-right, 
    .skew-left div { 
      transform: skewX(-30deg); 
    } 
    .padding { 
      padding: 5rem 10rem !important; 
       
    } 
  </Style> 
  <Panel Title="V-Model" DecoratorCSS="padding"> 
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    <Row RowNumber="1"> 
      <ProjectExplorerBook TypeName="User Need" Column="1" ColumnWidth="2" DecoratorCSS="skew-left" 
UseCategoryColor="true" DisplayCoverageSummary="true"> 
        <TraceHint HexColor="#cccccc" ToTypeName="Design Input Requirement" Path="straight" 
StartSocket="bottom" EndSocket="top"/> 
      </ProjectExplorerBook> 
      <ProjectExplorerBook TypeName="Validation Test Case" Column="6" ColumnWidth="2" 
DecoratorCSS="skew-right" UseCategoryColor="true" DisplayCoverageSummary="true"/> 
      <ProjectExplorerBook TypeName="Validation Test Result" Column="7" ColumnWidth="2" 
DecoratorCSS="skew-right" UseCategoryColor="true" DisplayCoverageSummary="true"/> 
    </Row> 
    <Row RowNumber="3"> 
      <ProjectExplorerBook TypeName="Design Input Requirement" Column="2" ColumnWidth="2" 
DecoratorCSS="skew-left" UseCategoryColor="true" DisplayCoverageSummary="true"> 
        <TraceHint HexColor="#cccccc" ToTypeName="Design Output" Path="straight" 
StartSocket="bottom" EndSocket="top" /> 
      </ProjectExplorerBook> 
      <ProjectExplorerBook TypeName="Verification Test Case" Column="5" ColumnWidth="2" 
DecoratorCSS="skew-right" UseCategoryColor="true" DisplayCoverageSummary="true"/> 
      <ProjectExplorerBook TypeName="Verification Test Result" Column="6" ColumnWidth="2" 
DecoratorCSS="skew-right" UseCategoryColor="true" DisplayCoverageSummary="true"/> 
    </Row> 
    <Row RowNumber="5"> 
      <ProjectExplorerBook TypeName="Design Output" Column="3" ColumnWidth="2" DecoratorCSS="skew-
left" UseCategoryColor="true" DisplayCoverageSummary="true"/> 
      <ProjectExplorerBook TypeName="Verification Test Case" Column="4" ColumnWidth="2" 
DecoratorCSS="skew-right" UseCategoryColor="true" DisplayCoverageSummary="true"/> 
      <ProjectExplorerBook TypeName="Verification Test Result" Column="5" ColumnWidth="2" 
DecoratorCSS="skew-right" UseCategoryColor="true" DisplayCoverageSummary="true"/> 
    </Row> 
  </Panel> 
  <Panel Title="Risk Analysis" DecoratorCSS="padding"> 
    <Row RowNumber="1"> 
      <ProjectExplorerBook  TypeName="Hazard" Column="1" ColumnWidth="2" DecoratorCSS="skew-left" 
UseCategoryColor="true" DisplayCoverageSummary="false"> 
        <TraceHint HexColor="#cccccc" ToTypeName="Hazard Analysis" Path="straight" 
StartSocket="bottom" EndSocket="top"/> 
      </ProjectExplorerBook> 
    </Row> 
    <Row RowNumber="3"> 
      <ProjectExplorerBook TypeName="Hazard Analysis" Column="2" ColumnWidth="2" DecoratorCSS="skew-
left" UseCategoryColor="true" DisplayCoverageSummary="true"> 
        <TraceHint HexColor="#cccccc" ToTypeName="Measure" IsVirtualTrace="true" Path="magnet" 
StartSocket="right" EndSocket="left"/> 
        <TraceHint HexColor="#cccccc" ToTypeName="Harm" IsVirtualTrace="true" Path="magnet" 
EndSocket="top"/> 
      </ProjectExplorerBook> 
    </Row> 
    <Row RowNumber="5"> 
      <ProjectExplorerBook TypeName="Harm" Column="1" ColumnWidth="2" DecoratorCSS="skew-left" 
UseCategoryColor="true" DisplayCoverageSummary="true"/> 
      <ProjectExplorerBook TypeName="Measure" Column="3" ColumnWidth="2" DecoratorCSS="skew-left" 
UseCategoryColor="true" DisplayCoverageSummary="true"/> 
      <ProjectExplorerBook TypeName="Design Input Requirement" Column="6" ColumnWidth="2" 
DecoratorCSS="skew-right" UseCategoryColor="true" DisplayCoverageSummary="true"/> 
    </Row> 
  </Panel> 
</ProjectExplorer>     
 
The configuration would result in 2 Panels being displayed. Any remaining Document Object Types would 
dynamically be displayed in their respective Book Category (not displayed here): 
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6.7.13 Configuring Custom Mail Messages 

All mail messages sent from Aligned Elements are predefined by the system and require no configuration 
to work. It is however possible for a customer to configure custom mails for some or all email actions 
known to the system.  
For the windows-client to use custom mail settings, there needs to be a directory in the template Directory 
called ‘MailContentSettings’ including an xml-document named ‘MailContentSettings.xml’.  
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The web-client, can define a common location using the key ‘EmailConfigHintPath’ in the web.config which 
is used for all template sets: 
<add key="EmailConfigHintPath" value="some path\ObjectTemplates\Default 
Templates\MailContentSettings" /> 
 

Below is an example configuration for the mail actions Request Access Win Login, Added user to Project, 
Send Review Email, Send Review Email Web, Send Review Email Web Reminder: 
 
<?xml version="1.0" encoding="utf-8"?> 
<MailContentSettings xmlns="urn:MailContentSettings.xsd"> 
  <MailContent MailAction="RequestAccessWinLogin" Subject="Hi I want access to {ProjectName}" 
Body="Dear Aligned Elements Administrator,&#10;&#10;Could you please add me as a user to the project 
'{ProjectName}'?&#10;&#10;Use this data to create my user:&#10;User name:&#10;Full name:&#10;&#10;My 
email address can be extracted from this mail.&#10;&#10;Please, notify me when I can log in."/> 
  <MailContent MailAction="AddedUserToProject" Subject="You have been added to project {ProjectName} 
on server {Server}" Body="Dear {FullName},&#10; the user {UserName} has been added to project 
{ProjectName} on server {Server}."/> 
  <MailContent MailAction="SendReviewEmail" Subject="Invitation to the Aligned Elements Review 
'{Title}', in Project '{ProjectName}' for Review Id '{IDNoProject}'" 
BodyFile="ReviewInvitation.html"/> 
  <MailContent MailAction="SendReviewEmailWeb" Subject="Invitation to the Aligned Elements Review 
'{Title}', in Project '{ProjectName}' for Review Id '{IDNoProject}'" 
BodyFile="ReviewInvitation.html"/> 
  <MailContent MailAction="SendReviewEmailWebReminder" Subject="Reminder - Invitation to the Aligned 
Elements Review '{Title}', in Project '{ProjectName}' for Review Id '{IDNoProject}'" 
BodyFile="ReviewInvitation.html"/> 
  <MailContent MailAction="SendWorkflowEmail" WorkflowTypeName="Issue" 
WorkflowAttributeName="Status" Subject="Closed Issue"  Body="This is the closed issue email" 
ActionDataID="mailClosed"/> 
</MailContentSettings> 

Emails can be sent as plain text or as html content. When using html-content, the email body is stored in a 
separate file in the same folder and is referred to by file-name.  
 
Dynamic content in the subject or body text, can be replaced by the system. The supported parameters are 
documented for each Email action in the xsl-schema MailContentSettings.xsd.  
 
Mails that are sent as part of a configured Workflow can be further specialized by defining the workflow 
typeName and/or attribute name and Action ID. 
     

The detailed valid content of the file is defined by the xsl-schema MailContentSettings.xsd which can be 
requested from support@aligned.ch.     

6.8 Defining Microsoft Word Templates 

When dragging document objects into a Microsoft Word document, they are displayed in a definable way. 
This definition is done by writing small word documents. These „word templates“ contain place holder tags 
which are filled with the data from the document object, when it is inserted into a document. In this way it 
is made possible that the look of the different document object types matches the look of the document 
templates which your company uses.  

6.8.1 Defining Microsoft Word Docx -Templates 

 
Docx-templates makes use of Content Controls to maintain information about the data from Aligned 
Elements that resides in a word document. For a Requirement it may look like this: 
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A requirement type (in our case Requirement) surrounds all data that should be displayed for the object. 
An attribute is contained in a nested content control. 
Aligned Elements supports the following content control types: 

1. Rich Text (for surrounding Content Controls, Rich text and table attributes, Traced Objects) 
2. Text (for String Attributes) 
3. Drop-down Lists (for Enum and Multi select attributes) 
4. Date Picker (for DateTime attributes) 

6.8.1.1 Defining a Simple Template using the Docx Template Builder 

The Docx Template Builder can be requested from support@aligned.ch and is a Word-addin that simplifies 
the creation of docx-templates. 

1. To enable the add-in, navigate to The Add-ins ribbon in word for any document that you would like 
to use as a word template. 

 
2. Check Show Action Pane 
3. Browse to your template directory. Now the templates are loaded and displayed in the Action 

Pane. 
4. Insert a table (if you want the document object to be enclosed in a table) and the text you would 

like to appear 

 
 

http://www.aligned.ch/
mailto:support@aligned.ch


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  209 / 269 

5. Select the complete section, and double-click on e.g. Main for Requirement 

 
 
 

6. The table in the example above will now be enclosed in a content control 
 

7. For each attribute that should be displayed, click on the location in the document (within the 
enclosing content control) and double-click on attribute name in the Action Pane, e.g. Title or 
Description. This causes one content control to be inserted per Attribute. 

 
8. When all data entries are defined. Save the template and try it out in Aligned Elements.  

 
 

6.8.1.2 Defining Templates Including Information from Traced Document Objects 

Follow the example above to create a simple template 
In our example we would like to include the Id’s of all traced Specifications. To do this you need to Use the 
Traced Object Designed in the Action Pane. 

1. Drag the Main for Requirement into the Traced Object Designer 
2. Drag the Main  for Specification into the Traced Object Designer 
3. Select an Attribute to display, in our case we use the ID 
4. Select if the insertion of this Traced Object should be enough to fulfill the “Document Object is not 

included in any file document object” Inconsistency (also see 3.21). If so, please check the “Include 
in Objects in File” checkbox. 
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5. Place the cursor in the document where the data should be displayed and click on Insert 
6. Repeat for all information that should be included in the template 

 

6.8.1.3 Defining Trace Object Attribute values 

Define the trace object attribute data similar to Traced Document object but use the syntax: 
TracedObjectAttribute:<name of the traced object attribute>:<name of attribute in the traced object to display> 
e.g. 
TracedObjectAttribute:Tasks:Task Description 
Also, just like for Traced Document Objects, include the path to the item such as: 
 

<A><Path V="Use Scenario/Task"/><ShowProject V="False"/><Repeat V="False"/></A> 
 

6.8.1.4 Using Main Tags 

You may create templates to display information other than Document Objects. The available options are 
listed under Main Tags: 

Tag Name Normal Use 

TraceTable To define trace tables. Make use of the Traced 
Object Designer to define the trace relations. 

QueryTable To define the template for Query result in table 
form. 

RPNSummary To define templates for RPNSummary 

DHFIndexTable To define the template for a DHFIndexTable 

RevisionHistory To define the template for the automatic Revision 
History 

Chapter To define templates for different chapter levels 

 

6.8.1.5 Using Special Content Controls 

Special tags can be used for any template for Document Objects and in trace tables. The available tags are: 
  

Tag Name Normal Use 

ParentChapter Will list the name of the chapter in which the 
document object resides. 

Creator Will list the user name of the creator of the 
document object. 
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ContainingFiles Will list all file document objects in which the 
document object appears 
 
Information about the files which contain a 
document object in the context of a traced object can 
be defined by setting the title of the content control 
to: 
 
TracedObject:1:ContainingFiles:FileAttributeName1, 
FileAttributeName, …, FileAttributeNameN 
 
Where FileAttributeName can be any valid attribute 
f.e. Title, ID, Project or DocumentVersion  
 
The Tag can be decorated with the IncludeSelf 
attribute.  
<A><IncludeSelf V=”True”/></A> 
If set to true, the Document in which Content Control 
is used will be listed as well as any other applicable 
document. Note that you will need to save and synch 
the document once for this feature to take effect. 
 

CheckBox Will display attribute data in the form of a check box. 
 
The title of the content control must contain a valid 
attribute of the document object.  
 
The tag then defines which values will check the box.  
For example: 
<A><CheckBox Default="false"><Map From="1" 
To="true"/><Map From="SampleText" 
To="2"/></CheckBox></A> 
 
Will check the box if the value of the attribute 
specified in the title of the content control is 1 and 
uncheck the box if the value is 2. All other cases will 
not check the box, because the default value is set to 
“false”. 
 
In the context of traced object, the definition is 
similar. Again, the title specifies the attribute. F.e. 
 
TracedObject:1:Priority 
 
And the tag specifies, in addition to the path of the 
traced object, the mapping: 
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<A><Path 
V="Requirement/Specification"/><CheckBox Default 
="True"><Map From="1" 
To="True"/></CheckBox></A> 
 

Inconsistency Will display information about an inconsistency type 
for a document object if present. 
To display information about a particular 
inconsistency the title of the content control must be  
Inconsistency:1:Name of Inconsistency 
 
And the tag must be  
 
<A><InconsistencyName V="Name of 
Inconsistency"/><TextWithOutIncon V="This 
inconsistency is not present"/><TextWithIncon 
V="This inconsistency is present/></A> 
 
The name of the inconsistency can be any 
inconsistency. See 3.22 
 For a list of possible inconsistencies. 
For example: 
 
<A><InconsistencyName 
V="IssueOpen"/><TextWithOutIncon V="No open 
issues"/><TextWithIncon V="Has open issues"/></A> 
 
will display “No open issues” if the document objects 
does not have the “Issue Open” inconsistency. 
Otherwise it will display “Has open issues” 
 

ContainedInReviews Will display information on document objects 
contained in a review. 
In order to display any attribute of a the reviews of a 
document object, insert a content control with the 
title “ContainedInReviews:AttributeNameOfReview”. 
 
If the information about the reviews is needed in the 
context of a traced object, the title of the content 
control must be: 
TracedObject:1:ContainedInReviews:AttributeName1, 
AtttibuteName2,…, AttributeName N 
 
The tag must be the same as for regular traced object 
attributes, i.e. it specifies the trace path. 
. 

RevisionHistory Will display the revision history of a document object. 
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The available fields together with the necessary title 
of the content control are: 

Info Title of content control 

Revision RevisionHistory:1:Revision 

User RevisionHistory:1:User 

Change comment RevisionHistory:1:Comment 

Date RevisionHistory:1:Date 

 
When adding the following text to the “Tag” field of 
the content control, only the last entry of the revision 
history is shown. 
<A><LastEntryOnly V=”true”/></A> 
 

Tags This will display any tags for the object. This can also 
be used as an attribute name in TracedObjects.  
 
The Tag can be decorated with the ListSeparator to 
define how multiple Tags are conjoined such as: 
<A><ListSeparator V="-" /></A> 
Will then render the text  
“red-green-yellow” 
 
It is also possible to specify that each value will be 
displayed on a separate line, by setting the 
ListSeparator to <ListSeparator V="&#10;" /> 

Shading of Rows in for TracedObjects In Tracetables and in tables used to display traced 
objects is possible to group all rows associated with a 
single object by shading the corresponding rows. For 
this following has to be set on Tracedobject content 
control which should trigger the change in shading: 
<A><ShadingRoot V="True" /></A>  
Optionally the alternating background colors for the 
shading can be set.  
Example: 
<A><ShadingRoot V="True"/><Color1 
V="wdColorBrightGreen"/><Path 
V="Requirement"/></A> 
 For the available colors, please refer to 6.8.1.7.1 

 

6.8.1.6 Numbering for rows in table attributes 

 
In order to allow numbering of rows of a table attribute, without using the build in word numbering 
features, Aligned Elements features a special content control for this. In order to have numbering in a table 
row insert a plaintext content control and specify the title of the controls as: 
 
Table:TableAttributeName:Number 
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6.8.1.7 Applying Operations to Content Controls 

 
Aligned Elements also features a few operators, which can used to change the actual content of a content 
control. The definitions are done in the tag field of the content control. In Aligned Elements the tag 
definitions must always start with <A> and always end with “</A>” 
 
Note: When editing tags of content controls in Microsoft Word older than Version 2013 there is a limit of 64 
characters. If more characters are needed, a (free) tool like the “Word Content Control Toolkit” must be 
used. In newer versions of Microsoft there is no limit to the number of characters. 
 

6.8.1.7.1 Transform 

 
The transform operator can be used to map certain content to a specified text. The following attribute 
definition will map the value of “true” to the text “Is true” and the value “false” to the text “Is False”. If the 
original value is neither “true” nor “false”, it will remain unchanged. 
 
Note: In order to map colors, the content control must be a rich text content control. 
 
<A><Transform><Map From="true" To="Is true" /><Map From="false" To="Is False" /> </Transform> </A> 
 
In addition, a default value can be specified for the values which are not covered by the mapped values. 
The following definition will display “Value is neither true nor false” for all values which are not part of the 
values specified in the “Map” attribute. 
 
<A><Transform Default="Value is neither true nor false"><Map From="true" To="Is true" /><Map 
From="False" To="Is False" /> </Transform> </A> 
 
Optionally the transform operator can also specify the colour of the text, the background colour of the text 
and also a background pattern. This is done with the Attributes Color, BGColor and BGPattern.  
 
Example: 
<A><Transform Default="Value is neither true nor false"><Map From="true" To="Is true" Color= " 
wdColorDarkRed " BGColor="wdColorGray80" </Transform> </A> 
 
If the content control is in a table cell, the BGColor will be applied as cell background color.  
 
Note: For the BGColor to work in a cell, the Content Control needs to by a Rich Text Content Control. Also 
make sure that no cell shading is set in the Word Template. 
 
Colors need to be specified as Microsoft as WDColor or on web color hex format such as “#xxxxxx”. The 
following WDcolors are available. 
 
Word Color Name Color 

wdColorAqua Aqua color. 

wdColorAutomatic Automatic color. Default; usually black. 
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wdColorBlack Black color. 

wdColorBlue Blue color. 

wdColorBlueGray Blue-gray color. 

wdColorBrightGreen Bright green color. 

wdColorBrown Brown color. 

wdColorDarkBlue Dark blue color. 

wdColorDarkGreen Dark green color. 

wdColorDarkRed Dark red color. 

wdColorDarkTeal Dark teal color. 

wdColorDarkYellow Dark yellow color. 

wdColorGold Gold color. 

wdColorGray05 Shade 05 of gray color. 

wdColorGray10 Shade 10 of gray color. 

wdColorGray125 Shade 125 of gray color. 

wdColorGray15 Shade 15 of gray color. 

wdColorGray20 Shade 20 of gray color. 

wdColorGray25 Shade 25 of gray color. 

wdColorGray30 Shade 30 of gray color. 

wdColorGray35 Shade 35 of gray color. 

wdColorGray375 Shade 375 of gray color. 

wdColorGray40 Shade 40 of gray color. 

wdColorGray45 Shade 45 of gray color. 

wdColorGray50 Shade 50 of gray color. 

wdColorGray55 Shade 55 of gray color. 

wdColorGray60 Shade 60 of gray color. 

wdColorGray625 Shade 625 of gray color. 

wdColorGray65 Shade 65 of gray color. 

wdColorGray70 Shade 70 of gray color. 

wdColorGray75 Shade 75 of gray color. 

wdColorGray80 Shade 80 of gray color. 

wdColorGray85 Shade 85 of gray color. 

wdColorGray875 Shade 875 of gray color. 

wdColorGray90 Shade 90 of gray color. 

wdColorGray95 Shade 95 of gray color. 

wdColorGreen Green color. 

wdColorIndigo Indigo color. 

wdColorLavender Lavender color. 

wdColorLightBlue Light blue color. 

wdColorLightGreen Light green color. 

wdColorLightOrange Light orange color. 

wdColorLightTurquoise Light turquoise color. 

wdColorLightYellow Light yellow color. 

wdColorLime Lime color. 

wdColorOliveGreen Olive green color. 

wdColorOrange Orange color. 

wdColorPaleBlue Pale blue color. 

wdColorPink Pink color. 

wdColorPlum Plum color. 

wdColorRed Red color. 

wdColorRose Rose color. 

wdColorSeaGreen Sea green color. 

wdColorSkyBlue Sky blue color. 

wdColorTan Tan color. 

wdColorTeal Teal color. 

wdColorTurquoise Turquoise color. 

wdColorViolet Violet color. 

wdColorWhite White color. 

wdColorYellow Yellow color 

 
The background pattern can take any of the following values: 
 
Word Pattern Name Pattern 

Clear No Pattern 

Solid 100% Fill Pattern 

HorizontalStripe Horizontal Stripe Pattern 

VerticalStripe Vertical Stripe Pattern 
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ReverseDiagonalStripe Reverse Diagonal Stripe Pattern 

DiagonalStripe Diagonal Stripe Pattern 

HorizontalCross Horizontal Cross Pattern 

DiagonalCross Diagonal Cross Pattern 

ThinHorizontalStripe Thin Horizontal Stripe Pattern 

ThinVerticalStripe Thin Vertical Stripe Pattern 

ThinReverseDiagonalStripe Thin Reverse Diagonal Stripe Pattern 

ThinDiagonalStripe Thin Diagonal Stripe Pattern 

ThinHorizontalCross Thin Horizontal Cross Pattern 

ThinDiagonalCross Thin Diagonal Cross Pattern 

Percent5 5% Fill Pattern 

Percent10 10% Fill Pattern 

Percent12 12.5% Fill Pattern 

Percent15 15% Fill Pattern 

Percent20 20% Fill Pattern 

Percent25 25% Fill Pattern 

Percent30 30% Fill Pattern 

Percent35 35% Fill Pattern 

Percent37 37.5% Fill Pattern 

Percent40 40% Fill Pattern. 

Percent45 45% Fill Pattern 

Percent50 50% Fill Pattern 

Percent55 55% Fill Pattern 

Percent60 60% Fill Pattern 

Percent62 62.5% Fill Pattern 

Percent65 65% Fill Pattern 

Percent70 70% Fill Pattern 

Percent75 75% Fill Pattern 

Percent80 80% Fill Pattern 

Percent85 85% Fill Pattern 

Percent87 87.5% Fill Pattern 

Percent90 90% Fill Pattern 

Percent95 95% Fill Pattern 

 

6.8.1.7.2 Prefix 

 
The prefix operator allows to specify a prefix for a value. The following example will prefix any text value 
with “Start-” 
<A><Prefix V="Start-"/> </A> 
 

6.8.1.7.3 Suffix 

 
The suffix operator allows to specify a suffix for a value. The following example will add “-End” to any text 
value. 
<A><Suffix V= "-End"/> </A> 
 

6.8.1.7.4 Combinations 

 
Operators can be combined. When doing this, the transformation is done first and then the prefix or suffix 
is added. So the following definition will do the following conversions: 
 
“1” -> “Start-Has value of 1-End” 
“3” -> “Start-DefaultText”-End” 
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<A><Prefix V="Start-"/><Suffix V= "-End"/> <Transform Default="DefaultText"><Map From="1" To="Has 
value of 1" /><Map From="2" To="Has value of 2" /> </Transform> </A> 
 

6.8.1.8 Setting the separator for MultiSelect Attributes 

 
If an object contains a MultiSelect attribute, see 6.7.3, the values are displayed by a default separator “|”. 
F.e. if an attribute has the values “red”, “green” and “yellow”. The text value in Word is 
“|red|green|yellow|. This separator can be customized by specifying the ListSeparator . 
 
F.e. the following:  
<A><ListSeparator V="-" /></A> 
Will then render the text  
“red-green-yellow” 
 
It is also possible to specify that each value will be displayed on a separate line, by setting the ListSeparator 
to  <ListSeparator V="&#10;" /> 
 
This will then produce the following output: 
“red 
green 
yellow” 
 

6.8.1.9 Display Full name or Email for an Enum User Attribute 

The attribute content control for an EnumUserAttribute can be configured to display the FullName or Email 
as opposed to the user name in the content control. To activate this behavior, use the following sequence 
in the Title of the Attribute Content Control: 
 
ElementsUser:<name of the EnumUserAttribute>:FullName 
Or 
ElementsUser:<name of the EnumUserAttribute>:Email 
 

6.8.1.10 Display Fields from the Project Information  

 
In order to display fields from the Project Information, see 3.27, a content control with the title 
“ProjectInfo” and the name of the attribute can be used. F.e to display the description of the Project Info, 
use a content control with the title “ProjectInfo.Description”. If a field is of the type “Richtextattribute”, 
please make sure to use a rich text content control. 
 
Note: In contrast to “regular” document objects, the attributes do not need to be grouped into a project 
info object, but the fields can be distributed across the document. It is also allowed to have these content 
controls in headers and footers.   
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6.9 Using an External PDF Converter 

Aligned Elements includes a build in PDF/A conversion capability for converting Ms Word documents which 
should suit most requirements. However if you have special content or types of documents that cannot be 
handled by the build in converter, you may configure the application to use an external PDF Converter. The 
only restriction is that the converter can be called as a command line application and be passed command 
line arguments.    
 
To switch on this capability, please extend the template directory with the following sub-directory: 
PDFConverters 
 
The directory should contain the PDF converter executable and be accompanied by at least 1 text file 
which contains the arguments that should be passed to the PDF converter. 
 
The example below makes use of the open source application OfficeToPFD 
https://officetopdf.codeplex.com/:  
 

 
Figure 1 Directory and file structure for External PDF converters 

 
I.e. if the PDF converter is called OfficeToPDF.exe you should add a text file OfficeToPDF.docx.args.txt. The 
name is the same as the converter executable and the next suffix denotes the file type that are converted 
with these arguments. The content of the text file must include 2 placeholders for the input and output 
filenames and may also contain any additional arguments that should be passed to the PDF converter. E.g.: 
"{0}" "{1}" /readonly /hidden /bookmarks 
  
Note: If the PDF converter supports conversion of multiple file types, you can add 1 argument text file per 
type. 

6.10 Installation of Aligned Elements 

6.10.1 Installation of Microsoft SQL Server Database 

6.10.1.1 Step 1: Download SQL Server  

 
Download the SQL Server or SQL Server express edition from Microsoft. In this example, we are 
downloading SQL Server 2022 Express with Advanced Services. Note that the Advanced Service edition is a 
must since it supports Full Text search on which Aligned Elements relies. The “regular” SQL Server Express 
does not support Full Text search and can thus not be used for Aligned Elements. 
 
Link: https://go.microsoft.com/fwlink/p/?linkid=2216019&clcid=0x409&culture=en-us&country=us 
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Make sure you select the “Express Advanced” version if using SQL Express. 
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Note! You will need a DB password to complete the installation. Obtain this password from your Aligned AG 
contact. 
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6.10.1.2 Step 3: Install SQL Server  

 
Double click on the downloaded .exe file. 
 

 
 
 
 
Select the “New SQL Server stand-alone…” option to start the installation. 
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After you start the installation, you have to agree to the typical End User License Agreement. 
 

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  224 / 269 

 
 
If applicable, select check for automatic updated.  
Note! Make sure that this option is aligned with your validation strategy. 
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Leave all Azure Extension fields empty and click next. 
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Depending on your Network content you get this message: The Installation Rules make sure that your 
computer is compatible with the installation. 
 

 
 
At a later stage you might have to configure your firewall to support remote calls. 

 
Note! Make sure that you select the “Full Text…” option. Aligned Elements is dependent on this feature for 
full text search. 
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Set default instance and click next 
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Default values are usually OK here.  
Note! Check that the proposed collation is case in-sensitive! This information is part of the name as CI, e.g. 
for Latin1_General_CI_AS.   
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VERY IMPORTANT! In the dialog above,  

▪ Select “Mixed Mode” 

▪ Enter a password for the sa user. 
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These are all of your options for SQL Server Express Edition. Continue on to install the product using these 
selections. 
 

 
 
 
 

6.10.1.3 Step 4: Install full-text filter packs 

You now need to install a filter pack to allow sql server to read the content of different document 
types (e.g. doc, docx) 
 
Download from https://www.microsoft.com/en-US/download/details.aspx?id=17062. Select the 
correct version depending on your OS (32 or 64 bit) 

Start installation by clicking on FilterPackx86.exe (or FilterPackx64.exe) 
 
To register the filter packs, please follow these steps (from http://support.microsoft.com/kb/945934) 
 

1. Start SQL Server Management Studio. 
2. In SQL Server Management Studio, select the instance in which you want to enable IFilters, and 

then run the following command in that instance: 
     sp_fulltext_service 'load_os_resources', 1 
 

3. If you are running SQL Server 2008 or higher, go to Step 4. If you are running SQL Server 2005, stop 
and restart the msftesql service. To do this, follow these steps: 

a. At a command prompt, type the following command and then press Enter: 
          net stop msftesql 
 
        Note To stop the msftesql service for a specific instance, run the following command: 
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        net stop msftesql$InstanceName 
 

b. At a command prompt, type the following command and then press Enter: 
          net start msftesql 
 
        Note To start the msftesql service for a specific instance, run the following command: 
        net start msftesql$InstanceName 
 

4. Restart the SQL Server service. 

6.10.1.4 Step 5: Adapt the SQL Server Instance User Account  

 
Download and install SQL Server Management studio from the mmicrosoft website. 
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Start SQL Server Management Studio Express 
 

 
 
In the log in box use the option as displayed below. NB! The server name must correspond to your 
computer name. The instance name in this case is “SQLEXPRESS” by default.  
 
Use the password created for the sa account above. 
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In the “Security” folder, select the “Logins” folder, right click and select the option “New Login…”. 
 

▪ Create a new user name with the name “AlignedElement” (not “AlignedElements”).  

▪ Set the password to the password that you have obtained from your Aligned contact.  

▪ Uncheck “Enforce Password Policy” and uncheck “Enforce password expiration”. 

▪ Make sure that the default language for the user is set to English. 
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Make sure that the user “AlignedElement” is assigned to the Server Roles “public” and “sysadmin”.  
 

 
 
Test the new login by logging in again with the user AlignedElement. 
 
 
 

6.10.2 Install Project Templates 

For all projects in Aligned Elements you need a common location for the project templates. Important is 
that the path needs to be the same for all different users e.g. \\serversoandso\Your Templates or a 
commonly mapped drive on the network e.g. g:\\Your Templates. 
 

1. To install, copy the template files provided by Aligned AG to your dedicated template directory. 
 

2. Ensure that all intended users have read and write access rights for the template directory. 

6.10.3 Install Client 

The following PC requirements apply: 
 

1. Windows 7 (x86 or x64) and later 
2. It is recommended to have at least 2GB RAM available. 
3. Microsoft Word 2007 and later 
4. You have a valid license from Aligned AG. 
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Note: 
A designated MSWord 64-bit Aligned Elements installer is required for compatibility with MS Word 
installed as 64-bit. 
 
 
Installation Steps: 

1. Download an installer from the Aligned website. (http://www.aligned.ch) 
2. Unzip the downloaded file and click on the setup.exe. 
3. After all pre-requisites are installed, the application is automatically started. 
4. You are prompted to install the license for Aligned Elements. Browse to the license file issued by 

Aligned AG. 
 

6.10.4 Automatic upgrade of project database 

The first time a new version of an Aligned Elements client loads an existing project database (created in a 
previous version of Aligned Elements), the database will automatically be upgraded to match the new 
version. The user will be informed during project load and may choose to cancel the upgrade procedure. 
After an upgrade it is possible that older versions of Aligned Elements may not work properly. 

6.10.5 Using Sql Server Full Text Search 

Aligned Elements relies on the SQL Server Full Text search capabilities for a number of features. To switch 
on this option, please install the Full text service from Microsoft. For Sql Server Express, it is available as 
part of the Microsoft SQL Server Express Edition with Advanced Services. For other editions of Sql Server, 
it is part of your normal distribution. 
If the Full Text service is installed, Aligned Elements will automatically configure the database to use the 
service. 
 
Note: When the full text service is used, some words “noise”-words, e.g. “is”, “are” etc.) will not return any 
result since they are not considered as relevant words. To change the content of the noise word file, follow 
the instructions below: 
 
Configuring Full-Text Noise Words SQL Server 2005: 

1. Check default full-text language code by using the context menu on the root in Object Explorer to 
access the Server Properties. Note that the Default Language not necessarily is the same as the 
Default Full-Text Language. 
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2. Check available languages by running the following query on the root in the Object Explorer. 
select * from sys.fulltext_languages 

 
This will render in a list of ID and language names. Compare with the ID code from 1. 
 

3. Check which noise file that corresponds to the language: 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL Server\<your SQL Server instance, 
e.g. MSSQL.1>\MSSearch\Language\eng 
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4. Open file in a normal text editor (e.g. Notepad) and modify/remove noise words in the file. Save the 
file. 

 
5. Rebuild indexes, (needs to be done for all databases) 

alter fulltext index on tblRevisableObject set change_tracking off 
alter fulltext index on tblRevisableObject start full population 
alter fulltext index on tblRevisableObject  set change_tracking auto 
alter fulltext index on tblAttribute set change_tracking off 
alter fulltext index on tblAttribute start full population 
alter fulltext index on tblAttribute set change_tracking auto 
alter fulltext index on tblFileAttributeValue set change_tracking off 
alter fulltext index on tblFileAttributeValue start full population 
alter fulltext index on tblFileAttributeValue set change_tracking auto 

6. Test that the search behaviour is as expected 
 

6.10.5.1 Configuring Full-Text Noise Words SQL Server 2008 

For SQL Server 2008 the noise words are no longer store in text files and the term noise-words has been 
replaced by stop-words. Please see http://msdn.microsoft.com/en-us/library/ms142551.aspx for 
information on how to manage stop-words for SQL Server 2008. The indexes listed above for SQL Server 
2005 still apply. 
 

6.10.6 Relocation of Template Folder 

Since Aligned Elements needs the configuration templates every time a project is opened, relocating the 
templates to a new folder require some careful steps. In an example where the templates are relocated 
from the path A to the path B, proceed as follows: 
 

1) Copy the templates from A to B 
2) Open the Aligned Elements project 
3) In Main Menu -> Project Settings -> Paths, set the Template Path to B (instead of previous A) 
4) Close the application. You can now delete the templates on the location A 

 
If the Template folder with which the project has been created is no longer available at the original 
location, Aligned Elements will notify the user when opening the project and give the user an opportunity 
to temporarily load the templates from a different location. Once the project is opened, it is strongly 
recommended that the new path to the templates are set in In Main Menu -> Project Settings -> Paths. 
 

6.11 Maintenance of database 

Aligned Elements use Microsoft SQL Server  Please refer to the vendor documentation [1] and [2] in 1.3 
References for detailed information on how to set up daily backups of the database and to perform 
database recovery. Below you will find a short description on how to set up a daily backup or move a 
database to a different server. 
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6.11.1 Initial Configuration of Microsoft SQL Server 2005 

The instructions below are based on the configuration of the Microsoft SQL Server 2005 Express Database 
but also apply to the Microsoft SQL Server 2005. 

6.11.1.1 Step 1- Configure your database server for remote access 

 

 
 
Open the SSQL Server Configuration Manager and enable all protocols. 
 

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  241 / 269 

 
 
Make sure the SQL Server is set up to Allow remote connections. 
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Step 2 - Configure the Firewall on the PC where the Database Resides 
 
To allow for remote connections make sure that the Ports 1433 (TCP) and 1434 (UDP) are opened in the 
Firewall. 
 
 
Step 3 - Check configuration 
1. Start Aligned Elements on a client which is on the same network as the database installation. 
2. In the Create/Open Project Dialog, Scan for databases 
 

 
 
3. If all is working, the configured database should be displayed in the Server combo box.  
 
4. Create a new project to test the connection. 
 
Troubleshooting: 
 
1. A message box will be displayed with the names of all servers that were found on the network if the 

scanning did not succeed. The problem during scanning could be that the databases did not provide 
their instance name (“SQLEXPRESS” in the picture above) which is needed to properly connect.  

 
Please check the firewall settings above again to fix the problem (or if your network has a different firewall, 
please contact your network administrator).  
 
2. No databases are found. This could occur when the remote connection is not properly set-up. To check 

if this is the problem, type the server and instance name manually in the server combo box (e.g. 
MyServerName\SQLEXPRESS) and press return (important: Observe that the slash is a backslash, not a 
front slash!). Thereafter try to create a new project to test that the server is valid.  

 
If this works (but the scanning does not), your problem lies in the firewall settings.  
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If it does not work (an error is displayed after creating the project), your problem can be either that the 
remote access is not configured properly or that the user authentication is not properly set-up (in this case, 
contact Aligned AG for support). 

6.11.2 How to Move a Database/Project to a Different Server 

A project consists of one database instance. The database name is always the same as the project name.  
 
To move a database from one server to another you need to have SQL Server 2005 or SQL Server 2005 
Express installed on the target server and perform the following steps: 

1. Open SQL Server Management Studio (Express) on the original server. 
2. Select Detach… for the database you want to move. 

 

 
 

3. You will get a confirmation dialog where you just press OK 
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4. The data file can be found in: 
C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data  
and has the name yourDbName.mdf. 

5. Copy the data file to the equivalent directory on the target server. 
6. Open the Sql Server Management Studio (Express) on the target server. 
7. Select Attach… to attach the database 
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8. Select Add… to browse to the database file and acknowledge with OK 
 

 
 
 
Since the server name has changed, the server name needs to be updated in tblProjectSettings table. 
Run the following query with the appropriate parameter values. 
update tblProjectSettings set Server = '<newServerName>' where Name = '<ProjectName>'; 
 

9. Start Aligned Elements and open the project from the new server. 

6.11.3 How to backup Your Database 

Open SQL Server Management Studio and navigate to Management/Maintenance Plans. 
 
Right-click and select Maintenance Plan Wizard. 
 

1. Select at least Full backup: 
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2. Click next  to name the plan  
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3. Click on “Change..” to set a schedule 
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4. Confirm and continue with next to order the tasks: 
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5. Select the Databases dropdown to select which databases should be part of the backup 
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6. Set the report options: 

 
 

7. Complete the wizard to generate the maintenance plan. 
 
After the first planned execution, verify that the backup was made and that the process was properly 
reported. Also verify that the backup is valid. 

6.11.4 How to Backup Your Databases – SQL Server 2005 Express Edition 

 
Note: If you are using SQL Server Standard Edition or higher, please refer to 6.11.3 How to backup Your 
Database. 
 
Please note that most of the following steps require local administrator rights.  
The script files:  
 

1. backup.sql 
2. expressmaint.sql 
3. executeBackup.bat 

 
that are mentioned below, can be requested by Aligned AG. 
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6.11.4.1 Step 1- Configure your database server 

 
1. Enter the SQL Server Surface Area Configuration.  
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2. Choose to configure the “Features”.  
 

 
 

3. Select the “OLE automation option” and check it. Press “Apply”. 
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4. Now choose the “xp_cmdshell option” and check it. Press “OK”. 
 

6.11.4.2 Step 2: Load a stored procedure into the database 

 
Open the Windows Command Prompt, by selecting Start -> Accessories -> Command Prompt. 
 
Execute the following text in the command prompt, 
 
sqlcmd -S .\SQLExpress -i c:\expressmaint.sql 
 
Where  
 
1) “SQLExpress” is the name of your database 
2) “c:\expressmaint.sql” is the location i.e. the directory where the expressmaint.sql file is located, which 
you have received from Aligned. 
 

6.11.4.3 Step 3: Adapt the backup.sql file 

 
Open the supplied file “backup.sql” in notepad (do NOT use Word, because it will write invisible formatting 
characters to the file). Now change the file, to suit your needs. The original file looks like this: 
 
exec expressmaint 
   @database      = 'ALL_USER',  
   @optype        = 'DB', 
   @backupfldr    = 'c:\backups', 
   @reportfldr    = 'c:\reports', 
   @verify        = 1, 
   @dbretainunit  = 'days', 
   @dbretainval   = 1, 
   @rptretainunit = 'weeks', 
   @rptretainval  = 1, 
   @report        = 1 
 
 
‘ALL_USER’ means that all user created databases are backup-ed. If you only want to up backup a single 
one, just write the name of the database. F.e. @database='MYPROJECTDB' 
 
backupfldr= 'c:\backups' is the directory where the backups will be stored. Change this to suit your need. 
This could be a directory on a network folder which is backuped onto tape on a regular basis. Make sure 
that the directory is created before you start. It is not created during the backup procedure. 
 
@reportfldr='c:\reports' is the directory where the backup procedure’s logs are stored. Make sure that the 
directory is created before you start. It is not created during the backup procedure. 
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@dbretainunit='days' and @dbretainval= 1 are used to specify how long backups are retained. You can 
also specify 'weeks' 
 
@rptretainunit = 'weeks' and @rptretainval  = 1, are used to specify how long the logs are retained. 
 
After you have changed the file, save it. 
 

6.11.4.4 Step 4. Schedule a task to perform the backup. 

 
Now open the executeBackup.bat file in Notepad and adapt the path to your backup script “backup.sql”. 
The line in executeBackup.bat should look like: 
 
sqlcmd –S  .\SQLExpress –i "C:\yourdirectory\backup.sql" 
 
Where  
1) “.\SQLExpress” is the name of your database. 
2) “c:\yourdirectory” must of course be replaced with the location where you saved your modified 
“backup.sql”. 
 
Schedule a task by Adding a scheduled task in the explorer (Control Panel/Add new Task). Browse to the 
location of executeBackup.bat and configure the desired time and interval: 
 

 
Picture 1: Set interval 
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Set time of the day and days in the week 

 
 
 

 
Set the administrator password for this PC 
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Picture 2: The schedule summary 

 
You can also schedule a teats from the command prompt by starting the command prompt and write (and 
again, please adapt the path to the location of the “executeBackup.bat” script): 
 
C:>at 23:00 dbBackup /every:mo,tu,we,th,fr "c:\yourdirectory\executeBackup.bat" 
 
We recommend setting the execution interval to daily. Please choose a time, where not many people will 
be working with Aligned Elements, because during the backup, the performance will go down. 
 
You can find the reason for any execution errors in the event manager filed under system events (e.g. 
typically the paths are not fully matching). You can also track the execution status in the special folder 
Scheduled tasks in the Control Panel.  
 
 

6.11.5 How to Backup Your Databases – SQL Server 2008 Express Edition 

 
Note: If you are using SQL Server Standard Edition or higher, please refer to 6.11.3 How to backup Your 
Database. 
 
Please note that most of the following steps require local administrator rights.  
The script files:  
 

1. backup.sql 
2. expressmaintSQL2008.sql 
3. executeBackup.bat 

 
mentioned below, can be requested by Aligned AG. 
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6.11.5.1 Step 1: Configure your database server 

 
1. Activate OLE Automation by opening the SQL Server Management Studio and perform the following 

query: 
 
sp_configure 'show advanced options', 1;  
GO  
RECONFIGURE; 
GO  
sp_configure 'Ole Automation Procedures', 1; 
GO  
RECONFIGURE; 
GO 
 
 

2. Activate the “xp_xmdshell” by opening the SQL Server Management Studio and perform the 
following query: 

 
sp_configure 'show advanced options', 1; 
GO 
RECONFIGURE; 
GO   
sp_configure 'xp_cmdshell', 1; 
GO 
RECONFIGURE; 
GO 
 

6.11.5.2 Step 2: Load a stored procedure into the database 

 
Open the Windows Command Prompt, by selecting Start -> Accessories -> Command Prompt. 
 
Execute the following text in the command prompt, 
 
sqlcmd -S .\SQLExpress -i C:\expressmaintSQL2008.sql 
 
Where  
 
1) “SQLExpress” is the name of your database 
2) “c:\expressmaintSQL2008.sql” is the location i.e. the directory where the expressmaintSQL2008.sql file 
is located, which you have received from Aligned. 
 

6.11.5.3 Step 3: Adapt the backup.sql file 

 
Open the supplied file “backup.sql” in notepad (do NOT use Word, because it will write invisible formatting 
characters to the file). Now change the file, to suit your needs. The original file looks like this: 
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exec expressmaint 
   @database      = 'ALL_USER',  
   @optype        = 'DB', 
   @backupfldr    = 'c:\backups', 
   @reportfldr    = 'c:\reports', 
   @verify        = 1, 
   @dbretainunit  = 'days', 
   @dbretainval   = 1, 
   @rptretainunit = 'weeks', 
   @rptretainval  = 1, 
   @report        = 1 
 
 
‘ALL_USER’ means that all user created databases are backup-ed. If you only want to up backup a single 
one, just write the name of the database. F.e. @database='MYPROJECTDB' 
 
backupfldr= 'c:\backups' is the directory where the backups will be stored. Change this to suit your need. 
This could be a directory on a network folder which is backuped onto tape on a regular basis. Make sure 
that the directory is created before you start. It is not created during the backup procedure. 
 
@reportfldr='c:\reports' is the directory where the backup procedure’s logs are stored. Make sure that the 
directory is created before you start. It is not created during the backup procedure. 
 
 
@dbretainunit='days' and @dbretainval= 1 are used to specify how long backups are retained. You can 
also specify 'weeks' 
 
@rptretainunit = 'weeks' and @rptretainval  = 1, are used to specify how long the logs are retained. 
 
After you have changed the file, save it. 
 

6.11.5.4 Step 4: Schedule a task to perform the backup 

 
Now open the executeBackup.bat file in Notepad and adapt the path to your backup script “backup.sql”. 
The line in executeBackup.bat should look like: 
 
sqlcmd –S .\SQLExpress -i "C:\yourdirectory\backup.sql" 
 
Where  
1) “.\SQLExpress” is the name of your database. 
2) “c:\yourdirectory” must of course be replaced with the location where you saved your modified 
“backup.sql”. 
 
Schedule a task by Adding a scheduled task in the explorer (Control Panel/Add new Task). Browse to the 
location of executeBackup.bat and configure the desired time and interval: 
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Set interval 

 

 
Set time of the day and days in the week 
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Picture 3: Set the administrator password for this PC 

 

 
Picture 4: The schedule summary 

 
You can also schedule a teats from the command prompt by starting the command prompt and write (and 
again, please adapt the path to the location of the “executeBackup.bat” script): 
 
C:>at 23:00 dbBackup /every:mo,tu,we,th,fr "c:\yourdirectory\executeBackup.bat" 
 
We recommend setting the execution interval to daily. Please choose a time, where not many people will 
be working with Aligned Elements, because during the backup, the performance will go down. 
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You can find the reason for any execution errors in the event manager filed under system events (e.g. 
typically the paths are not fully matching). You can also track the execution status in the special folder 
Scheduled tasks in the Control Panel. 

6.11.6 How to Restore your backed up databases  

 
1) Open SQL Server Management Studio (Express) on the original server. 
2) Connect to the database server. 
3) Expand the Database Folder. 
4) Right click on the database you want to restore and select Tasks -> Restore…->Database  

 

 
 

5) Select the back up you want to use by selecting a point in time.  
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6) Select “From Device” (1) and click the Browse button (2). In the next dialog select “Add” (3) 
and browse to the directory where you have backed up the database and select the back up 
file (4). 

 

 
 
Tick the check box of the backup file you want to use and click OK to restore the database.  
 

 
 
Note! When completed you need to run the following to SQL Queries on your project.  

http://www.aligned.ch/


Aligned Elements User Manual 
 
 

Aligned Elements V3.0.443.22517 

 

Aligned AG | Klingenstrasse 37 | 8005 Zürich | Phone +41(0)44 312 50 20 | www.aligned.ch | info@aligned.ch  264 / 269 

 
1) ALTER DATABASE "<the database name>" SET NEW_BROKER WITH ROLLBACK IMMEDIATE; 

 
2) ALTER DATABASE "<the database name>" SET ENABLE_BROKER; 

 
Note the quote around the project name. 
 

6.11.7 How to copy and rename an SQL Server database 

 
Note! Make sure the collation of the source server and database is the same as the collation of the target 
server and database. This is especially important for linked projects. 
 
Note! No incoming traces to the renamed project from other projects will be set when renaming a project 
this way. 
These traces have to be set manually again for the renamed project. 
 
Note! All Document Objects in existing Word Documents in File Objects needs to be replaced in the 
renamed project, since the Document Object IDs stored in the Word Document contains the old project 
name. This applies to all Word Document containing Document Objects with the old project name, in the 
renamed project or in linked projects. 
 
Note! The new project name may not contain: 

- Any quotes or apostrophes 
- No hyphen or minus signs 
- Not end with one or more spaces 

 
1) Take a backup of the database you intend to copy. Make sure that no one uses or will use the 

database at the moment you perform this operation.  
 

2) Use SQL Server Management Studio to find the database. Use the context menu to click 
“properties”->”Files” to find the location where the database files are stored (.mdf and .ldf). Take 
note of these locations. Detach the database by right clicking on the database, use the context 
menu item “Tasks” and select “Detach”. If detach cannot be done, select the “Drop all connection” 
option and try again. 
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3) Use a File Explorer and navigate to that location where the MDF and the LDF files are stored and 

take copies of the MDF and LDF file and store the copies in a different location. These copies will be 
used as the original database which we are going to re-attach to the server once we are done with 
the renaming. 

 
4) Attach the database again using the context menu in SQL Server Studio Manager. We now need to 

modify the logical and physical name of the MDF and LDF files. 
 

5) To modify the logical name, rename the logical file names by open the database properties and 
select the “Files” tab. 

 
Place the cursor in the cell, under the column “Logical names” and type the new name for both MDF and 
LDF files: 
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Press “OK” to close this screen. The logical files are now renamed. 
 

6) To change the physical names, we need to detach the database again (see step 2)  
 

7) Navigate to the detached physical files (see step 2) and rename the physical .MDF file (using F2 in 
the File Explorer) and delete the .LDF file. 

 
8) Use the following query to attach the renamed database again. A new LDF file will automatically be 

created 
 
USE master; 
GO 
CREATE DATABASE <newName> 
      ON (FILENAME = '<location of the renamed mfd file including the extension>')  
      FOR ATTACH ; 
GO 
 
9) When the database has been attached perform the following queries: 

▪ ALTER DATABASE "<the database name>" SET NEW_BROKER WITH ROLLBACK IMMEDIATE; 

▪ ALTER DATABASE "<the database name>" SET ENABLE_BROKER; 

 
Note the quote around the project name. 
 
9) After that has been completed perform the following queries on the attached database: 
 
update tblChapter set ProjectName = '<newDBName>' where ProjectName = '<oldDBName>'; 
 
update tblSnapshotChapter set ProjectName = '<newDBName>' where ProjectName = '<oldDBName>'; 
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update tblLockedRevisableObject set ProjectName = '<newDBName>' where ProjectName = 
'<oldDBName>'; 
 
update tblRevisableObject set projectName = '<newDBName>' where projectName = '<oldDBName>'; 
 
update tblRevisableObject set ProjectIdNoRev = REPLACE(ProjectIdNoRev, '<oldDBName>-', 
'<newDBName>-') where (ProjectIdNoRev LIKE '<oldDBName>-%'); 
  
update tblTrace set projectName = '<newDBName>' where projectName = '<oldDBName>'; 
 
update tblSignatureLink set projectName = '<newDBName>' where projectName = '<oldDBName>'; 
    
update tblUserFavourite set ProjectName = '<newDBName>' where ProjectName = '<oldDBName>'; 
 
update tblComment set ForProjectIdNoRev = '<newDBName>' where ForProjectIdNoRev = '<oldDBName>'; 
 
update tblTagLink set ProjectName='<newDBName>', ProjectIdNoRev = REPLACE(ProjectIdNoRev, 
'<oldDBName>', '<newDBName>') where ProjectName='<oldDBName>' 
  
update tblArrayRevisableObjectDbId set projectName = '<newDBName>', idrev= REPLACE(idrev, 
'<oldDBName>', '<newDBName>'), idNoRev= REPLACE(idNoRev, '<oldDBName>', '<newDBName>')  where 
projectName = '<oldDBName>' 
  
 update tblTestRunConfiguration set CNprojectName = '<newDBName>', CNidRev= REPLACE(CNidRev, 
'<oldDBName>', '<newDBName>'), CNidNoRev= REPLACE(CNidNoRev, '<oldDBName>', '<newDBName>')  
where CNprojectName = '<oldDBName>' 
  
  
update tblTestRunGridRow set CNprojectName = '<newDBName>', CNidRev= REPLACE(CNidRev, 
'<oldDBName>', '<newDBName>'), CNidNoRev= REPLACE(CNidNoRev, '<oldDBName>', '<newDBName>')  
where CNprojectName = '<oldDBName>' 
  
  update tblTestRunGridRow set TCprojectName = '<newDBName>', TCidRev= REPLACE(TCidRev, 
'<oldDBName>', '<newDBName>'), TCidNoRev= REPLACE(TCidNoRev, '<oldDBName>', '<newDBName>')  
where TCprojectName = '<oldDBName>' 
  
  update tblTestRunGridRow set TCIRprojectName = '<newDBName>', TCIRidRev= REPLACE(TCIRidRev, 
'<oldDBName>', '<newDBName>'), TCIRidNoRev= REPLACE(TCIRidNoRev, '<oldDBName>', 
'<newDBName>')  where TCIRprojectName = '<oldDBName>' 
  
update tblTestRunGridRow set ETCprojectName = '<newDBName>', ETCidRev= REPLACE(ETCidRev, 
'<oldDBName>', '<newDBName>'), ETCidNoRev= REPLACE(ETCidNoRev, '<oldDBName>', '<newDBName>')  
where ETCprojectName = '<oldDBName>' 
 
update tblProjectSettings set Name = '<newDBName>' where Name = '<oldDBName>'; 
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update tblObjectQuery set XmlString = REPLACE(XmlString, '<InputObject>oldDBName-', 
'<InputObject>newDBName-') 
Where (XmlString LIKE '%StaticInput%') 
 
update tblObjectQuery set XmlString = REPLACE(XmlString, '<InputChapter>oldDBName@', 
'<InputChapter>newDBName@') 
Where (XmlString LIKE '%DynamicInput%') 
 
update tblObjectQuery set XmlString = REPLACE(XmlString, '<ProjectName>oldDBName</ ProjectName >', 
'<ProjectName>newDBName</ ProjectName > ') 
 
 
update tblChart set XmlString = REPLACE(XmlString, '<InputObject>oldDBName-', 
'<InputObject>newDBName-') 
Where (XmlString LIKE '%StaticInput%') 
 
update tblChart set XmlString = REPLACE(XmlString, '<InputChapter>oldDBName@', 
'<InputChapter>newDBName@') 
Where (XmlString LIKE '%DynamicInput%') 
update tblReviewProgress set ReviewProjectIdNoRev = Replace(ReviewProjectIdNoRev, '<oldDBName>-', 
'<newDBName>-') where (ReviewProjectIdNoRev like '<oldDBName>-%') 
 

update tblReviewProgress set PageProjectIdNoRev= Replace(PageProjectIdNoRev, '<oldDBName>-', 
'<newDBName>-') where (PageProjectIdNoRev like '<oldDBName>-%') 
 

update tblReviewProgress set PageProjectDBID= Replace(PageProjectDBID, '<oldDBName>-', 
'<newDBName>-') where (PageProjectDBID like '<oldDBName>-%') 
 
update tblAttribute set StringValue = REPLACE(StringValue,'<oldDBName>','<newDBName>') Where(name 
= 'TestRun' AND StringValue LIKE '<oldDBName>-%')"); 
 

 
9b) We also need to set the new server name on the copied database. Use this SQL Query: 
 Update tblProjectSettings set Server = ‘<new server name>’ 
 
10) To attach the original files, copy the copies from the original database (see step 3) back into the 
MSSQL/Data directory.  
 
11) Attach the original database again (see step 4) 
 
12) When the original database has been attached perform the following queries: 

• ALTER DATABASE "<the database name>" SET NEW_BROKER WITH ROLLBACK 
IMMEDIATE; 

 

• ALTER DATABASE "<the database name>" SET ENABLE_BROKER; 
 
Note the quote around the project name. 
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